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About this guide 

This guide describes workflow, concepts and procedures for using the Infor Distribution FACTS 
Inventory Control Module. 

Intended audience 
This guide is for FACTS end users, managers, in-house analysts, and trainers who require an 
understanding of the product and how to use it. 

Organization 
This table shows the chapters of the guide: 

Section Description 

About this guide Lists the intended audience as all users. 
Describe the purpose and the related 
documentation.  

Overview The overview section described the purpose of 
the application in terms of the business 
solutions that it provides, program listings, and 
menu trees, as applicable to the application.  

Work Flows & Program Concepts This section includes process flows for each 
module, program descriptions and concepts 
that are key to using this FACTS module. 

Transaction Procedures This section contains daily, weekly and end of 
year procedures as well as step-by-step 
processing information for entry, inquiry and 
transaction programs. 
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Related documents 
You can find the documents in the product documentation section of the Infor Support Portal, as 
described in "Contacting Infor" on page 10. 

Refer to the contents of the FACTS Version 9.3 & Incrementals folder located at 
https://support.infor.com/. Click Search>Browse Documentation>FACTS> Version 9.3 & 
Incrementals to view a document tree like this. 

o FACTS Version 9.3 & Incrementals
 Installation and Administration Guides

• Configuration Guides
• Demo Application Installation Guide
• Hardware Guide
• Installation Guide
• Online Help Installation Instructions
• Product Compatibility Matrix
• Technical Information

 Integrations
• Credit Card
• Document Management
• Infor Solutions

o eCommerce
o Storefront Integration Layer

• WMS
 Release Information

• Feature Demonstration Videos
• Program Menu Changes
• Release notes

o Incremental Release Notes
 User Guides

• Feature Implementation Guides
• Standard Module User Guides

Contacting Infor 
If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and 
create a support incident. 

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To 
access documentation on the Infor Support Portal, select Search > Browse Documentation. We 
recommend that you check this portal periodically for updated documentation. 

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 1 Overview 

The Infor Distribution FACTS Inventory Control System allows you to maintain items and 
their relevant information (costs, prices, quantities, etc.) accurately, while providing complete 
audit trails and optionally posting to General Ledger. General Ledger interaction is automatic 
and the GL posting tables allow great flexibility in how you post to GL. 

All information is traceable through the Inventory Control System because the system has 
been designed so that all transactions will produce a printed audit trail. Instructional prompts, 
default values and the capability to back-up to previous fields promotes both operator 
efficiency and comfort in using the system. 

The Inventory Control master menu consists of these submenus. 

Adjustments  

Warehouse Transfers  

Costing and Pricing  

Electronic Price Updates  

Physical Inventory  

Inquiries  

Reports and Prints  

End of Period  

File Maintenances  

Major Features in Inventory Control
FACTS is a true asset management tool, incorporating automated restocking routines that 
are the result of more than decade of experience and evolution, and includes many of the 
concepts of the acknowledged authority on Advanced Inventory Management (AIM) 
replenishment processing--Grant Howard. Refer to the Advance Inventory Management 
(AIM) Replenishment Overview for details. 

Just a few of the major features of the FACTS Inventory Control should be mentioned: 

Multiple warehouses - allows using branch or satellite warehouses if desired. Costing, 
except for manual costing, is by warehouse to allow freight to be factored into incoming 
costs.  
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Multiple units of measure - each item can have different units of measure, and from these, 
the default stocking, pricing, costing, selling and buying units of measure are established.  

Multiple vendors per item - items can have both primary and secondary vendors.  

Automated restocking - automatic restocking based on current ordering information is 
central to proper inventory management.  

Line-buying - allows review and restocking of vendor product lines enabling quantity 
discounts.  

Item interchange - allows entering another reference number (e.g., customer or vendor item 
number) at any item field and interchanging it with your item number automatically. 

Multiple Bin Locations – provides the ability to have alternate bin location 
recommendations for pickers, receivers and inventory counters to look for stock per 
warehouse/item record. These additional locations do not track quantities. Alternate bin 
locations for an item are maintained via the Warehouse/Item F/M. The Quick Warehouse 
Entry feature available from Item F/M also allows the alternate locations to be set up. You 
can view alternate bin locations from the Warehouse view of Item inquiry. 

There are numerous transactions and secondary files in the Inventory Control System, but 
there are three major files:  

Item - the Item File stores all static information pertinent to the item (description, unit of 
measure, primary vendor, etc.).  

Warehouse/item - stores information pertinent to the item in a particular warehouse (e.g. 
location, on-hand quantity, quantity committed, costs, etc.).  

Warehouse/item/lot - if using serial number or lot inventory, this file keeps track of the 
specific serial/lot numbers of an item in a warehouse (e.g., date received, quantity, etc.). It is 
useful to think of each file after the item file as a detail version of the previous file. 

Many optional parameters are used in the system to tailor the application to your business. A 
few of these are worth noting:  

Price level - up to six price levels by item and unit of measure may be maintained in addition 
to standard price. Price levels may include quantity breaks and commission percentage.  

Fractional inventory - fractional inventory may be supported up to four decimal places.  

Price/cost mask - prices and costs may be stored at three decimal places.  

Serial/lot inventory - as stated above, the system supports use of both serial and lot items if 
they are so designated.  
Serial/Lot costing options: You have the ability to cost serial and lot items by the system 
cost (costing method for the module). The feature provides for GAAP compliance. For the 
FACTS SO, IC and MC modules, you can decide if the cost for serial and lot items will be 
averaged actual (as it has always operated in the past) or system cost (costing method for 
the module). The default setting for each Static Control F/M is A-Averaged Actual (same 
behavior as they have before the monthly is applied). Users who want to take advantage of 
this change will need to change the option to S-System Cost for each of the applicable 
modules. The net result of selecting S-System Cost is that serial/lot items will be costed like 
non-serial/lot items.  Serial/lot processing allocates cost layers only for shipped quantities 
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Costing method - standard costing may be maintained by manual, last, weighted average, 
LIFO, or FIFO. The costing method chosen here is the cost used when posting GL 
transactions (Inventory Asset account, Inventory adjustment account, etc.) from the Inventory 
programs. This cost is known by the system as standard cost.  

The basic functions related to inventory control are:   

Item setup - items are added to the system and warehouses through the file maintenance 
(F/M) programs.  

Item maintenance - relatively static information is also maintained through the F/M 
programs. Manual costs and prices have their own submenu. Nonstatic information such as 
on-hand quantity is maintained automatically through interface with other modules (e.g., 
Sales Orders, Purchase Orders) or through the Adjustments Submenu.  

Restocking - proper restocking, knowing when to order and how much to order, is critical to 
inventory control. The Restocking Submenu recommends the best restocking based on 
current information, and supplies this information to the Purchase Order System.  

Transfers - transferring items between warehouses is accomplished through programs on 
the Transfers Submenu.  

Sales - sales is performed through the Sales Order System, with item information 
immediately updated.  

Information - inquiries and reports allow access to item information as desired and in a 
format conducive to proper management decisions. 

Advance Inventory Management (AIM) Replenishment  
Infor Distribution FACTS uses Advanced Inventory Management (AIM) replenishment 
processing as defined by Grant Howard. The major areas of Inventory Control replenishment 
include: 

Replenishment Parameters--group the settings into the following areas: Ranking, Usage, 
Rounding, Priority, Exceptions, Adjusters and Lead Time. 

Cost Discrepancy Processing--provides a way to identify an inventory receipt document with 
an incorrect cost, enter the correct cost, and then have that corrected cost update down to 
the disbursements and past documents that were filled by that receipt. 

These are examples of cost discrepancies. 

• Receipt of inventory at wrong cost 
• Unexpected freight on a purchase order 
• Invoice from vendor differs from cost on PO 

Multiply Buying UM Options - In Item UM Entry you can alternate buying unit of measures for 
the Buyers Control Center (BCC) in the Purchase Orders module. The quantities entered in 
the BCC will be converted to the appropriate default buying UM on the Purchase Order line. 

Item setup via Item File Maintenance - You can specify an option for “Use ROQ” - round up 
order quantity. This option rounds up the recommended order quantity for the item in the 
Buyers Control Center. The unit of measure to use is based on an available buying unit of 
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measure for the item. If a quantity needs to be applied to the specified UM it can be 
indicated. The default quantity is 1 and must be an integer value for rounding. Additionally, 
the ROQ can be applied for warehouse transfers or ignored. 

Implementation of Rank - An item’s Rank is determined by the number of ‘hits’ the item 
incurs during a number of periods at the document level. An item’s ranking will be updated 
during the Daily Sales Register (DSR). Therefore, the parameters determining an items’ 
Order Point / Line Point will be updated to reflect current system requirements. An item’s 
Rank also determines the number of periods to apply a slope percentage when calculating 
Average Daily Usage. 

Ranking for an item is performed for stocked items that are flagged as Replenish for a 
warehouse. If a non-replenished item is changed to a replenished item, the system utilizes 
the usage information captured for the item to calculate the appropriate rank. 

Tending of Usage Data - The usage data is collected daily for all stocked items in the 
system. This allows for accurate calculation of ADU for Order Point and Line Point. The 
extrapolated data points for seasonal usage will employ a T-Backward usage calculation. 
The usage for an item will be examined for 12 periods in arrears, backing up a number of 
periods based on an items Rank. The number of periods utilized for trending will be based on 
an item’s Rank. The higher the activity Hits for an item, the higher the Rank and thus a 
smaller the window to be utilized for trending. An “A” ranked item will have a 3 month 
backward and forward trend and require 15 months of history. A “B” ranked item will have a 4 
month trend window and require 16 months of history, and so on. 

Trending for a non-seasonal item employs either a Backward or Forward ADU calculation. 
For Backward trending, an “A” ranked item will look at the prior 3 periods of usage to 
calculate the ADU. A Forward “A” ranked item will go back 12 periods and use the 3 Forward 
periods for the ADU calculation. The trending type for an item can be configured at the 
Warehouse / Item level. 

Using the item search (ICMAST) 
The Item Search includes these special options. 

• The Availability Warehouse prompt for is defaulted to the user's default warehouse, 
from the active user profile selected in User Preferences.  When a warehouse is 
selected the available and on order quantities in that warehouse are displayed in the 
search browser.  All quantities are displayed in the item's default selling UM.  If the 
availability warehouse is blank, neither quantity will be displayed. 

• The Exclude Inactive Items check box option is available to exclude inactive items. 
When you select Options>Save Filter Values or Options>Preferences>Save as User 
Defaults, the current setting of the 'Exclude Inactive Items' check box is saved.  
When you search again, the saved value is restored.  

• The Sort By option allows you to select Description Search to find items by the item's 
description. The search is case-insensitive. 

• The Inactive Items checkbox was added to include or excluded inactive items in the 
search results. The default value is to exclude the inactive items. 
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Warehouse transfers 
Use the Warehouse transfers menu to transfer items between warehouses, and while in 
route, keeps track of in-transit inventory. The various programs allow the creation of planned 
special order transfers, entering an actual transfer (or pulling over a planned special order 
one), printing a transfer ticket, confirming shipment, and printing a register of all shipments. 
These all relate to the sending, or from warehouse. General Ledger is updated during the 
shipments register. When the items arrive at the destination, or to warehouse, they are 
confirmed through the Receipt Confirmation program. The Receiving Register prints all 
confirmations since the last register, and updates GL. Special orders are updated by this 
register. The Commit Backordered Quantities program commits only those quantities that 
have been received according to the line. If the order line is not a special order line and 
backorder quantities exists and stock is available then the quantities are committed per 
normal behavior. The Transfer Status Report can report on any shipments and their status in 
the transfer process. The Quick Transfer Adjustment is used where no shipping is actually 
involved, e.g., where two warehouses reside in the same building and stock is simply moved 
from one shelf to another. This might be done to separate damaged goods from regular 
inventory (as this is really an adjustment, the audit trail appears on the Adjustments 
Register.)  

IC Side Bar 
Use the IC Side Bar in Transfer Entry, Shipment Confirmation, and Receipt Confirmation to 
display additional quantity and item detail information for quick item selection and viewing. 
This provides information about items in the line-item section to facilitate efficient transfer. 

Click Show/Hide to toggle the Side Bar display off and on. Select a view from the drop box. 
For views with drag and drop functionality, click and drag one or multiple lines at a time to 
the line-item section. Click Reload to refresh the contents displayed in the Side Bar area list 
box. 

You can use the Side Bar for research and review after you specify an item. Limiting, 
scrolling and double click actions, when available, are also enabled during line entry. Drag 
and Drop during line entry is not allowed. 

Refer to this table for the available Side Bar views: 

View Description  
Drag / Drop 
available Functionality 

F-From 
Warehouse 
Quantities 

Displays the from 
warehouse quantities for 
that selected line. All 
from warehouse’s 
quantities for a selected 
item on the ticket are 
displayed. This is item-
specific and contents 
change with items listed 
in Transfer Entry.  

 There is no further 
action in this view. 
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T-To 
Warehouse 
Quantities 

Displays the to 
warehouse quantities for 
that selected line. All to 
warehouse’s quantities 
for a selected item on 
the ticket are displayed. 
This is item-specific and 
contents change with 
items listed in Transfer 
Entry.  

 There is no further 
action in this view. 

A-
Warehouse 
Quantities 

Displays all warehouse 
quantities for that 
selected line. This is 
item-specific and 
contents change with 
items listed in Transfer 
Entry.  

 There is no further 
action in this view. 

R-Resources Displays resources for 
the warehouse and 
item. Warehouse-
specific as well as item-
specific. The contents 
related to the 
warehouse will not 
change, but content 
may change with item 
selection.  

 Select a line and 
double click to launch 
the Supplemental 
Resource Manager 
(SMC910).  

t-Timeline Displays the selected 
item’s current timeline 
for that single item (and 
from warehouse). 
Temporary items are 
omitted. This is item-
specific and contents 
change with items 
ordered.   

 Select a line and 
double click to launch 
the inquiry 
corresponding to the 
selected line type (if 
the document is 
available). 

N-Notes Displays notes based on 
warehouse and item. 
This is warehouse-
specific and item-
specific. The contents 
related to the 
warehouse will not 
change, but content 
may change with item 
selection. 

  Select a note and 
double-click to launch 
the Note Entry 
(SME710) for the line 
and type (Document 
(header); Line or Item 
(line). 
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I-Incoming Displays where the item 
is coming into the “from” 
and “to” warehouses via 
Purchase Orders, 
Transfers, or 
Manufacturing entry 
programs. 

 Select a line and 
double click to launch 
the inquiry 
corresponding to the 
selected document 
type. 

O-Outgoing Displays where the item 
is committed for the 
“from” and “to” 
warehouses via Sales 
Orders, Transfers, or 
Manufacturing entry 
programs. 

 Select a line and 
double click to launch 
the inquiry 
corresponding to the 
selected document 
type. 

L-Long Term 
Surplus 

Displays items with long 
term surplus in the 
ticket’s From and To 
warehouses set in 
Warehouse/Item FM 
(ICF920). Alternate 
warehouses with long 
term surplus are 
included if the Use 
Surplus check box is 
selected in IC Static 
Control F/M and are 
valid for IC in 
Warehouse F/M 
(ICF970). 

X Double click a line to 
display the Change 
Long Term Surplus 
Quantity window to 
change the order 
quantity. Click Refresh 
to reset all quantities 
and values to their 
initial amounts.   

s-Substitute 
Items 

Displays substitute 
items for the selected 
item in the ticket’s From 
and To warehouses set 
in Warehouse/Item FM 
(ICF920). The item 
description, quantity and 
buying UM are also 
displayed. 

X Double click a 
substitute item to 
launch the Change 
Substitute Item 
Quantity window for 
the selected substitute 
item. 

Costing and pricing 
The Costing and pricing submenu allows entry and maintenance of normal costs and all 
prices. Suggested costs and prices may be entered, printed, and edited prior to actually 
correcting these suggested costs/prices to current costs/prices. This allows for nonintrusive 
cost and price changes and ample time for guaranteeing accuracy. Suggested costs/prices 
may be entered individually through the Suggested Cost/Price Entry program, or created 
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automatically based on a percent of cost or price through the Create Suggested Costs/Prices 
Program. After reviewing the suggested cost/price printout, the current costs/prices are 
updated through the update program. A cost/price list is then available.  

Two additional programs allow handling of FIFO/LIFO costing. Be aware that pricing is 
company-wide, while costing is by warehouse. Also, in addition to manual cost maintained 
here, the last and weighted average cost of each item is maintained automatically by the 
system. 

Costing 
The Inventory Control system contains a ‘costing flag’ which determines which cost the 
system should use for calculating gross margin. This cost is called the standard cost. These 
are the possible costs that may be used as the standard cost. 

Manual – you always maintain the cost 

Average – the standard cost is the average cost (maintained by the system) 

Last – the standard cost is the last cost (maintained by the system) 

LIFO – last item cost is first cost out 

FIFO – first item cost is first cost out 

Costs are initially entered through the quick item entry in the Item F/M when initially setting 
up items. Once the costs are entered, the average, last, LIFO and FIFO costs are maintained 
by the system. The only cost which may be maintained by the user is the manual cost. The 
manual cost is maintained through these Suggested Cost/Price programs. When entering a 
suggested manual cost, you may enter a new amount for suggested manual cost, a 
percentage (%) change from the current manual cost or enter a basis (list price only) and 
multiplier for the suggested manual cost.  

When setting up manual cost, there is only one allowable costing unit of measure and 
therefore only one manual cost per item. 

Pricing 
The possible prices that may be set up through the costing/pricing subsystem are as follows: 

List Price - this is usually the manufacturer’s suggested retail or list price. List price may be 
used when selling an item but is generally used as the basis for setting up other prices for an 
item. For example, when setting up price levels, each level price may be set up as List Price 
times a number (multiplier). If the list price is $10.00 and the level prices are 1-$9.75, 2-
$9.50, 3-$9.25, and 4-$9.00 the basis is $10.00 (list price) and the multipliers are 1-.975, 2-
.950, 3-.925, and 4-.900. When entering a suggested list price it may be entered as a dollar 
amount or as a percent (%) change of the current list price. 

Standard Price - this is a standard price as determined by you the user. Suggested standard 
price may be entered as a dollar amount, a percent (%) change of the current standard price 
or may be entered using a basis (list price or manual cost) and multiplier. 
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Level Price - there may be up to 6 (six) level prices per item. The level price used when the 
item is sold is based on the price level assigned to the customer. For example, if a customer 
is assigned price level 4, the level 4 price will be used when selling an item to that customer. 
Suggested level prices may be entered as a dollar amount, a percent (%) change of the 
current level price or may be entered using a basis (list price, manual cost, standard price, or 
previous price level) and multiplier. 

When setting up level prices, the prices must be set up in a descending order if the require 
descending level prices flag is set to Y in the IC Static Control Record. A descending order 
indicates that the price calculated for price level 1 must be greater than level 2 and the price 
calculated for price level 2 must be greater than price level 3, etc. 

Quantity Break Price - there may be up to 6 (six) quantity break prices per item. The quantity 
break price allows you to enter a minimum quantity of the item to sell along with the price per 
UM for that item. For example, if three quantity break levels are set up as follows: 1) 10 ea. 
for $2.75 ea.; 2) 15 ea. for $2.50 ea.; 3) 20 ea. for $2.25 ea.) and the quantity sold is 12, the 
default price would be $2.75. Suggested quantity break prices may be entered as a dollar 
amount, a percent (%) change of the current quantity break price or may be entered using a 
basis (list price, manual cost, standard price or previous quantity break) and multiplier. 

When setting up quantity break prices, the prices must be set up in a descending order if the 
require descending level prices flag is set to Y in the IC Static Control Record. A descending 
order indicates that the price calculated for quantity break 1 must be greater than quantity 
break 2 and the price calculated for quantity break 2 must be greater than quantity break 3, 
etc. 

Using basis and multiplier  
When entering suggested prices, there may be a current list price and a suggested list price. 
If list is then used as the basis the system must determine whether the current list or 
suggested list is used. The rules are as follows: 

If there is a suggested price entered for the basis selected, that suggested price is used. 

If no suggested price exists for the basis selected, the current price is used. 

For example, when setting up prices for item I100 and entering the level 1 price, if basis 
selected is list price but no suggested list price exists, the current list price is used as the 
basis as follows: 

Current list price: $10.00 

Level 1: basis is current list price, multiplier is .9500; 10.00 X .9500 = $9.50 

In another example, when setting up prices for item I100 and entering the level 1 price, if 
basis selected is list price and a suggested list price exists, the suggested list price is used 
as the basis as follows: 

Current list price: $10.00 

Suggested list price: $11.00 

Level 1: basis is suggested list price, multiplier is .9500; 11.00 X .9500 = $10.45 
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An example of how these levels could be used is for trade discounts. The levels could be set 
up as follows: 

Level 1: 5% discount off list price (basis: list; multiplier: .9500) 

Level 2: 5% discount off the level 1 price (basis: level 1; multiplier: .9500) 

Level 3: 10% discount off the level 2 price (basis: level 2; multiplier: .9000) 

Units of measure 
Since each item can have more than one valid unit of measure (UM) for pricing, each item 
can have each of the prices listed above set up for each pricing UM. Therefore the unit of 
measure is part of each pricing record. When entering or updating suggested prices, the user 
has the choice of entering or updating all pricing UM records, default pricing UM records, or 
non-defaulting pricing UM records for an item. 

‘Use Default Prices’ setting  

You may not want to duplicate pricing records for each unit of measure if all prices for all 
units of measure calculate to the same price per the default price unit of measure. For 
example, if there are 10 each per box and the price per each is $1.00 and the price per box 
is $10.00 then you can simply set up the each price allow the system to always calculate the 
box price for when the item is sold per box. 

In the Item File there is a flag, Use Default Prices, that allows you to determine for each item 
whether to use calculated prices from default pricing and quantity break UMs for other pricing 
and quantity break UMs that do not have prices set up. Using the preceding example, the 
use default prices flag is set to Y: 

Item I100 - default price UM is each; price/each is $1.00. Box and case are valid pricing UMs 
however no pricing has been entered for box or case. There are 10 each in a box and 100 
each in a case. 

Five boxes of I100 are sold and the system is looking for the default price. The system will 
calculate the box price based on the each price. In this example, the box price would be 
calculated at $10.00/box (1.00 X 10 each/per box). 

In addition to setting up prices for specific items, you can set up contract prices. Contract 
prices are prices that are set up by customer, customer class or all customers by item, item 
class, vendor or all items and then by specific or all units of measure. Because there may be 
multiple contract prices for the same for example, customer/item combination, a hierarchy is 
used to determine which contract price to use. This hierarchy is user-defined and is set up 
through a hierarchy F/M found on the Contract Pricing Menu 

Contract prices may be set for standard price and up to 6 (six) price levels and 6 (six) 
quantity break levels. Contract pricing is set up through the Contract Pricing Subsystem 
found in Sales Orders. Please refer to the FACTS Sales Orders Manual for more information 
on contract pricing. 

How the system determines the correct price to use - The ‘price search’ 
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Once all of the applicable prices listed above are set up by the user, the user then sets a 
Sales Order control flag that determines the hierarchy of which prices to use when selling an 
item through the sales order entry programs.  

These are the choices for the hierarchy. 

1 Standard Price 

2 Level Price 

3 Quantity Break Price 

4 Contract Price (see "Contract Prices" in this section) 

5 Lowest 

During Sales Order entry programs, when at the price field, the system runs a ‘price search’ 
program to generate the default price. This default price is based on the price hierarchy set 
by the user. For example, the user could set the hierarchy to "standard, level, contract, 
quantity break, lowest". This tells the system that if there is a standard price available for the 
item, the standard price should be the default for that item. If there is no standard price 
available, the system should then check for a level price. If no level price exists for the item 
the system should then check for a contract price. If no contract price exists for the item the 
system should then check for a quantity break price. If no quantity break price exists the 
system should look for the lowest price. 

The price search program looks for prices in the order of the hierarchy until it finds a valid 
price. If lowest is reached in the hierarchy during the price find, the system looks at all prices 
and determines the lowest and presents that lowest price as the default. 

While performing the price search, the system also checks the use default prices flag set in 
the Item F/M. This flag determines whether the default pricing UM should be used to 
calculate a price for another UM if no prices for that other UM exist. (See section above - 
‘Use Default Prices’ flag). If the hierarchy is set to "standard, level, contract, quantity break, 
lowest", when looking for each price, the system will first look for a price in the pricing unit of 
measure in which the item is being sold. If there is no price for the pricing UM for that item, 
the system then checks the use default prices flag to determine if the price should be 
calculated for the pricing UM (being sold in) based on the default pricing UM. 

CenPOS credit card processing: In Unit of Measure Code F/M (ICF965) you can specify 
an Alternate Unit of Measure Code and use it as an option in Credit Card Control F/M for 
Level III summary data processing. 

Cost discrepancy processing 
If a cost is recorded on a Purchase Order and the register has been processed, it is 
necessary to have the ability to redistribute the cost to ensure proper GL balance. When 
entering the invoice via PO Invoice Receipts Entry (POE310), if the cost of the line item 
differs from the cost in ICRCPT, the cost will need to be updated in ICRCPT and all 
disbursements in ICRDST. 

Cost Discrepancy processing provides a way to identify an inventory receipt document with 
an incorrect cost, enter the correct cost, and then have that corrected cost update down to 
the disbursements and past documents that were filled by that receipt. 
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These are some examples of cost discrepancies. 

• Receipt of inventory at wrong cost 
• Unexpected freight on a purchase order 
• Invoice from vendor differs from cost on PO 

Electronic price updates 
The Electronic Price Updates subsystem allows you to electronically update the FACTS 
System with information obtained from an electronic pricing service. You have the ability to 
report on, add, change or delete any data prior to updating the item, catalog and/or pricing 
files. 

Physical inventory 
The Physical Inventory Submenu allows for cycle counting or complete physical inventories. 
Cycle counting (counting a portion of inventory each evening) is recommended for greatest 
accuracy between computer records and actual stock. Count sheets may be printed in 
almost any order (e.g. by item, location or vendor). After printing count sheets at the close of 
the business day, the Capture Quantities Program is run. This ‘captures’ the on-hand 
quantity and allows business to resume the following day prior to the counts being entered or 
processed. This avoids having to postpone normal business operations until after counts are 
entered and updated. The counts from the physical are then entered and the Discrepancy 
Report (showing any variances between the computer balance and the count) is run. After 
verification of the discrepancy report, the Update Inventory Program is run to reset any 
discrepant items. 

Inquiries 
The Inquiry menu allows you to display specific item information by item number or perform a 
search. General or detail information may be displayed for each item. You can also display 
information for a specific warehouse or all warehouses. 

The Item Inquiry provides a wealth of information about items entered in the system.  

The Profit Analysis Inquiry enables you to analyze profits based on an item cost, price and 
sales history. For example, the program displays sales required to maintain profits if a price 
is lowered. 

The Catalog Item Inquiry provides information for catalog items within inventory. 

The Transfer Document Inquiry allows you to view the various record types that make up a 
transfer document. 
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Reports and prints 
The Reports and prints submenu contains numerous reports with various options and 
parameters for selecting the report in a format most desired. For example, most reports allow 
printing an item, alphabetic, vendor or item class order. Additionally, the range of items, etc. 
maybe specified.  

End of period  
The End of period submenu contains programs that should be run to close the module 
correctly at the end of each period. The Item Activity Report provides a printout of all item 
activity (receipts, adjustments, sales, transfers, etc.) for the period. This information is reset 
after the period is closed, so it must be printed at this time. The Serial/lot Number Removal 
Register prints a list of all serial/lot numbers that have been sold and optionally removes 
them from the system. The Item Ledgercard Removal removes ledgercards for all items 
before a specified date - failure to run this program may result in an overly large ledger card 
file. The End-of-Period Update closes the current IC period, rolls usage figures back one 
period, recalculates ordering controls, and resets month-to-date sales figure for all items. 
Items with unusual usage for the period are flagged.  

Posting to General Ledger 
Setting up automatic postings from the Inventory Control module to the General Ledger 
module primarily involves two programs: IC to GL Posting F/M and IC GL Posting Table F/M. 

First, use IC GL Posting Table F/M to create and maintain GL posting tables for Inventory 
accounts. 

Next, use the IC to GL Posting F/M to determine how the Inventory accounts should post.  

IC GL Posting Table F/M 
Establish a set of valid GL posting tables in this program. Once the posting tables are in 
place, you can assign each item is assigned to a table, which in turn determines the correct 
GL account numbers to post to when posting a transaction to General Ledger for that item. 
The posting tables determine the General Ledger distribution after the printing of various 
registers throughout the system. 

These registers may use the GL account numbers set up in the IC GL posting table(s). 

Adjustments Register distributes to inventory GL number, sales GL number, receipts GL 
number, adjustments GL number and physical discrepancies GL number. 
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Transfers Shipment and Receiving Registers distribute to inventory GL number, in-transit GL 
number and inter-warehouse transfers GL number. 

MC Production Registers distribute to inventory GL number, MC finished goods and MC 
components GL number. 

PO Receipt Register distributes to inventory GL number, receipts GL number and the non-
inventory GL number. 

If the accounts are set to Item in the SO to GL Posting F/M, SO Daily Sales Register 
distributes to inventory GL number, sales GL number, cost of goods GL number, 
miscellaneous sales GL number, temporary inventory GL number, inter-warehouse COGS 
GL number and non-inventory GL number. 

IC to GL Posting F/M 
You can determine the detail of the journal entries posted through the GL Distribution flag. 
The flag may be set to one of the following: 0-indicating no GL distribution is printed or 
posted; 1-indicating the GL distribution is printed (printing is in detail format) but not posted 
to GL; 2-indicating the GL distribution is printed (printing is in detail format) and posted to GL 
in detail (posting includes each item contributing to the amount for each account number).  

Through the Adjustments Journal, you can determine which GL journal (where in the general 
ledger journal file) to post transactions from the Adjustments Register. Through the Transfers 
Journal the user determines which GL journal (where in the general ledger journal file) to 
post transactions from the Transfers Shipment and Receiving Registers. 

Through the Post by Branch flag, you can indicate whether to post inventory transactions by 
branch, i.e., insert the branch in the GL account number when posting. For example, if the 
GL number to post is 415-00-0 (where the branch is in the last position) and the branch is 3, 
the account number posted is 415-00-3. 

You can also establish whether to post adjustment to general ledger by the G-account 
number assigned to the adjustment in the GL posting table (GL Posting Table F/M) or the A-
account number assigned to the adjustment code. If the flag is set to A-adjustment, the GL 
number assigned to the code is posted when entering an adjustment. If the flag is set to G-
GL posting table, the GL number in the GL posting table is posted. If the flag is set to G, the 
adjustment codes type determines whether to post to the A-adjustment, R-receipts or S-
sales GL number.  

The Inventory Control transactions that may print a GL distribution and post to GL are the 
transactions from the Adjustments Register, Transfers Shipment Register and Transfers 
Receiving Register. 
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Chapter 2 Work flow & program Concepts 

This chapter covers the work flow for sub modules in Inventory Control and addresses work 
flow concepts vital to using inventory programs and reports.  

Adjustments 
Use the Inventory Control Adjustments menu to enter inventory adjustments and item 
repackaging.  

Work flow 
Inventory on-hand quantities are updated at the time of entry. After entries have been made, 
the Adjustments Register is run to update the adjustments file and post to general ledger. 
The Adjustments Register lists all adjustments since the last register and optionally posts to 
General Ledger. Adjustments created by discrepancies during physical inventory will also 
appear on this register. 

Program concepts 
The Adjustment Entry program allows immediate adjustments to on-hand inventory. Each 
entry includes an adjustment code explaining the general nature of the adjustment quantities 
(e.g. lost, damaged, etc.). Through the Adjustment Entry program, you can enter manual 
adjustments to inventory on-hand quantities to post receipts of goods, adjust for damaged 
goods and record sales. You must establish adjustment codes in the Adjustment Codes F/M 
program and assign one to each adjustment. If an R-(receipts) type adjustment code is 
entered or an A-(positive) adjustment type adjustment code, the cost must be entered. If an 
S-sales type adjustment code is entered, a price must be entered. All other codes do not
require field of a cost/price. A memo may also be entered to explain the reason for each
adjustment. As soon as the transaction is recorded, on hand quantities are updated. A
scrolling feature displays the most recent transactions recorded at the bottom portion of the
screen. This provides additional safeguards against user error due to oversight or transaction
duplication.
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The Item Repackaging program allows the repackaging of items by converting the quantity of 
an item of a given package size into the resulting quantity of a like item of a different 
package size. The requirement for repackaging is that the smallest unit of measure for both 
items is the same. If binders are sold by each and by case, two items are required in the item 
file. The smallest unit of measure for both must be each. If there are 10 binders in a case, 
then when repackaging a case into individual binders, the system transfers 1 case of the 
case item number to 10 each of the each item number. Updating the on-hand quantities of 
the items according to the transfer amounts occurs immediately as the transfer is recorded. 
Two records of the transfer (one for each item) are created in the adjustments file and are 
available for printing on the next Adjustment Register. A scrolling feature displays the most 
recent transactions recorded at the bottom portion of the screen. This provides additional 
safeguards against user error due to oversight or transaction duplication. 

The Adjustment Register prints an audit trail of all adjustments and repackaging since the 
last register. The Adjustment Register also includes any physical discrepancies from the 
Physical Inventory Update program (if applicable) and the warehouse transfers entered 
through the Quick Transfer Adjustment program. The adjustments file consists of adjustment 
and item repackaging transactions, which have been recorded through the Adjustment Entry, 
the Item Repackaging Entry and Quick Transfer Adjustment programs. If GL is used, a GL 
distribution is printed and GL is posted to automatically. Templates that store "current period" 
(or similar values like "system date") resolve to the "current period at the time the report is 
run" rather than what the "current period" was at the time the template was created. For 
example: If you save a template for the Adjustment Register and select "System Date" for 
the Date field, when that template is selected to run again (either manually or via Job 
Stream) the current date is determined using the FACTS system date when the register is 
run not the date when the template was created. This program will: print a listing of 
adjustments, item repackaging, quick item transfers and physical discrepancies; build and 
print a general ledger distribution, if needed; post to general ledger if general ledger is built 
and update inventory files optionally including removal of adjustments printed. The optional 
update removes all records printed, and posts to General Ledger. 

Warehouse Transfers  

Work flow  
Use the programs on this menu to transfer items from one warehouse to another. 

Use the Buyers Control Center Transfer program to generate warehouse transfers.  The 
initial screen of the Buyers Control Center (BCC) is referred to as the summary screen. The 
summary screen is launched from the Purchase Orders, Inventory Control, and 
Manufacturing Control modules with the appropriate activity code selected. The columns and 
options differ slightly based on the Activity selected, but the process is very similar. Upon 
entering the BCC, buyers can specify a buyer code and warehouse to review the current 
actions. The Activity is set to Transfers by default. User security must be set in Program 
Security Maintenance (SMF420) for each user and activity code. A prioritized summary of 
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each ARP or warehouse activity is displayed. Transfer processing verifies that planned 
special order transfer lines still exist when loading the line grid or when creating transfers 
from the Buyers Control Center. If the planned special order transfer was used (from the 
Customer Returns System, etc.) and is no longer on file, the system displays a message 
prompting you to review the changes. Be sure to specify the Ship Via for the carrier for 
transfers on the BCC Detail screen. 

Use Planned Special Order Transfer Entry (ICE310) program to enter planned special order 
transfers for inventory items tied to a sales order from one warehouse to another. The items 
may then be printed and checked for accuracy on the Planned Special Order Transfer 
Report before the actual transfer is entered on a transfer ticket. Throughout the sales order 
entry programs, if items are on backorder, the user may automatically update items to the 
planned special order transfer file. If a line of an order is deleted and a planned special order 
transfer exists, the planned special order transfer is automatically removed from the planned 
special order transfer file.  

When creating a transfer line for a specific back-ordered sales document line the ordered 
quantity must match the back-ordered quantity. Click Options>Import Planned Special Order 
Transfers to create a transfer line for a specific planned special order transfer record. Any 
line that is a special order line cannot have quantity changes. Existence of SO document and 
lines determines if this a special order.  

PO, MC and IC Suite Entry programs do not allow any change to special order ordered 
quantities or back-ordered quantities, when the production ticket, PO or transfer is in 
process. Any changes must be managed through the originating order document and its 
special order line(s). Special order lines in SO Entry Suite programs can only be changed for 
their back-ordered quantity and price before the planned special order PO record, BOM or 
FML ticket or transfer record is converted into a purchasing document, production, or transfer 
document. Once the planned special order PO, ticket or transfer record is converted into a 
purchasing or transfer document then, in SO Entry Suite programs, the only change allowed 
is to price. 

Special order overrides  
Special order overrides allow authorized users to manage special order quantities outside of 
normal FACTS processing. Override quantity changes are at the users own risk. The 
override ability applies to quantity and unit changes only. Override ability does not affect 
system behavior for non-special-order quantities and units from stock. Special-order stock 
still cannot be used on non-special-orders. Non-special-orders still cannot use special-order 
stock.  
Special order override privileges and messaging display are set in User Code F/M 
(SMF950). Overrides provide the ability to create situations where special-order receipt 
records are over- or under-received. This creates OS type receipt records, even when the 
special-order receipt remains under- or not utilized. Use the Item Balancing Register to clean 
up OS type records for over and under situations.  
Messages can be displayed to users with override ability to special order quantity changes. 
This provides knowledge of potential issues. Messages can be turned off, per user with 
override ability. Users without override ability will also see the relevant messages when 
changing quantity if that quantity changes falls outside allowed ranges.  

Infor recommends that the override messages are left on for all users with override ability. 
This allows users to be forewarned that their changes should be carefully considered. 
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For planned special orders, complete these steps: 

1. Specify the sales order number containing the items to be transferred for this special 
order. The number entered must be a valid sales order number.  

2. Specify the line number of the sales order that contains the item number to transfer. The 
number of units (per stocking unit of measure) is automatically entered under units from the 
number of units on order or back order from the sales order and line number entered.  

Sales Order Line Number Processing Details:  If the available quantity in the "from" 
warehouse is less than the sales order back-ordered quantity, then the system displays a 
message with the option to continue or cancel. The sales order back-order quantity will 
default into the requested quantity of the line. The requested quantity plus shipped quantity 
from open receipts cannot be different from the back-ordered quantity on the sales order. 
The quantities will be in the selling UM from the sales order line. 

When a planned special order transfer record is created, the system checks to make sure 
that a planned special order PO or production record does not already exist for that order 
and line and that the order and line do not already exist on another planned special order 
transfer record or in the Buyers Control Center (POE400) program. If the special order is 
found already in the BCC, the addition is not allowed and a message is displayed indicating 
that a BCC record was found. For planned special order transfer records, the order/line must 
wholly be a special order. Quantity changes are not allowed. The amount ordered and 
amount back-ordered must be the same to allow manual entry/tie for special order.  

Then, use the Planned Special Order Transfer Report (ICR310) program to obtain a report of 
all planned special order transfers entered in the Planned Special Order Transfer Entry 
program and any planned special order transfers updated by the sales order system. Report 
information includes: from and to warehouse, item number and description, units, stocking 
unit of measure, cost, costing unit of measure, extension, sales order number, line number 
and customer. 

Use the Transfer Entry program to enter and correct transfer tickets and/or import planned 
special order transfer, which contain items to be transferred from one warehouse to another. 
The Transfer Entry screen consists of two sections. The upper portion of the screen is called 
the header portion where the FROM and TO warehouses, request date, etc. are entered. 
The lower portion of the screen is called the line-item portion where items, quantity 
information, etc. are entered. You have the option of changing, adding or removing line-
items, or deleting the transfer ticket at any time. You can also backorder warehouse transfer 
line items. This program provides a complete audit trail of all transfer ticket numbers used. 
When you add a new transfer, the program checks to ensure that the transfer ticket number 
being assigned does not already exist in the transfer history header file. A deleted ticket’s 
line-item records are removed and the header record status is changed to deleted. The 
transfer ticket appears on the next Receiving Register as a deleted transfer ticket and is 
removed in the register update. For EMS processing the Transfer Entry program checks to 
determine if the transfer you are going to change has been flagged by Accellos. If it is has 
you will not be able to modify it, if it has not, the system sends a ‘nuke’ record to Accellos 
causing this transfer to be removed. The transfers then need to be reprinted to get it sent 
back to Accellos. 

Transfer tickets are available for printing using the Transfer Ticket Print program. You can 
print transfer tickets through this program or through the Transfer Entry program. The printed 
transfer tickets include all header and line-item information. The form depth (number of 
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lines), whether printing on a preprinted form, item description(s) to print and whether to sort 
by location is determined in the IC static control record. You can select to print open 
transfers only, backorders only or all transfers or rush tickets only, normal priority tickets only 
or both. Transfer Tickets on service hold will not print. Only document type "S" can be 
printed. Lines print in sequence number order. 

The program calculates and prints the next ticket shipment number in the header portion of 
the transfer ticket. This will not update until the shipment register is run. The header and line 
notes also print on the transfer. Templates that store "system date" resolve to the "current 
system date at the time the report is run" rather than what the "current system date" was at 
the time the template was created. For example: If you save a template for the Transfer 
Ticket Print and select "Current Date" for the Cutoff Date field, when that template is selected 
to run again (either manually or via Job Stream) the cutoff date is determined using the 
current date in the Company Periods & Ending Dates F/M (GLF970) when the report is run 
not the current date when the template was created. Multiple Bin Locations on Transfer 
Tickets: If the Print Alternate Locations on Transfer Ticket setting in the IC Static Control F/M 
program is set to yes, the Transfer Ticket Print program prints a new line after the main item 
line that shows all alternate locations set up for the "from" warehouse/item. If the Print 
Alternate Locations on Transfer Ticket setting in the IC Static Control F/M program is set to 
no or there are no alternate locations set up, no additional line prints.  NOTE:  If a bill of 
lading is to be printed for a warehouse transfer ticket, it needs to be done from the SO Bill of 
Lading Print Program. For WMS processing, the Transfer Ticket (ICP310) program creates 2 
flat files that will be sent to Accellos. Select the checkbox to control whether a flat file needs 
to be created. 

Shipments from the FROM warehouse are confirmed through the Shipment Confirmation 
(ICE330). The confirmation process involves confirming that a transfer ticket (or a portion of 
it) was shipped. Once a transfer ticket is confirmed, it is ready to print on the next Shipment 
Register. For WMS processing, the Shipment Confirmation (ICE330) program does not allow 
confirmation of shipped orders that belong to an Accellos controlled warehouse. That 
process is done by the upload stock picks program. 

Shipments are then updated by the Shipment Register (ICR320) and then appear on the 
Transfer Status Report until receipts are confirmed by the TO warehouse in the Receipt 
Confirmation. 

During processing, the system automatically displays urgent notes for transfer ticket 
headers, lines and items based on your settings on the Notes tab of Transfer Entry Options 
F/M. Refer to the Viewing/Entering Notes from IC Transfer Entry Programs topic for 
additional details. 

As the Shipment Register prints, deleted and voided documents are printed, including the 
date the document was deleted and the user who deleted it print. These are not counted in 
the number of tickets processed, and the lines will not print for a deleted document. Any lines 
that were deleted from a ticket that is running through the register also print after all the open 
lines for the ticket have printed. This information comes from the deleted lines file (ICTRND) 
and includes the item, description, quantity requested or shipped, cost, date the line was 
deleted and the user who deleted it. The deleted lines do not include the cost extension and 
do not add into the ticket total. This program will: print a listing of transfer tickets confirmed 
as shipped, items transferred and costing information, build and print a general ledger 
distribution, if needed, post to general ledger, if general ledger is built, update inventory and 
general ledger files. Register information includes: ticket number, request date, shipped date, 
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from and to warehouse, ship via and reference number. For each item transferred, the item 
number and description, serial/lot numbers (if applicable), units, stocking unit of measure, 
cost per unit, costing unit of measure, extension and sales order tickets. Ticket and register 
totals are printed. The total number of tickets listed is also included. Usage: If the "To" 
warehouse’s restocking warehouse is the "From" warehouse, then the "From" warehouse 
gets the usage updated if the "From" warehouse also has the Replenish flag set to Y on the 
Main screen of Warehouse/Item F/M (ICF920). Transfer History Processing: When the 
Shipment Register update is run, the system writes the processed transfer tickets to the 
Transfer History files. For each ticket, the program writes a record to the ICPTRH Transfer 
History Header file. For each line on the ticket, the program creates a record in the Transfer 
History Line file, ICPTRL. For is for a serial or lot line-items, records are written to the 
Transfer History Serial/Lot file, ICPTRS. For duplicate ticket numbers, the program uses a 
sequence number field. Before writing a new header record, the program determines if the 
ticket number already exists and increments the sequence number for the new header being 
added and writes all line and serial/lot records with the new sequence number. 

When the receiving warehouse receives the items, the receiving warehouse confirms their 
arrival through the Receipt Confirmation program. Use this program to enter confirmation of 
transfers out of the FROM warehouse. The confirmation process involves confirming that a 
transfer ticket (or a portion of it) was shipped. Once a transfer ticket is confirmed, it is ready 
to print on the next Shipment Register. 

During processing in the Planned Special Order Transfer Entry (ICE310), Transfer Entry, 
Shipment Confirmation (ICE330), and Receipt Confirmation programs, the system 
automatically displays urgent notes for transfer ticket headers, lines and items based on your 
settings on the Notes tab of Transfer Entry Options F/M. Refer to the Viewing/Entering Notes 
from IC Transfer Entry Programs topic for additional details. EWMS Processing Note: The 
Shipment Confirmation (ICE330) program does not allow confirmation of shipped orders that 
belong to an Accellos controlled warehouse. That process is done by the upload stock picks 
program. 

You can use the Document Fill Report (ICR350) to advise warehouse personnel of what 
backorders can be filled with the incoming merchandise (received purchase orders and 
transfers) before the Transfer Receiving Register is run. The report can be run for special 
order lines (those tied to an SO) and/or restocking (those not specifically tied to an SO), or 
you can print only documents with a fillable line with a backorder. Received Purchase Orders 
print first and then the received Transfers. The program prints a page break between the two 
types of documents. In addition, since Transfer Entry has the capability to backorder 
quantity, the document lines that could be filled by incoming stock, the report output also 
includes backordered transfers. The backordered sales order lines will print first and then the 
backordered transfer lines. The alternate bin locations are print on the report based on the IC 
Static Control F/M setting, Print Alt Locations on Transfer Fill. If you select to print POs only 
or both document types, this program prints the received purchase order that match the 
selection criteria and the backordered document lines that could be filled by these receipts. If 
you did not include POs in the document type selection, then this program does not print and 
runs for transfers. After the sales order line are printed that could be filled by a PO line, then 
any transfer lines for the item that have a backordered quantity also print. The "to" 
warehouse description prints in the column where the customer name printed for the sales 
orders. If you select to print transfers only or both document types, this program prints the 
received transfers that match the selection criteria and the backordered document lines that 
could be filled by these receipts. If you did not include transfers in the document type 
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selection, then this program does not print and instead returns to the menu. The program 
reads the transfer line file for all open receipt lines that have a received quantity. Since there 
can be multiple open receipts for one ticket, the report prints the transfer ticket number and 
total received once and then each receipt for that ticket prints on a separate line. If you 
included updated receipts, those also print. Then, the report prints the lines that could be 
filled by that received quantity. After the sales order line are printed that could be filled by a 
transfer line, then any transfer lines for the item that have a backordered quantity will also 
print. The "to" warehouse description will print in the column where the customer name 
printed for the sales orders. 

After receipt confirmation, the receiving warehouse runs the Receiving Register. This 
program prints a listing of transfer tickets confirmed as received, items transferred and 
costing information; builds and prints a general ledger distribution, if needed; post to general 
ledger, if general ledger is built, and updates inventory and general ledger files. Register 
information includes: ticket number, shipped date, receipt date, from and to warehouse and 
either the ship via and reference number of the status of deleted (prior to printing ticket) or 
voided (after printing ticket) ticket. For each item received, the item number and description, 
serial/lot numbers if applicable, units, stocking unit of measure, cost per unit, costing unit of 
measure, extension and order number. Ticket and register totals are printed and the total 
number of tickets listed is also included. When a line on a transfer is tied to a sales order, the 
Receiving Register prints the sales order line number next to the sales order number. 

Lead Time: If the "To" warehouse’s restocking warehouse is the "From" warehouse, the 
Receiving Register may flag abnormal (A) lead time in the "To" warehouse if the "To" 
warehouse item is stocked and the Replenish flag on the Main screen of Warehouse/Item 
F/M (ICF920) set to Y, before checking all other conditions that would flag the item with an 
abnormal lead time. 

Transfer History Processing: The Receiving Register Update updates the records previously 
added in the transfer history files. The Receiving Register updates the receiving-side 
information in the records. The program updates the records for the last sequence number in 
the file.  

The Transfer Status Report may be printed at any time to obtain a list of all items in the 
warehouse transfer system. This list prints the status of the item (in-transit, etc.). Report 
information includes the following: ticket number, item number and description, status (E-
entered, P-printed, S-shipped, T-in transit, R-received, D-deleted and V-voided), request 
date, from and to warehouse, number of units requested, backordered (if the document 
status is Entered, Printed, or Shipped), shipped and received quantities (if the document 
status is In-transit, Received, Updated) , stocking unit of measure, cost per unit and costing 
unit of measure. The total number of tickets listed is also included. The report prints a 
separate line for an open transfer shipment and all open transfer receipts within the ranges 
selected. Each will be evaluated based on its own status and priority. 

The Quick Transfer Adjustment program allows an immediate transfer of on hand quantities 
from one warehouse to another. The audit trail of the warehouse transfer is printed on the 
next Adjustment Register located on the Adjustments menu. Use this program to transfer a 
quantity of an item from one warehouse to another. Updating the on hand quantities of the 
items according to the transfer amounts occurs immediately as the transfer is updated. Two 
records of the transfer (one for each warehouse) are created in the adjustments file and are 
available for printing on the next Adjustment Register. The Quick Transfer Adjustment 
(ICE350) program uses the Costing Method designated the Static Control F/M (ICF980) 
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program instead of Standard Cost. A scrolling feature displays the most recent transactions 
recorded at the bottom portion of the screen. This provides additional safeguards against 
user error due to oversight or transaction duplication. Usage: If the "To" warehouse’s 
restocking warehouse is the "From" warehouse, then the "From" warehouse gets the usage 
updated if the "From" warehouse has the Replenish flag on the Main screen of 
Warehouse/Item F/M (ICF920) set to Y. Lead Time: If the "To" warehouse’s restocking 
warehouse is the "From" warehouse, then the "To" warehouse lead time type is set to "A" for 
abnormal only if the item is stocked and the Replenish flag on the Main screen of 
Warehouse/Item F/M (ICF920) set to Y. Otherwise, the lead time flag will be blank. The 
Quick Transfer Adjustment (ICE350) program is disabled for any Accellos-controlled 
warehouses. 

Run Commit Backordered Quantities (SOR210) to update the backordered quantities on 
sales orders, warehouse transfers and backorders to committed quantities and to provide a 
report of what is updated. The report prints as the update occurs. You can select whether to 
include sales orders only, transfers only or both when the report is run. You also have the 
option to print the transfer tickets for the transfers that had backordered quantities 
committed. As orders and invoices are entered, some line-items have backordered amounts, 
usually because on a customer order there is an amount greater than the quantity available. 
In time, another shipment of the backordered item arrives at the user’s company. Some of 
this new stock may be partially committed from special orders that were imported to create 
purchase orders; however, the rest of the quantity is available. Since the quantity is 
available, it can once again be committed by new orders and invoices, leaving none left over 
to fill backorders. To avoid leaving backordered quantities on permanent backorder, the 
system allows the user to run this program. This program checks orders and backorders for 
backordered amounts. The program does not check invoices, printed or confirmed orders, 
quotes, counter sales, etc. Sales orders and backorders for customers on hold are not 
checked for backordered amounts. If the program finds backordered amounts, it then looks 
to see if the item has any quantity that is available. If there is enough of the item available to 
fill the entire backorder quantity and leave at least one in stock, the system automatically 
commits the quantity and sets the backordered amount to zero. For serial or lot number 
items, the system does not commit the backordered amounts if the OE Serial/Lot Number 
Entry flag in the Sales Orders Static Control Record is set to Y. Infor™ recommends that you 
run this program after running the purchase order Receipt Register, after entering 
adjustments in inventory control, or after a large amount of line-items have been deleted or 
voided. If there are a large number of orders and invoices in the system, this program may 
take some time to run. Report information includes order number, order type and status, 
requested date, warehouse code, customer number and name, item number and description, 
and the amount committed and its corresponding unit of measure. 

The Transfer Document Inquiry allows you to view the various record types that make up a 
transfer document 
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Program concepts 

Adjustment Entry (ICE210) 

Updating the on-hand quantities 
Updating the on-hand quantity based upon the adjustment amount occurs immediately as 
the transaction is recorded. If the adjustment type is an R-receipt, the unit cost is also 
entered and the current cost updated according to the costing flag is the IC static control 
record. If the adjustment type is an S-sale, the sales dollars (dollar amount of sales) are also 
entered. If the adjustment type is an A-adjustment, the cost is also entered. The Adjustment 
Register should be run periodically to give a hard copy of all adjustment and repackaging 
transactions and update general ledger. 

You have the ability to cost serial and lot items by the system cost (costing method for the 
module). The feature provides for GAAP compliance. For the FACTS SO, IC and MC 
modules, you can decide if the cost for serial and lot items will be averaged actual (as it has 
always operated in the past) or system cost (costing method for the module). The default 
setting for each Static Control F/M is A-Averaged Actual (same behavior as they have before 
the monthly is applied). Users who want to take advantage of this change will need to 
change the option to S-System Cost for each of the applicable modules. The net result of 
selecting S-System Cost is that serial/lot items will be costed like non-serial/lot items. The 
results of this program are affected by this selection. 

Lead time: If the adjustment type is "R" for receipt and the restocking warehouse is direct 
from the vendor, the lead-time is set to abnormal only if the item is stocked and the 
replenishment flag (located on the Main view of Warehouse/Item F/M) is Y. Otherwise, the 
lead-time flag is blank. 

EWMS processing note: The Adjustment Entry (ICE210) program does not allow exiting an 
item that is in an Accellos-controlled warehouse if the adjusted quantity does not sum to 
zero. All quantity adjustments should be done in Accellos. The only reason this program 
should be used is to adjust costs. So you can adjust one out at one cost and back in another. 
The net effect on inventory quantity is zero. 

Replenishment hierarchy 
The Replenishment hierarchy encompasses the parameter settings necessary to utilize 
many of the features in Advanced Inventory Management (AIM) replenishment.  Refer to the 
Infor Distribution FACTS 9.3.0 Advanced Inventory Management (AIM) Guide for advanced 
replenishment. 

The Advanced Inventory Management (AIM) process utilizes a parameter setup, which 
defines the inventory and replenishment settings at the company, warehouse, vendor, and 
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purchasing line levels and requires additional parameters to be established based on a 
hierarchy for applying the parameter settings.  

The hierarchy utilized by FACTS is listed here from least to most specific. 

Company 

Warehouse 

Vendor 

Purchasing Line 

Item 

Warehouse / Item 

The parameters are stored in the ICREPL–Inventory Control Replenishment Parameters 
table. The table ICREPL fields control parameters affecting the replenishment algorithm for 
an item or items. The functions that the parameters serve are explained in further detail here, 
and can be summarized as implementing the Grant Howard Best Practices for Inventory 
Management approach. At the minimum, the Company level parameters must be established 
/ reviewed, with their default values dictated by the AIM process. 

You may decide to set up only the company level record for the majority of the parameters, 
and set only select parameters at other levels. Most parameters have a flag that turns them 
“on” or “off.” If you choose not to have any parameters at the vendor or purchasing line level, 
for example, do not create those Inventory Control Replenishment Parameter records. Some 
parameters are available at the company, or company and warehouse levels only. 

This function will also track usage and cost matrix settings used to adjust ordering controls 
when a product experiences low or exceptional usage. The Replenishment Parameter 
Maintenance program presents the options in a logical, easily understood format where 
settings can be made at the company, warehouse, vendor and/or purchasing line level.  

Replenishment variables calculations 
The replenishment variables for an item will be updated when an item transaction is 
recorded. An item transaction is defined as receiving or disbursing an item from a warehouse 
by any system document. When a register operation or update routine is performed, the 
Order Point and Line Point values for an item will be recalculated and stored in ICWHSE for 
reference to replenishment. 

Usage calculation 
Usage by Item will be summarized by the Daily Sales Register (DSR) from the item’s 
transactions recorded in the ICRDST table. The summary table ICUSED will provide usage 
information for replenishment calculations. Qualified usage adjustments recorded in ICRDST 
will be reflected in ICUSED upon the next DSR. Therefore, the daily usage for an item will 
not be stored in the system until the daily sales register has been performed but can be 
calculated at any time from the disbursements of the item. 
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Item by warehouse replenishment variables 
The calculation of an appropriate Order Point / Line Point values per Item by Warehouse is 
instrumental to the AIM process. The factors of Lead Time, Vendor Review Cycle, Economic 
Order Quantity (EOQ), ASQ, Five-Hi and usage trending are factors in determining an 
accurate Order Point and Line Point set of values. The addition of daily transactional usage 
by warehouse and item combination allows these values to be updated to meet the current 
system state. 

Calculation of order point 
The Order Point is calculated using the Lead Time from the ARP and Safety Stock value for 
the item by warehouse. The Lead Time is the average number of days prior to the product 
being received to the replenishing warehouse. The number of Lead Time days, the period in 
which the Lead Times must occur, and the minimum and maximum days for Lead Times are 
all configurable at each level of the AIM Hierarchy. Once the average Lead Time has been 
established, the Average Daily Usage (ADU) is calculated and a Safety Stock Percentage or 
Days is applied for the calculated Order Point. Since the Order Point may not have sufficient 
history to be calculated according to the buyer’s metrics, a T-Minimum Order Point (T-Min) 
can be established to serve as a “floor”, which Order Point cannot fall below in the AIM 
Hierarchy. 

The calculated Order Point will then be compared to the ASQ and Five Hi calculations for the 
item. The maximum of Calculated Order Point, T-Min, ASQ and Five Hi are utilized to ensure 
proper quantities can be made available based on Sales Order Demand for the warehouse. 
Therefore, if ASQ, Five Hi, or T-Min exceeds the Calculated Order Point, the highest value 
will become the Order Point for the item. A threshold may be configured for ASQ and Five Hi 
to keep the Order Point from increasing more than a specified dollar amount. This threshold 
will also be applied to the final Order Point calculation where applicable. 

Line point by item 
The Line Point for an item is the stocking level to achieve based on the Review Cycle for the 
item by warehouse. The calculated usage based on the Review Cycle is added to the Order 
Point to determine the Line Point for the item. When an item’s PNA falls below the Line 
Point, it will appear for replenishment in the system. During the replenishment process, a 
temporary Line Point can be calculated by adjusting the review cycle in order to meet the 
buying target, or synch a product line to a Stocking Level. 

Order quantity 
The Order Quantity is a comparison of the adjusted usage during the review cycle and the 
EOQ for the item. The greater of the two values is used for the order quantity, and the 
quantity is rounded to the next standard pack based on the ROQ setting for the item. 
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Item ranking 
An item’s Rank is determined by the number of Hits the item incurs during a number of 
periods at the document level. An item’s ranking will be updated during the Daily Sales 
Register (DSR). Therefore, the parameters determining an items’ Order Point / Line Point will 
be updated to reflect current system requirements. An item’s Rank will also determine the 
number of periods to apply a slope percentage when calculating ADU. 

Ranking for an item will be performed for stocking items that are flagged as Replenish for a 
warehouse. If a non-replenished item is changed to a replenished item, the system will utilize 
the usage information captured for the item to calculate the appropriate rank. 

(Movement Class for an item by warehouse was replaced with Rank.) 

Tending of usage data 
The usage data will be collected daily for all stocked items in the system. This will allow for 
accurate calculation of ADU for Order Point and Line Point. The extrapolated data points for 
seasonal usage will employ a T-Backward usage calculation. The usage for an item will be 
examined for 12 periods in arrears, backing up a number of periods based on an items Rank. 
The number of periods utilized for trending will be based on an item’s Rank. The higher the 
activity Hits for an item, the higher the Rank and thus a smaller the window to be utilized for 
trending. An “A” ranked item will have a 3 month backward and forward trend and require 15 
months of history. A “B” ranked item will have a 4 month trend window and require 16 
months of history, and so on. 

Trending for a non-seasonal item will employ either a B-Backward or F-Forward ADU 
calculation. For B-Backward, an “A” ranked item will look at the prior 3 periods of usage to 
calculate the ADU. An F-Forward “A” ranked item will go back 12 periods and use the 3 
Forward periods for the ADU calculation. The trending type for an item can be configured at 
the Warehouse / Item level. 

Long- and short-term surplus 
In the Inventory Control, long- and short-term surplus processing is available for transfers 
and long- and short term surplus quantities are viewable in these programs:  

• Warehouse Display for Item (ICC150) 
• Transfer Entry and Quick Transfer Adjustment (ICE350) via the View>Warehouse 

Quantities Display menu option 
• Transfer Document Inquiry (ICI640)-Line detail  
• Warehouse/Item F/M (ICF920) General View 

Note: The Replenish check box on the Restock view of Warehouse/Item F/M (ICF920) is one 
of the controls for whether surplus is calculated. If the Replenish checkbox is unchecked 
then this warehouse/item does not have surplus checking and the long- and short-term 
surplus fields are “N/A”. If changing the Replenish checkbox from unchecked to checked, the 
long- and short-term surplus fields are not updated until the continuous background process, 
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S4, runs and calculates the surplus for this now replenished item. You must save the change 
in Warehouse/Item F/M and exit. Once S4 is run, when you return to Warehouse/Item F/M 
any noted surplus is displayed. 

In Replenishment Parameter Maintenance (ICF990), the Surplus Stock category parameters: 
Long-Term Surplus, Seasonal and Long-Term Surplus, Non-Seasonal are used to determine 
long- and short-term surplus points. The long term surplus point is calculated based on the 
values for either seasonal or non-seasonal items. The usage calculation, number of days’ 
supply over available stock, and the number of days an item must be established to calculate 
long-term surplus are used to determine the long-term surplus point. The short-term surplus 
point is calculated based on line point and EOQ. 

These defaults are used if values are not entered for the Surplus Stock parameters: 

• Total yearly usage calculation  
• 365 days’ supply over available stock  
• Skip of items established less than 180 days 

System alerts and background processes  
The system alert and background processing routines facilitate any actions needed to 
populate the Buyers Control Center and Exception Control Center. The system has a defined 
set of routines and the update interval required to perform the exception and replenishment 
calculations. In addition, order point and line point adjustment routines receive updates 
during system register processes. Receipt of items will adjust the order point based on lead 
time changes for example, and occur automatically at preset intervals. The background 
processing agent is responsible for handling these updates and providing the data to the 
system. 

The System Alerts Dashboard is used to review the alerts that a user is subscribed to and 
manage alert subscriptions. In the browser in the lower portion of the screen, the system 
displays the alert code and description and number of subscriptions for each. 

You can highlight an alert line in the browser and select Manage Subscriptions to access the 
Manage Alert Subscriptions (ALE105) screen where you can add a subscription for an alert 
type. 

You can select Alert Details to view the Details for System Alert screen, which displays the 
Alert code and name, an explanation of the alert and the condition that generated it, where 
the alert is delivered - to the user, the Exception Control Center program or both, and the 
available subscription values. Once you have reviewed the alert detail information, select the 
Ok button to exit the screen and return to the System Alerts Dashboard. 
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Replenishment parameters 
Note: Replenishment information is presented in this guide as an overview.  Refer to the 
Infor Distribution FACTS 9.0 Advanced Inventory Management (AIM) Guide for detailed 
information   

The Inventory Control replenishment parameters are divided nine categories: The 
parameters are entered in the Replenishment Parameter Maintenance program, and the 
fields are contained in the ICREPL – Inventory Control Replenishment Parameters table.  

For the following defined scenarios, the system will generate an alert for handling in the 
Exception Control Center (ECC) program, according to the hierarchy defined in 
Replenishment Parameter Maintenance. 

Alert on Expiring Parameters 

Alert on Non-Replenishment Items with Hits 

Usage Alert Settings 

Alert on Product Arriving Too Early/Too Late for Demand 

Alert on Calculated VS. Frozen Order Point / Line Point / Order Quantity Variance 

Alert on Unconfirmed Purchase Orders 

Alert for Purchase Orders Past Promise Date 

Review Cycle Out of Outside Limits Alert 

Seasonality Analysis Alert 

Replenishment System Alert Details 
To add a subscription for an alert using the Manage Alert Subscriptions (ALE105) screen, 
specify the Available Subscription values listed for the specific alert you are subscribing to.  

Frozen Controls 
The Advanced Inventory Management process contains controls that allow automatic 
replenishment of exceptional products under certain conditions. 

FACTS month end processing functionality employs a number of qualifiers that “freeze” 
products from being automatically replenished. Examples of frozen products include those 
with less than six months usage history (new products), products with low demand, and 
products that experience exceptional, or high usage in a particular month. The intention is to 
force the buyer to review the frozen products and manually adjust ordering controls when 
necessary. This manual process ensures adequate stock levels are maintained for these 
“exceptional” products and customer service is not adversely affected. ‘Freezing’ products 
that qualify under these controls, an exception record is created. The Exception Control 
Center (ECC), specifically, provides a method for reporting exception notifications to the 
buyer instead of freezing those products. 
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This exception will show frozen products that are due to be unfrozen within the next month. 
This exception is generated only one time, when IC End of Month Processing is run at month 
end, and is dependent upon the Frozen Controls fields in Warehouse Item F/M (ICF920). 

Freeze Order Point / Line Point / Order Quantity 

Freeze Rank 

Freeze Lead Time 

Freeze Safety Stock 

Lead Time 
Lead time is the amount of time required to replenish a product in your warehouse, from the 
moment a purchase order is generated in the system, to the moment it is on the shelf and 
ready to sell. The average lead time is stored for each product in Warehouse/Item F/M. It is 
updated each time new product is received in PO Receipt Entry. Lead time, expressed as a 
number of days, is used to calculate a product’s order point, an indicator of “when to buy.” 

Order Point = [Usage Rate * (Average Lead Time Days / 28)] + Safety Allowance 

Lead time days are also used to calculate safety quantity when safety is defined in 
Warehouse/Item F/M as a percentage. 

There are times when lead time on a particular receipt should be ignored and not factored 
into the average lead time. Generally, this occurs when a product’s lead time varies 
significantly from the average, and, if factored into the average, could result in an order point 
that is too high or too low. Other examples of receipts where you might ignore the lead time 
include: 

When a product was shipped using a faster shipping method to expedite delivery on a 
specific order 

When stock is purchased as a “pre-buy” to take advantage of early purchase discounts, but 
shipment is delayed 

When stock is received in the system long after it actually showed up in the warehouse 
(delay in data entry) 

When a purchase order was not created until the date of receipt 

The Lead Time options provide parameters that can be set to monitor exceptional lead times 
and automatically override lead time. You can set to ignore the lead time on product 
replenishment transactions in several FACTS functions. 

Lead time is calculated by adding the last lead time and the most current lead time and 
dividing by two. If the next-to-last recorded lead time is over six months old, the last lead time 
is used (no averaging is performed) or by calculating lead time based on a user-defined 
number of receipts, over a user-defined number of months. 
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Vendor-approved replenishment path (ARP) 
Lead Time is part of the calculation for Order Point, and in cases where very long lead times 
occur, they can cause the order point to grow to unrealistically high levels. Similarly, if 
average lead time ends up being a very small number, it can lead to meaninglessly small 
order points. 

To prevent either of these situations from occurring, you can establish a minimum and 
maximum lead time to use in the order point calculations.  

Use a Minimum / Maximum Days for ARP 
Vendor Lead Time 

Indicates whether to apply a minimum and 
maximum lead time 

Lead Time Minimum Days Smallest # of days to use for lead time from a 
vendor 

Lead Time Maximum Days Largest # of days to use for lead time from a 
vendor 

Transfer-approved replenishment path (ARP) 
Same as above except for warehouse transfer ARPs. 

Use a Minimum / Maximum Days for ARP 
Warehouse Lead Time 

Indicates whether to apply a minimum and 
maximum lead time 

Lead Time Minimum Days Smallest # of days to use for lead time from 
a warehouse 

Lead Time Maximum Days Largest # of days to use for lead time from a 
warehouse 

Receipts used to calculate lead time  
For calculated lead times to be accurate, you need to have a reasonable number of recent 
receipts. These parameters establish the limits on how and when to calculate average lead 
time. 

The first two indicate how many receipts you must have within a given number of months in 
order to be able to calculate the average lead time. 

Assuming those minimums are reached, the next set of values indicate how many receipts 
you can use over the given number of months for the calculation. 

# Receipts Required Must have at least this # of receipts 

Number of Months The # of required receipts must be within this number of months 
preceding 
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Number of receipts to 
use 

This is the maximum number of receipts to use for the calculation 

Number of Months This is the maximum number of months back a receipt can be to be 
used in the calculation 

Abnormal Lead Time Parameters for ARP Vendors 
For calculated lead times to be accurate, you also need to set parameters to determine if a 
new lead time is normal or abnormal.  

These parameters establish what lead time information is used to calculate average lead 
time. 

% of Average Too 
Low field 

The percent difference below the existing average lead time for a new 
lead time to be considered abnormal. 

% of Average Too 
High field 

The percent difference above the existing average lead time for a new 
lead time to be considered abnormal. 

Abnormal Lead Time Parameters for ARP Transfers 
Same as above except for warehouse transfer ARPs. 

% of Average Too 
Low field 

the percent difference below the existing average lead time for a new 
lead time to be considered abnormal. 

% of Average Too 
High field 

the percent difference above the existing average lead time for a new 
lead time to be considered abnormal. 

New Item Default Lead Time for ARP Vendors and ARP Transfers 
The New Item Default Lead Time for ARP Vendor/Transfer parameters determine the default 
lead time for new items at the vendor “V” level and at the warehouse transfer “T” level.  This 
value is used if the IC Warehouse average lead time field is blank. 

Users are alerted to set up a default lead time when/if desired, at the scope(s) desired, in 
Replenishment Parameter Maintenance. When new item entry is made in Warehouse Item 
F/M, if the ARP is from vendor then the ‘vendor’ default is used, if the ARP is from another 
warehouse then the ‘transfer’ default is used. 
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Order Point Adjusters General Settings 
Order Point adjusters are parameters that allow the calculated Order Point to reflect 
replenishment needs based on usage at the customer level. The parameters are applied 
during the scheduled Replenishment Parameter update. Threshold Minimum, ASQ and Five 
Hi quantities are all considered when calculating the Order Point based on the Safety Stock 
and Lead Time for a warehouse / item. The highest of the values obtained from Threshold 
Minimum, ASQ and Five Hi is used to calculate the Order Point for the warehouse / item. 
The net result of the order point adjuster is to allow the system to compensate for how a 
customer’s buying habits are reflected in the purchasing and stocking of an item. This will 
help prevent stock out situations for normal usage patterns. 

The order point helps you determine when the right time to buy is. A reliable order point is 
critical; however, it’s calculated based on average product usage. As most distributors know, 
averages don’t always represent customers’ buying habits. The goal of the order point 
adjusters is to provide a tool for calculating accurate order quantities for those products that 
experience demand that is infrequent or where order quantities vary considerably from one 
order to another. This tool will help improve customer service by preventing stock-out 
situations for products that experience unusual usage patterns. There are three order point 
adjusters that can be set up: Average shipping Quantity (ASQ), Five-high, and Threshold 
Minimum. 

These are order point adjusters. 

ASQ/Five Hi Months (Usage Periods for ASQ and Five HI calculations) 

Five-High ASQ Adjuster Parameters 

Average Shipment Quantity (ASQ) Adjuster Parameters 

Threshold Minimum Order Point 

All non-stocked items (set in Item F/M) will have all warehouses forced to not replenished 
and will have 0 average shipment quantity (ASQ) and 0 usage. 

Order quantity replenishment settings 
The Order Quantity is a comparison of the adjusted usage during the review cycle and the 
Economic Order Quantity (EOQ) for the item. The greater of the two values is used for the 
order quantity, and the quantity is rounded to the next standard pack based on the Round up 
Order Quantity (ROQ) setting for the item. 

The MIN / MAX replenishment model is achieved by setting the Order Point and Line Point 
values as desired and then setting Frozen Controls to all values with a Freeze Periods of 99. 

The EOQ is calculated as: 

 
Economic Order Quantity 
Average Usage is by Month 
Multiply by 24 (2 * average usage per year is the EOQ formula) 
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The calculation of an appropriate Order Point / Line Point values per Item by Warehouse is 
instrumental to the AIM process. The factors of Lead Time, Vendor Review Cycle, Economic 
Order Quantity (EOQ), Average Sales Quantity (ASQ), Five-Hi and usage trending are 
factors in determining an accurate Order Point and Line Point set of values. The addition of 
daily transactional usage by warehouse and item combination allows these values to be 
updated to meet the current system state. 

These are Order Quantity Replenishment Parameters. 

OQM for Trend Items ARP Vendor 

OQM for non- Trend Items ARP Vendor 

OQM for Trend Items ARP Transfer 

OQM for non-Trend Items ARP Transfer 

Apply Rounding to Order Quantity 

Rounding Value for ARP Vendor 

Rounding Value for ARP Transfer 

Minimum Order Quantity for ARP Vendors and Transfers 

Rank 
Ranking is a method of classifying products based on their relationship to other products in 
your inventory. It is used by your buyer to ensure that products that experience a higher 
volume of sales are ranked higher, and that replenishment controls are in place to make sure 
there are always adequate stock levels for the higher ranked products. When products are 
ranked, they are placed into three or more groups for the purpose of stock control and 
planning. Called ABC ranking, these groups represent products ranked based on their sales 
“hits.” Hits are the number of times a product appears on a sales order, warehouse transfer, 
or lost business transaction, regardless of quantity. These are called line hits. By tracking a 
product’s line hits, you can rank a product by the volume of transactions it appears on. 

The products with the most hits are ranked as A items. A items generally represent a smaller 
group (15-20%) of products that result in around 75-80% of the annual demand. For the 
purpose of inventory control and replenishment, the greatest attention should be paid to 
these A-ranked products. 

Products with fewer hits are ranked as B, C, D, and so on (up to 26), based on how your 
ranking levels are defined. Least attention is paid to the lowest ranks. 

Threshold Minimum Rank for New Items 

Rank is only calculated on replenished items.  Non-replenished items are always assigned a 
rank of E. 

An item’s rank in the warehouse is used for multiple calculations and is an indication of how 
it compares to other items in the warehouse in terms of hits. 

This setting applies to all new items setup in a warehouse.  The new product’s rank will be 
set and remain fixed for the specified number of months from the date the item was 
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established in the warehouse.  Its rank will not be recalculated by the system.  This setting is 
separate and distinct from the freeze rank setting.  If an item’s rank is frozen, that frozen rank 
will always be used, even if it’s a new item. 

Because items that are newly established in a warehouse have little or no usage, the 
automatic ranking would immediately push them down to an E rank, causing the 
replenishment controls to stop most purchasing activity. 

Previously this was countered by “mocking-up” usage for the item, but since Rank is now 
based on document hits, that process will no longer work. 

Instead, you can establish a minimum Rank for new items and a number of months since 
inception that an item should be considered “new”.  If FACTS calculates a rank lower than 
the T-Min Rank, it will override it and assign the T-Min.  If sales of the item quickly take off, 
the Rank will increase as warranted. 

After the item has been established for more than the specified # months, the T-Min Rank 
will no longer be applied. 

Rank The rank that will be used for all new items in the warehouse 

Number of months The number of months the new item rank will be used. 

Review Cycle 
The review cycle and buyer can be designated for transfers. The buyer can be designated 
for each Approved Replenishment Path (ARP) based on this matrix. 

Source Purchasing Line 

Vendor <not specified> 

Vendor Purchasing Line 

From Warehouse <not specified> 

From Warehouse Purchasing Line 

An example is buyer 100 for warehouse 01 can be established for items to be transferred 
from warehouse 02 for purchasing line “Warehouse Items”. Buyer 200 for warehouse 01 can 
be established for items to be procured from vendor V100 with no purchasing line set. 

Buyer Code Buyer code for the ARP 

Review Cycle The number of days to use for calculating Line Point 

Review Cycle Min Minimum number of days between replenishment activity (optional, 
display only) 
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Review Cycle 
Max 

Maximum number of days between replenishment activity (optional, 
display only) 

Use Target The target (Cost, Weight, Cubes or none) to use to automatically calculate 
the review cycle. 

Buying Target $ The target currency value for meeting replenishment requirements for this 
ARP 

Buying Target 
Lbs 

The target weight for meeting replenishment requirements for this ARP 

Buying Target 
Cubes 

The target volume for meeting replenishment requirements for this ARP 

Memo Optional memo for review cycle entries 

For Review Cycle an additional From Warehouse parameter is available in Replenishment 
Parameter Maintenance. Therefore, it doesn’t fit in the “normal” hierarchy, but rather has its 
own unique settings for Review Cycle. The hierarchy that the system uses for Review Cycle 
is as follows: 

Warehouse + From Warehouse 

Warehouse + Vendor 

Warehouse + Purchasing Line 

Purchasing line is the most unique, and Vendor and From Warehouse are at the same 
“level”. From Warehouse is used for Transfers and Vendor is used for Purchase Orders. 
Purchasing Line is only used for Purchase Orders at this time, too. 

Safety Stock 
Safety stock, also referred to as safety allowance, is the additional stock you carry in 
inventory to protect against a stock out. If forms a pad to take care of reasonable variations 
in usage or lead time from the averages anticipated. Safety allowance is an amount that you 
define for each product in IC Warehouse/Item F/M (ICF920). It can be entered as days, a 
percentage, or a quantity. FACTS will convert a days or percentage value to a quantity and 
use that value to determine the product’s order point. 

These are safety stock parameters. 

Safety Stock for Approved Replenishment Path (ARP) Vendor Parameters 

Safety Stock for ARP Vendor Adjusters 

Safety Stock for ARP Warehouse Parameters 

Safety Stock for ARP Warehouse Adjusters 
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Usage 
When determining the usage for an item in the Order Point and Line Point calculations, the 
number of periods for analysis is indicated by the item’s rank. The higher an item’s rank, the 
fewer the number of periods should be specified. The usage periods by Rank are used in the 
Backward, Forward and Trending usage analysis for an item.  

These are usage parameters. 

Threshold Minimum Usage 

Trending Parameters and Adjusters 

Usage Months for Seasonal and Non Seasonal 

Seasonal Lead time Advance for Transfer and Vendor ARPs  

Surplus Stock 
Surplus stock is defined as the quantity over the long and/or short-term surplus points. These 
points are calculated. Short term point is calculated based on line point and EOQ. The long 
term surplus point is calculated based on the values in Replenishment Parameter 
Maintenance (ICF990) for either seasonal or non-seasonal items. For long-term surplus, the 
usage calculation, number of days’ supply over available stock, and the number of days an 
item must be establish to calculate long-term surplus are used to determine the long-term 
surplus point. The long-term surplus point will never be less than short term surplus point; 
even if all surplus is short term, long term surplus point will be equal to or greater than short 
term surplus point. 

Short- and long-term surplus points may differ or be the same. Stock quantities may be all 
short-term surplus, all long-term surplus, or a mixture of both. There may also be no surplus 
stock at all, if quantities on-hand are below any given surplus point. For example, a surplus 
point of 10 means, if you have stock quantities of 100, then, starting at quantity 10, the rest is 
surplus. A quantity of 90 is in surplus even though ICWHSE shows the surplus point 10. It 
does not mean a quantity of 10 is in surplus.  

These are surplus stock parameters. 

Long-Term Surplus, Seasonal   

Long-Term Surplus, Non-Seasonal   
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Costing and pricing  

Work flow 
The Suggested Cost/Price Entry (ICE410) program allows you to enter and/or maintain 
suggested cost and/or prices by unit of measure for individual inventory items. 

Use the Create Suggested Costs/Prices (ICU410) update program to create suggested costs 
and prices, based on user-specified parameters, for a range of items. For example, you may 
choose to update the current selling price of all items supplied by a given vendor by 5%. 
Based on this information, this program calculates and creates the suggested price record 
for every item provided by that vendor. Update Suggested Costs/Prices (ICU430) updates 
suggested costs and prices based on user specified parameters for a range of items 
selected by the user. Costs and prices that are updated are written to the current 
costing/pricing files and are then removed from the suggested cost/pricing files.  
eCatelog Note: When a list price is changed, the system adds a record to the eCatalog log 
file for the next update to the eCatalog database. Use Erase Suggested Costs/Prices 
(ICU420) to erase suggested costs and prices based on user specified parameters for a 
range of items selected by the user. The Print Suggested Costs/Prices (ICR410) program 
allows you to print suggested costs and prices based on user specified parameters for a 
range of items selected by the user. 

The Cost/Price List - Vertical (ICR420) program prints, in a vertical format, current costs and 
prices based on user specified parameters for a range of selected items. 

The Cost/Price List - Horizontal (ICR425) program prints, in a horizontal format, current costs 
and prices based on user specified parameters for a range of selected items. You can limit a 
customer's price list to only those items a customer has purchased since a cut-off date. The 
report can be further limited by only one ship-to address. You also have the option to add 
other individual items at run time (for cross-selling). An additional option allows the price list 
to print suggested prices. For example, large companies may want a 30-day notice of any 
price changes. Being able to create a report of suggested prices instead of current pricing, 
allows us to give customers their price list 30 days in advance of price changes. If you 
specify a customer, Information buttons are displayed at the Print and Include prompts if you 
have entered values that might confuse or provide undesired information if the customer 
receives the report. 

Use LIFO/FIFO F/M (ICF410) to create and maintain last in first out (LIFO) or first in first out 
(FIFO) costing layers. It is only available for use when the LIFO/FIFO Layers flag in the IC 
Static Control Record is set to O-LIFO or F-FIFO. Information is entered for each item by 
warehouse. It includes for each level (up to 10 levels allowed) the sequence number of the 
layer, date received, received cost and quantity received. This file is updated by Purchase 
Order receipts and through the IC Adjustment Entry program when the adjustment code is 
RC (receipts) is used. 

LIFO/FIFO Cost Layer Print (ICR430) prints a list of all LIFO/FIFO costing layers and 
available quantities for each item. An average weighted cost is also included for each item. 
Report information includes the following: (1) warehouse code and description, (2) item 
number and description and (3) for each costing layer the costing layer number, sequence 
number, receipt date, received cost, costing unit of measure, units received, current on hand, 
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committed and available quantities and stocking unit of measure. An average-weighted cost 
is provided along with the total on hand, committed and available quantities for each item. 
The total number of items listed is also included. 

Cost discrepancy processing  
Use Cost Discrepancy Entry (ICE610) to identify and correct receipt documents that have 
been updated with the wrong cost. The receipt record (ICRCPT) is updated immediately so 
that any further disbursements of that receipt will be at the correct cost. The General Ledger 
is updated when the Cost Discrepancy Register is run.  

For PO receipts that have been updated but not yet run through the PO Receipt Register, a 
message is displayed and cost discrepancy entry is not allowed. Adjustment records are not 
displayed in Cost Discrepancy Entry browser if they have not been processed through the 
Adjustment Register. 

You can highlight a line in the browser and click Disbursements to drill down to the source 
document if the appropriate inquiry program is available. 

Click Verify Receipts to check all cost discrepancy records currently on file for their 
matching receipt. If not found, the cost discrepancy record is removed. At least one cost 
discrepancy record is required to enable the button. 

When using cost factoring, the current and new unit costs are the same because the cost is 
factored across units. In the browser, the Factored Unit Cost column contains the factored 
cost that is applied during the register when no cost change is visible. 

In the Cost Factoring section, the total cost amount to factor for the document and memo are 
displayed. Specify the factor type: by weight, cost or units. You can optionally specify the 
Offset GL account to use an alternate GL Offset account (offset to Inventory) for factored 
cost. For certain document types, the GL Inventory and Offset accounts will not be available. 
These entries are allowed, but the register will only update the receipt and disbursement 
costs since the GL accounts are not known. 

In the browser, all of inventory lines for the selected document are displayed. For 
Adjustments and Warehouse documents, a single line is displayed in the browser; you 
cannot specify cost factoring information. 

When a cost factoring value is specified, click Update Cost to calculate the unit factor value 
and display the value in the browser. If the entered cost factor value is not evenly 
distributable, you can choose to ignore the message or fix it. Specify Ignore to allow the 
uneven distribution to be saved and manually update individual lines to account for any 
unenven distribution. Specify Fix to allow entry of a new cost value. The Factored Unit Cost 
column is only populated when using cost factor. 

Note that factored costs do not show as individual lines in the browser, but are distributed 
and visible after register processing. 

You can edit an inventory line for the new unit cost and specify a memo to explain the 
change. The browser display includes the Item number and description as well as quantity 
and unit of measure, Current Unit Cost, New Unit Cost Unit Cost Difference, the Total Cost 
Difference, and memo.  
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In the browser, the Cost Overridden column includes an asterisk, *, when the receipt cost 
was changed by the user. 

When using the look-up button for on file cost discrepancy records, factored cost records are 
included in the look-up results. Cost discrepancy records, which are auto-created by an over-
shipment being filled by a receipt, are not included in the look-up results. 

For serial/lot lines, the cost discrepancy update is extended to each serial/lot number, but 
you cannot change cost separately for each serial number. If any cost discrepancies have 
been entered, but not posted, you must run Cost Discrepancy Register before you can close 
the GL or IC period. 

If the costing method is anything other than LIFO or FIFO, no cost changes will be made to 
the past documents that make up the disbursements. 

In the header portion of the program, specify the warehouse and the document type:  PO – 
PO Receipt, TR – Transfer Receipt, AD – Adjustment, MC – Bill of Materials, MF – 
Formulation, WH--Warehouse document, or SO – Sales Order/Credit Memo.  For document 
types except adjustments and warehouse, specify the Doc ID # and for PO receipts, transfer 
receipts or sales orders/credit memos specify the Receipt/Ship#/Invoice#.  For adjustments 
and warehouse documents, specify the item number and date of the adjustment.       

Over-shipments 

If the filling of an over-shipment (OS) has a different cost than what was used on the usage 
document, a cost discrepancy record will be automatically created during the receipt process 
and flagged as User Entered =”N”.  Cost discrepancy records for over-shipments are display-
only and cannot be edited or deleted in this program. You must run the Cost Discrepancy 
Register (ICR610) to process cost discrepancy records for over-shipments to finalize the 
changes and allow additional edits to be performed.  

Special-order temporary items 

Special-order temporary items are included in cost discrepancy processing for the Cost 
Discrepancy Entry and Cost Discrepancy Register programs. 

If a temporary item is entered in Order Entry as a special order, then the temporary item is to 
be received on a tied special-order PO or transfer. During Order Confirmation, a tied 
disbursement record is created, against which any cost discrepancy entry can be 
successfully applied. Cost discrepancy entry and register for this type of special-order 
temporary item updates cost for both the receipt and the disbursement of that special-order 
temporary item. 

Use the Cost Discrepancy Register (ICR610) to print a register of cost discrepancies entered 
in the Cost Discrepancy Entry (ICE610) program. If any cost discrepancies have been 
entered, but not posted, you must run the Cost Discrepancy Register before you can close 
the GL or IC period. All records post to the GL period based on the register date. The GL 
account numbers come from the receipt record (ICRCPT), so they post to the same accounts 
as the original receipt. The GL Update writes journal entries for the cost discrepancy from the 
receipt as well as any disbursements from that receipt. Note that default GL account 
numbers are not assigned by this register. 

At the top of the screen, warehouses with discrepancies are displayed and the first 
warehouse in this list is displayed by default in the warehouse prompt.  
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Any time you run the Cost Discrepancy Register, you must continue to re-run this program 
until there no records available. Processing in the Cost Discrepancy Register may 
automatically generate additional cost discrepancies. These automatically generated cost 
discrepancies are not completed until the next time the Cost Discrepancy Register run. 
Always run this register repeatedly until no additional records are generated. 

GL Summary 

The GL Summary includes the line level information: document type, document number, 
Receipt / Invoice / Shipment number, Line Number, Component Line, Item and a flag 
indicating if the item is a Serial / Lot item. This information is posted through to the GL 
Journal and can be view from Source Doc button the GL Journal Inquiry program. 

IC receipt and disbursement files 

GL account numbers are written to IC receipt and disbursement files during registers. Cost 
Discrepancy Entry is only allowed on receipts that are post-register processing. Running the 
Cost Discrepancy Entry Register for receipts which have ‘open’ disbursement documents 
that are not yet run through their own register does not show GL account information on the 
Cost Discrepancy Register output. Costs on ‘open’ disbursement documents can be updated 
by the cost discrepancy register, and, when the ‘open’ documents have their own register 
run, the associated docs, having already had their costs updated through the Cost 
Discrepancy Entry Register, update GL on their own register. 

Outputs with no cost difference 

Records can be written to the cost discrepancy file when an over-shipment is filled by an 
incoming receipt. Additionally, factored cost discrepancy entry may be involved. These are 
two types of output that show no cost difference on the first page of the Cost Discrepancy 
Register. Running the register clears such records. 

When an overshipment (OS) receipt is resolved by an incoming receipt, the OS receipt 
record is removed and a Cost Discrepancy Entry record is written. Since the received cost 
did not exist at the time of the OS, now the cost is the same as the receipt that resolved that 
OS. Any change to the cost of that receipt (making the cost different than the disbursement 
document, such as the sales order) will have that disbursement  document's cost updated 
with the receipt cost during the Cost Discrepancy Entry Register. 

For example:  A new item is entered, and before any receipts occur that new item is sold, an 
OS record is written. Then, once a receipt for that new item comes in, the OS record is 
removed and the sold quantity is accounted for from that incoming receipt. To handle 
potential cost changes, a Cost Discrepancy Entry record is written and “Created by 
Processing Overshipment” is displayed on the first page of the Cost Discrepancy Entry 
Register. The received cost has not changed. The sold item’s cost, if different from the 
receipt’s cost and not manually changed by the user at entry, would need to be updated with 
that incoming resolving receipt’s cost when the Cost Discrepancy Entry Register is run. 

Update and report-only modes 

The Cost Discrepancy Register runs in report-only mode by default. The Reports Only check 
box is checked by default. You must uncheck the Reports Only check box to run in update 
mode. If a locked distribution record is encountered during the report-only output, a message 
containing the document number and the cost discrepancy which will be skipped, is 
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displayed. Make a note of any locked documents during report-only output allows for 
resolution before the Cost Discrepancy Register is run in update mode. 

When output is report-only mode no files are updated in the system. The costs presented are 
the unchanged costs. When output is run updating costs, the values presented may be 
already updated values. The costs presented may be the changed cost instead of the pre-
change cost. For example, if a receipt having disbursements associated has a cost change, 
then the disbursement summary page showing that receipt will show the original receipt cost 
in report-only mode, and show the changed, or updated, cost when run and updating costs. 

When output is report-only mode, the register number displayed in the output header is 
0000. If using Unform Document Archiving, all report-only mode output that is sent to Unform 
is stored under the 0000 register number. 

Special-order temporary items 

Special-order Temporary items are included in cost discrepancy processing for the Cost 
Discrepancy Entry and Cost Discrepancy Register programs. 

If a temporary item is entered in Order Entry as a special order, then the temporary item is to 
be received on a tied special-order PO or transfer. During Order Confirmation, a tied 
disbursement record is created, against which any cost discrepancy entry can be 
successfully applied. Cost discrepancy entry and register for this type of special-order 
temporary item updates cost for both the receipt and the disbursement of that special-order 
temporary item. 

Serial / Lot Items 

Serial / Lot items are processed by adjusting the line level cost of the usage documents (if 
used) and the receipt layer cost(s). The cost update will be performed at the lowest level first, 
and then applied back up the document lines, based on the setting for Sales Order Static 
Control F/M>Serial / Lot Cost method. If Averaged Actual is used, the lot costs will be 
averaged and applied to the serial / lot item layer cost. 

Program concepts 

Methods for Creating Suggested Costs and Prices 
The Suggested Cost/Price Entry program allows you to set up manual cost, list price, 
standard price, level prices and quantity break level prices for an item or range of items. 

Suggested Cost Price Entry allows the manual cost basis to default to the current manual 
cost basis when entering a new item. This way if the manual cost is based on list price and 
the multiplier is to be changed, you only have to enter the new multiplier and not also change 
the basis from fixed price to list price. 
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Basing Manual Cost and All Prices Off of List Price 
Note that if the manual cost or a price is based on another price, changing the price that they 
are based on will automatically cause the cost or prices that are based on it to change. In 
that case, there is no need to step through all of the costs and prices for them to be updated. 

For example, if your manual cost and all prices are based on list price, entering the new list 
price in Suggested Cost/Price Entry is all that is needed for the manual cost and all the other 
prices to be updated. There is no need to go through the manual cost fields or any of the 
other price fields in Suggested Cost/Price Entry to make them get the new values. When 
Update Suggested Costs/Prices is run, all of the values that are based on List Price will 
automatically be calculated using the new list price. 

For further clarification, when, for example, manual cost is based on list price, no actual 
value for manual cost is stored anywhere in FACTS; instead, the manual cost is calculated 
whenever it is needed by getting the current list price and applying the multiplier. 

There are three methods for creating suggested costs and prices: 

1. Using a basis and multiplier 

This method uses another existing cost or price as the basis of the new cost/price and a 
multiplier is applied against the existing one. 

If for example, the basis price was $100.00 and the multiplier was .9400, the new calculated 
price would be $94.00 ($100.00 x .9400). Taking this example further, in terms of setting up 
level prices, you can determine that each one is based on some percentage of the list price. 
If the list price is $100.00 and the levels are 1) $95.00, 2) $94.00, 3) $93.00, 4) $92.00, 5) 
$91.00 and 6) $90.00 the level prices may be set up using a basis, list price, and multipliers: 
1) .9500, 2) .9400, 3) .9300, 4) .9200, 5) .9100, 6) .9000. 

When entering costs/prices using the basis and multiplier method, the actual price is not 
calculated and stored in the pricing files. Rather, the basis and multiplier are stored in the 
pricing files and the price is calculated at the time the item is sold in the sales order entry 
programs. The advantage of using the basis and multiplier method is that when the basis 
price changes, that is the only price you have to change; the multipliers fix the rest of the 
price levels for you. 

For example, if the standard price is always a multiplier of manual cost, then the standard 
price will automatically be changed if the manual cost is changed. 

2. Using a dollar amount 

Using this method, you only enter the actual dollar amount of the costs and prices. No 
calculations are necessary. The price entered is the price that is stored in the pricing files 
and is what the system presents when the item is sold in the Sales Order Entry programs. 

3. Using a change % (percent) 

Costs/prices may be entered by entering a change % (percent) from the existing cost/price. 
For example, if a standard price of $100.00 is increasing by 3% then you enter a change 
percent of 3.000. The system then calculates and displays the new calculated price of 
$103.00. When entering a change percent, the system calculates and stores the actual dollar 
amount in the pricing files. In this example, the system would store $103.00 the pricing files 
and this is the amount that would appear in Sales Order Entry programs. 
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4. Commissions 

In addition to these three options for setting up the standard price, price levels and quantity 
breaks, you may also enter a commission percent. A Sales Order Static F/M flag determines 
whether this flag is available throughout the costing/pricing subsystem. 

If the flag is turned off, the system does not give you the option to enter the commission %. If 
the flag is turned on, each cost/price you create will require you to enter a commission %. 

When entering the commission %, you also have the option to set it to "no priority" (which 
leaves the field blank), indicating that commission is not generated based on the price being 
set up. (If the item is set to "no priority", any commission % entered in the pricing system will 
be ignored). For more information on commissions, refer to the Commission Basis flag set in 
System Management>File Maintenances>Company Control F/M. 

Physical Inventory  
The Physical Inventory menu is where you perform and complete a physical inventory. 
Performing a physical inventory is not only an easy way to update inventory quantities, but it 
also a good way to check that the inventory, purchase orders, sales orders and 
manufacturing systems are being run properly. 

Work flow 
You can control the order in which physical inventory is performed in FACTS through the 
Physical Inventory Order control in the IC Static Control F/M. FACTS allows you to perform 
physical inventory in item, alpha, vendor, item class, location (bin) or movement class order. 
Between physical inventories, you can select any physical inventory order. However, once 
you capture counts in the order selected, do not change it until after you run Update 
Inventory program. 

A physical inventory may be performed for on hand quantities or available quantities 
(available = on hand minus committed). You determine which by setting the Physical Count 
Quantity flag in the IC Static Control F/M to either Available or On hand. 

Performing physical inventory in FACTS 
The programs included on the Physical Inventory menu appear in the order they should be 
used. 

First, Print Count Sheets so staff members can record their counts for each item. Count 
sheets print the item number, description, package size, stocking unit of measure and a 
space to record the count for you so inventory takers only need to enter their counts on the 
sheets. Depending on how the Physical Inventory Order prompt is set in IC Static Control 
F/M, count sheets can be printed in item, alpha, vendor class, item class, (bin) location or 
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movement class order. Count sheets print out item numbers and descriptions, locations and 
a blank line to enter the count followed by the stocking unit of measure. The current available 
or on hand quantity and committed quantity may be printed (if available or on hand quantities 
are counted). The program also prints a line where the inventory takers can sign their 
names. The count sheet also provides the total number of items listed. The Print Count 
Sheet program gives you the option of including current quantities on count sheets for 
comparison purposes. The program also gives you the option of capturing on hand quantities 
from here, rather than the Capture Quantities program. It’s a matter of preference. 

The Capture Quantities program, enables you to print count sheets any time before a 
physical inventory and wait to capture the quantities when you are ready to perform the 
physical inventory. Therefore, the counts may be captured when printing count sheets or 
separately, as long as it is at the time of the physical inventory. Use this program to capture 
and store the on-hand or available (available = on hand minus committed) quantities and 
costs of the items selected for physical inventory. The Physical Count Quantity prompt in the 
IC Static Control F/M determines whether the program captures on hand quantities or 
available. The data is written to the physical count file, ICPHYS. Run this program after the 
last activity that would affect the warehouse/item file prior to the physical count and before 
any activity that would affect the warehouse/item file after the physical count. For example, if 
you are conducting a physical inventory over a weekend, you could run this program anytime 
between close of business Friday and opening of business Monday. You can opt to run this 
program directly from the Print Count Sheets program or on the date selected after the count 
sheets are printed. After the on hand or available quantities are captured, the physical 
inventory is taken and the counts have been entered, normal activity can resume even if the 
counts have not been updated by the system. The order in which this program captures 
items depends on how the Physical Inventory Order prompt is set in the IC Static Control 
F/M. The available options are item, alpha, vendor, item class, bin (primary and alternate) 
location or movement class order. If a record for the selected item and warehouse is already 
on file, you have the option of: overwriting the existing physical inventory record; overwriting 
this and any other physical inventory records already on file for items to be updated, or 
aborting the update. The cutoff date function is removed from the Capture Quantities 
program for Accellos controlled warehouses. 

Use the Enter Counts (ICE510) program to enter the physical count of each item taken 
during physical inventory. Prior to entering counts, the count sheets must be printed and on 
hand or available quantities captured (which type, available or on hand, is determined in the 
IC Static Control F/M). The program allows you to enter counts in the same order in which 
the count sheets were printed based on the item type prompt. After you enter the counts, run 
the Discrepancy Report and update inventory. Items may be displayed and counts entered 
either individually or sequentially in the order they printed on the count sheet. If a count has 
already been entered for a particular item, you can either change it or display the next 
record. This allows you to page through the file, checking for missed or incorrect entries. A 
scrolling feature displays the most recent transactions recorded at the bottom portion of the 
screen. This provides additional safeguards against user error due to oversight or transaction 
duplication. Enter counts for all items before you print a Discrepancy Report or run the 
Update Inventory program. The Enter Counts (ICE510) program does not allow entry of 
counts to an Accellos controlled warehouse. 

Once the quantities are captured, you physically counted the items in your inventory, enter 
them into the system. When entering counts, the items display automatically in the order of 
the count sheets. Depending on how the Physical Exceptions Only flag is set in the IC Static 
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Control F/M you may need to enter all counts (if the flag is set to N) or just exceptions where 
there is a discrepancy (if the flag is set to Y). 

Once the counts have been entered, run the Discrepancy Report to show discrepancies 
between what the system shows for quantities and what was actually counted. If there are 
problems on the report, you can enter counts again (replacing the old values) for the 
necessary items. Items with discrepancies print in the same order (item, alpha, vendor, item 
class, or location) as they appeared on the count sheets. Report information includes: item 
number and description, primary and alternate bin locations, serial lot number (if applicable), 
physical count, captured count, discrepancy between physical and captured counts, stocking 
unit of measure, cost, costing unit of measure and cost discrepancy and physical extension. 
The total number of items listed is also included. 

You may need to repeat the Enter Counts/Run Discrepancy Report process several times or 
until the physical inventory is balanced. 

When all the numbers are satisfactory, run the Physical Inventory Update program. This 
updates quantities with the new counts and removes the old quantities. 

Discrepancies are updated to the adjustments and transfers file so they can be posted to 
General Ledger through the next Adjustment Register (Inventory 
Control>Adjustments>Adjustments Register). 

Program concepts 

Multiple Bin Locations in Physical Inventory 
IC Static Control physical count order other than location 

When the count sheets are printed using Print Count Sheets (ICR510) and the Physical 
Inventory Order setting on the IC Static Control F/M is not location, the system prints the 
items in the selected sort order with the item’s primary location on the main line. If the item is 
not a serial or lot item and has alternate locations set up, the system prints additional lines 
immediately after for each, with the alternate location, a count line and the stocking unit of 
measure. The additional location lines maintain their ordinal value, so alternate location 1 will 
be on the 2nd print line and alternate location 2 on the 3rd print line and so forth. If the item 
is a serial or lot item and has alternate locations, the system prints one line showing all the 
alternate locations immediately after the main item line and no count lines print for the 
alternate locations. Then, the system prints the serial/lot lines. 

When you capture quantities and the Physical Inventory Order setting on the IC Static 
Control F/M is not location, the Capture Quantities program captures the primary location 
only for serial or lot items and the primary location and all alternate locations set up for non-
serial or lot items. 

The system captures quantities for Serial or lot items that are not flagged available for the 
primary location only. The primary location record contains the captured quantity for the item. 
For alternate bin location records the system captures a blank quantity. 
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IC Static Control physical count order is location 

When you select Location as the Physical Inventory Order and the Items Included is set to 
Primary, items are included in physical inventory processing based on the location range you 
enter in the Print Count Sheets program. This setting determines whether the location range 
searches for items in primary locations only (including alternate bin locations set up in the 
warehouse/item record) or all locations present for a warehouse/item record. 

When an item is contained in any bin location in the range of the locations selected, the 
system includes all locations for the item (whether it is in the range or not) to ensure that the 
physical count sheet is accurate.  

When you capture quantities and the Physical Inventory Order setting on the IC Static 
Control F/M is location, the Capture Quantities program captures for the primary and all 
alternate locations for non-serial or lot items and for serial or lot items that are flagged as 
available. 

When the count sheets are printed and the Physical Inventory Order setting on the IC Static 
Control F/M is location, the items are selected based the Locations Included setting in the IC 
Static Control F/M. If "Primary Location in Range Chosen" is selected and the item’s primary 
location is within the range entered, the item is selected. If the flag is set to "Any Location in 
Range Chosen", the system compares all of an item’s locations to the range entered. If any 
location, primary or alternate, is within the range, the item is selected. The system prints a 
line for the selected item’s primary and alternate locations, each in the proper location sort 
order. Only the primary location prints the on hand or committed quantity if selected. If the 
item is a serial or lot item, all serial/lot numbers will print under the primary location and only 
"available" serial/lot numbers will print under the alternate locations. 

The system prints a line on the count sheet for the selected item’s primary and alternate 
locations, each in the proper location sort order. Only the primary location prints the on hand 
or committed quantity if selected. If the item is a serial or lot item, all serial/lot numbers will 
print under the primary location and only "available" serial/lot numbers will print under the 
alternate locations. 

Multiple Bin Location Information 
For items with multiple bin locations, the following applies for the Discrepancy Report 
(ICR520): 

When the Physical Inventory Order is not location, the items print by their selected sort order 
with the primary location on the main print line. 

If the Physical Inventory Order is location, the items print by the primary location sort. 
Location information is included between the item description and physical count. If an item 
does not have alternate locations, no location information is included. If the item does have 
alternate locations and it is a serial or lot item, a second line prints immediately after showing 
all the alternate locations. When the serial/lot numbers print, they print in serial/lot number 
and location order. 

If Physical Inventory Order is location and a lot item has alternate locations, it can have 
multiple records for the same lot number. In this case, the lot number, location and count 
quantity print each on a separate line. When there are no more records for the lot number, a 
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total line prints with the accumulation of each location physical count, the lot’s capture 
information and the discrepancy information. 

If the item is not a serial or lot item and it has alternate locations, only the item, description, 
primary location and physical count print on the main line. The alternate locations print on the 
next lines, maintaining their ordinal value, and will print the same information. When there 
are no more records for the item, a total line prints with the accumulation of each location 
physical count, the item’s capture information and the discrepancy information. 

For items in multiple-bin warehouses, the Physical Inventory Update reads all location 
records and the physical count quantity is accumulated before any file updating occurs. The 
program creates only one adjustment record or ledger card record per item or item/serial lot 
number. 

Upon completion of the update, the available or on hand quantities in the warehouse/item file 
reflect the true quantities (the physical count) of the warehouse, allowing for adjustments 
made (sales, etc.) since the time that the quantities were captured. 

Items with discrepancies are updated in the same order (item, alpha sort, vendor class or 
location) as they appeared on the count sheets. 

Discrepancies post to the adjustment file so they can print on the next Adjustment Register 
and update the General Ledger. 

Printing discrepancies-only on the Discrepancy Report or Physical Inventory Update 

If the IC Static Control F/M setting for Count Exceptions Only is set to No, then the any null 
count quantity for any location is considered zero. If the Count Exceptions Only flag is set to 
Yes, a null count quantity in the primary location record is considered equal to the capture 
quantity. A null quantity in any other location records is considered zero. This comes into 
effect when you select to print discrepancies only. Using the above rules, all location count 
quantities are summed and compared to the capture quantity. If they are equal, this is also 
not considered a discrepancy. 

Reports  
Most inventory reports have the option of printing in item, alpha, item class or vendor order. 
In addition to the order, the user may choose the range to be printed. For example, if the 
order selected is item number, field of the beginning and ending item number is required. 

Program concepts 
The Stock Status Report provides a report listing the on hand quantity of each item, the 
value (cost) of the item and extension giving the total valuation of each item. The report may 
be printed by warehouse giving the value of each warehouse. Use Filter By Surplus to 
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optionally limit the report output based on surplus stock and determine the quantity an item 
has for short-, long-term surplus in the selected warehouse.  

The value (cost) may be selected when printing the report. Therefore, the user may see the 
value of a warehouse based on the standard, average, last or manual cost. You have the 
ability to cost serial and lot items by the system cost (costing method for the module). The 
feature provides for GAAP compliance. For the FACTS SO, IC and MC modules, you can 
decide if the cost for serial and lot items will be averaged actual (as it has always operated in 
the past) or system cost (costing method for the module). The default setting for each Static 
Control F/M is A-Averaged Actual (same behavior as they have before the monthly is 
applied). Users who want to take advantage of this change will need to change the option to 
S-System Cost for each of the applicable modules. The net result of selecting S-System Cost 
is that serial/lot items will be costed like non-serial/lot items. The results of this program are 
affected by this selection. An asterisk (*) indicates the on hand and committed quantities are 
insufficient to meet the committed and backordered requirements. 

In the three formats, item and report totals and the total number of items listed are printed. If 
the print order selected is vendor, the report prints item class totals within vendor and vendor 
totals. If the print order selected is item class, the report prints vendor totals within item class 
and item class totals. 

The Surplus Stock Report provides a report listing all items (non-stocked items are now 
included if they have quantity) at or above their maximum stocking levels. Long- and short-
term surplus stock is any available stock quantity over the economic order quantity (EOQ) 
point, i.e. (available – line point – EOQ). The report includes three formats: 

• Summary, which includes warehouse, stocking unit of measure, item number, cost, 
description, costing unit of measure, rank range information, extended cost, trend type, 
warehouse totals, order quantity plus line point, available stock, surplus, % of total 
inventory (factored against the current total ‘on the shelf inventory’ for the item, i.e., what 
% of the shown available quantity is the shown surplus) report totals, and total number of 
items listed.  

• Detail output also includes the ‘total’ number of documents, one line per each type: Sales 
Order, PO, and TR, as well as the summed total quantity of that item across those 
documents. 

• Detail with transactions also include, for each type having a ‘count’ of documents, each 
document number and line number and quantity on that line for that item. 

The Item Sales Report provides a report listing sales based on the accumulated sales history 
stored for each item or item by warehouse. The report includes month-to-date, year-to-date, 
and prior year figures in unit or dollar amounts and selection criterion for active items, 
inactive items or all. 

The Inventory Turns Report provides a report listing the number of inventory turns per item 
and provides warehouse totals. Inventory turns are calculated as the unit sales divided by 
the average on hand. Turns equals total cost (usage times (x) average cost) for 12 periods 
divided (./.) by average value (average beginning on hand value) for 12 periods. 

The Warehouse/Item Listing provides a report listing all items assigned to each warehouse. 
On hand, on order and committed quantities may be included. This listing is especially useful 
for verifying stocking information after the initial warehouse setup. Items entered into the 
warehouse/item file through the Warehouse Item F/M or the Create Warehouse/Item 
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Records programs are available for printing. Report information includes: General--item 
number and description(s), stocking unit of measure, movement class (1-12, 13=dead stock, 
14=not set), seasonal item flag (Nonseasonal, Low, High), warehouse location, date created 
in warehouse, last and next physical dates, whether ledgercards are stored, whether the 
minimum rank was applied (which indicates whether the rank of the item was due to the 
replenishment parameter for minimum rank for new items) and the hit count for the item over 
the number of months specified for calculating rank. For each receipt this information is 
displayed the item number and description(s), rank range information, whether the minimum 
rank was applied (which indicates whether the rank of the item was due to the replenishment 
parameter for minimum rank for new items), the hit count for the item over the number of 
months specified for calculating rank, and seasonal item flag (Nonseasonal, Low, High). For 
receipts, you can enter the number of receipts to print. For each receipt, the received 
quantity, stocking unit of measure, received cost, costing unit of measure, date received, 
lead time and lead time status (Abnormal=causing a greater than 50% change in average 
lead time, Ignored=disqualified by user in average lead time calculations, blank-normal). 

The report also includes the total number of items listed. 

The Item Ledgercards Listing prints a list of the transaction types chosen that have affected 
the item’s on hand quantity. Warehouses may be selected. 

The Item Listing provides a report listing all items in the inventory file, along with specific 
information regarding each item. The user may print either package (units of measure, 
conversion factors, etc.) or general (item class, alpha sort, etc.) information. Report 
information includes: general information about each item including item number and 
description, stocking unit of measure, standard pack, alpha, vendor, item class, sequence 
number, vendor-item number, general ledger posting table, freight class, commission 
percent, date created, taxable flag, update inventory flag, serial/lot flag, manufactured flag 
(Bill of materials, Formulation and Neither) and miscellaneous sales flag and packaging 
information about each item including item number and description, units of measure, 
conversion factors, standard pack and weight per the smallest, 2 and 3 units of measure. 

Use Companion Item Listing (ICR730) to obtain a listing of all parent companion items with 
associated companion line items. Companion items are maintained through these programs, 
SO Companion Item entry (SOE150), PO Companion Item entry (POE150), and IC 
Companion Item Entry (ICE150). Companion items may be used in sales orders, purchase 
orders and transfers. For each item, the report provides Item and description, substitute 
item(s) and description(s), and the total number of items listed. 

The Substitute Item Listing provides a report listing each item and its substitute items. 
Substitute items are maintained through the Item F/M program and may be used in sales 
orders as a substitute (replacement) when the item ordered is not available. Substitute items 
are maintained through the Item F/M program and may be used in sales orders as a 
substitute (replacement) when the item ordered is not available. For each item, the report 
provides item number and description, substitute item(s) and description(s) and total number 
of items listed. 

Item Interchange Listing prints a list of all item interchange numbers. The item interchange 
file is a storage place for interchangeable or superseded part numbers listed for one stock 
item. The item interchange file is a storage place for interchangeable or superseded part 
numbers listed for one stock item. It might be used to store customers’ own part numbers to 
access your numbers when sales orders are entered. It might also be used to identify your 
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own numbers using user-defined codes. For each item, the report provides item number and 
description; corresponding interchange item(s) and memo(s); and total number of items 
listed. 

The Catalog Item Listing allows listing of catalog items to be printed. Catalog items are items 
that are provided by a vendor but are not stocked. 

The Item Label Print program allows labels to be printed from the information stored in the 
item file. Each label includes the item number and description. Optional information includes 
the unit of measure, standard pack, item class and location. Label information includes: item 
number and item description and optional information includes unit of measure, standard 
pack, item class and location. The program prints on 4-up 3.3 x 15/16 labels. For more 
information see the forms section in the PIA Manual. 

The Bar Code Label Print program prints bar code labels of item numbers. Since there are 
different types of bar codes, make sure the printer uses the bar code standard needed. The 
hex code for bar code on and off must be set up in the Printer F/M program. The program 
prints on a 1-up 5 x 1 label. The program prints item number, description, stocking unit of 
measure and the bar code for the item number. 

The Item Balancing Register resets quantities for on-hand, on-order, committed, 
backordered, and LIFO/FIFO cost layers. It needs to be run only if quantities become out of 
balance due to a system malfunction or user error. The register first prints all out-of-balance 
items, then offers an optional update to reset the quantities to match the printout. Only run 
this program only if any quantities in Sales Orders, Purchase Orders, Or Inventory are out of 
balance. 

The IC Code List prints a listing of the various IC codes including item classes, item price 
classes, general ledger posting tables, adjustment codes, unit of measure codes, and 
warehouses. Each type of code is created and maintained in its own file maintenance 
program. Most are used in the item file. The adjustment code is used for making inventory 
adjustments. Report information includes each code, the information stored with each of 
those codes and the total number of codes listed. 

End of period  
The end-of-period menu contains programs that should be run at the end of each inventory 
period. 

Program concepts 
The Item Activity Report is an optional report that prints each item’s activity for the period. 
The report shows the on hand quantity at the beginning of the period, receipts, production, 
adjustments, transfers and sales for the period and the calculated on hand quantity for the 
end of the period. Since the activity is removed during the End-of-Period Update, make sure 
you run the Item Activity Report before the End-of-Period Update. Otherwise the report is not 
available for the period. Item activity is grouped according to receipts, production 
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(manufacturing), transfers, adjustments and sales. The calculated ending balance equals the 
period beginning quantity plus receipts plus produced plus adjustments plus transfers in 
minus transfers out minus sales. Throughout the period, the calculated ending balance may 
not equal the actual on hand because in most cases the actual on-hand quantities are 
updated immediately, whereas the calculated quantities (i.e., sales) are not updated until the 
register (i.e., Daily Sales Register) is updated. At the end of the period after all registers have 
been updated, the two quantities should be the same. 

The Serial/Lot number Removal Register enables you to print a register of all serial/lot 
numbers with a sold status that meets entered criteria. An update may be run to remove 
these sold records (items) from the system. Report information includes: warehouse, item 
number and description, serial/lot flag, serial/lot number, purchase order number, date 
received, vendor number, units received, buying unit of measure, cost, costing unit of 
measure, last sale date, invoice number, customer number, units sold, selling unit of 
measure, price sold at, and pricing unit of measure. Note: The Serial/Lot Number Removal 
Register program also includes items setup in alternate bin locations. 

If you use ledgercards for warehouse/item combinations, you can remove them during the 
end-of-period process with the Item Ledgercard Removal program. The Item Ledgercard 
Removal program also checks to make sure there are no updated PO receipts that have not 
been run through the register to prevent problems with writing the ledger card from the PO 
register once the ledgercards have been re-sequenced. If there are outstanding updated 
receipts, the system displays a message indicating there are outstanding updated receipts. 
Ledgercards can be sorted by item, alpha, vendor or item class order based on a transaction 
cutoff date. This program is a recommended part of the end-of-period procedures. 

The End-of-Period Update program closes the current IC period, rolls usage figures back 
one period, recalculates ordering controls, and resets month-to-date sales figure for all items. 
Items with unusual usage for the period are flagged.   

File maintenances  
Use the file maintenance programs in the Inventory Control module to set up and maintain 
information on items and warehouses.  

The programs on the File Maintenance menu enable you to set up and maintain items 
records in a particular warehouse (with location, reordering controls, stocking information, 
etc.), and serial/lot numbers for an item in a warehouse (with receiving information, quantity, 
etc.).  

The Item Interchange F/M allows setting up alternate reference numbers for an item, so that 
when the reference number is entered at an item field, the correct item number is displayed 
automatically. An item may have an unlimited number of interchanges. The 
Warehouse/Vendor Review F/M contains information on vendor buying requirements and 
how often a vendor’s product line should be reviewed for reordering.  

The last four programs are really user time savers. The Create Warehouse/Item Records 
allows creation of a new warehouse or the adding of a product line to a warehouse without 
the operator having to enter each record manually. The Create Warehouse/Vendor Review 
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Records allows duplication of warehouse/vendor records from one warehouse to another. 
The Transfer/Change Item Codes and Item Changer Programs allow changing selected item 
information without having to pull up each record in the Item F/M and changing it manually. 

Program concepts 
You can access the following programs from the IC File Maintenances menu: 

Item F/M (ICF910), which is used to create and maintain records in the item file. Each record 
contains an item number and general and packaging information relevant to the item. The 
Item File is the backbone of the Inventory System and is referenced and/or updated by 
programs in the Inventory, Sales Orders, Purchase Orders, Sales Analysis and 
Manufacturing Control Systems. Before entering items, make sure you have set up at least 
one item class, item price class, unit of measure, vendor and GL posting table. 

When a catalog item is imported into Item F/M, the system adds a record to the eCatalog log 
file for the new item master record. Because catalog items also upload, a record must be 
written to remove the catalog item from the eCatalog database if the item number is changed 
in the import. Import of a catalog item requires the item number to be changed. Once 
imported, it is removed from the catalog file. 

Item/Unit of Measure F/M (ICF915), which is used to enter units of measure information for 
an item, including conversion factor and weight per unit, and whether it can be used for 
selling, stocking, or pricing. It is also used to define the unit of measure defaults for stocking, 
pricing, selling, costing and buying. This program automatically displays after adding a new 
item so all units of measure can be entered. It can also be displayed from the Item F/M for an 
existing item by entering U at the main user prompt. This program can be added to any 
menu through the SM Program F/M and Menu F/M on the SM Menu Setup Menu. 

eCatalog Note: When certain default units of measure are changed a record will be added to 
the eCatalog log file for the next update to the catalog database. Field changes that will 
trigger an update are: Smallest UM, Default Selling UM, and Default Pricing UM 

Warehouse/Item F/M (ICF920), which is used to create and maintain records in the 
warehouse/item file. Each record contains general, restocking, usage, sales, cost, activity 
and receipt information relevant to a particular item in a given warehouse. 

Purchase Line Entry (ICE920), which is used to group together items you usually buy 
together. The path to the program is Inventory Control>File Maintenances>Purchase Line 
Entry (ICE920). A Purchase Line is for a range of items from a particular vendor and its 
parameters can be defined either at the Purchase Line or Warehouse / PLine level. In 
Replenishment Parameter Maintenance, an item’s parameters can be entered and the 
appropriate scope level is chosen during entry. Depending on the scope selected, a set of 
parameters can apply to a range of items. For example, an item can be selected by entering 
its part number, and then the scope can be set to the Purchase Line for the item. All items 
that are members of the Purchasing Line would then have the settings applied according to 
the hierarchy. Purchase Line Entry ties into fields in Item F/M (ICF910). Purchase Line Entry 
sets purchase line information for an item for a vendor. This information overrides the vendor 
defined in Item F/M & over writes it in the Item file. If you modify the primary vendor on a 
purchase line, the vendor is updated for all of the items on that purchasing line. 



Work flow & program Concepts 

Infor Distribution FACTS  Inventory Control User Guide  | 63 

Catalog Item F/M (ICF905), which is used to maintain information on catalog items and 
export catalog items into the FACTS Item F/M. Catalog items are items that are provided by 
a vendor but are not stocked. This file maintenance allows you to maintain information on 
catalog items and export catalog items into the FACTS Item F/M. 

eCatalog Note: When a catalog item is added or certain fields are changed a record will be 
added to the eCatalog log file for the next update to the catalog database. An "Allow Web 
Purchase" field will not be added to the catalog file. When uploaded, the Allow Web 
Purchase field will always be set to "unselected", any conversion factors will be sent as 1 
and the Active checkbox will be selected. All UM’s will be set to the pricing UM. Field 
changes that trigger an update are: Description 1 , Description 2, Item Class, Vendor-Item, 
Price Class, Default Pricing UM, and Primary Vendor 

Serial/Lot F/M (ICF930), which is used to maintain serial numbers and lot numbers for items. 
Each record contains the warehouse, item, serial/lot number and serial/lot purchase and 
usage/sales information stored for the record. Initially no data needs to be entered here and 
the records are maintained by the system. 

Item Interchange F/M (ICF935), which is used to access or identify item numbers in the 
inventory using different codes. For example, if item number 100 is 1/2 inch metal tape, there 
might be an interchange number called tape. When tape is entered into the system, item 100 
is displayed. 

Interchange numbers must be greater than one character. Duplicate interchange numbers 
may not be used for different item numbers. Interchange numbers also may not be existing 
item numbers in the inventory. The file may be used to store your customers’ part numbers 
as an aid when they are creating a sales order. 

Interchange numbers are used throughout the system where items are entered except in the 
Sales Analysis module. 

Use Review Cycle Setup (ICE560) to create and maintain the warehouse/warehouse and 
warehouse/vendor review cycles and update the minimum and maximum review cycle 
values. You can also modify current and recommended vendor review cycles.  It is used to 
establish review cycles and buying targets for all ARPs, both vendor and transfer. This 
program will analyze all of the replenished items in the selected warehouse, and display all 
of the ARPs (both vendor and warehouse) represented. The ARP for each item is 
established in Warehouse/Item F/M.  For each ARP, we display the # of items in the 
warehouse that are replenished by that ARP, and the review cycle and buying targets 
established. If no review cycle is setup, an asterisk will appear on that line, indicating that the 
review cycle should be setup. To view the items in the replenishment path you can select the 
Show Items button on the Setup Review Cycle screen or select View>Items in the ARP from 
the menu. When you have finished modifying review cycle information, you can select 
File>Create Missing Review Cycle Records to generate additional review cycles, or you can 
select File>Update Min/Max Review Cycle to update the review cycle minimum and 
maximum values based on your changes. 

Quick Item Add, which is used to create and maintain records in the item file quickly by using 
an existing item to serve as a template for the new item. This is a pared-down version of Item 
F/M, so it only includes the fields necessary to set up an item record in the system. To speed 
up entry, it asks you to choose an existing item to serve as a template for the new item. You 
can edit any records created with this program in Item F/M. Note: The Quick Item Add 
program does not allow you to enter or create alternate bin locations for items. 
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Process Warehouse/Item Records (ICU960), which is used to process warehouse/item 
records automatically for a range of items in the item file. You can import and export of data 
to Excel for review and updates. This can replace utilization of existing warehouse item 
records for an alternate warehouse to serve as the basis and allow initial replenishment 
parameter settings and expiration dates in an offline mode.  Warehouse/item records can be 
imported, exported or pending records removed for one warehouse each time the program is 
run. This program may save you time during initial inventory setup or in the event that you 
are opening a new warehouse.  

Create Warehouse/Vendor Review Records (ICU930), which is used to duplicate 
Warehouse/Vendor Review Records from one warehouse to another. You can specify: the 
order to create - vendor, alpha or vendor class, beginning and ending order choice, 
warehouse from which to duplicate review records, and warehouse to which to duplicate 
review records. 

Transfer/Change Item Codes (ICU920), which is used to change information in the Item and 
Warehouse/item Files for a range of items. All of this information is stored on each item in 
the item file. You may find this program useful when you need to make global changes to a 
number of item records without having to manually change each individual record in Item 
F/M or Warehouse/Item F/M. For example, sales tax or zip code changes may affect a 
number of item records. You can use this program to make the change once. When running 
this program, you can specify: the change order - item, alpha, item class, vendor, beginning 
and ending order to change and the warehouse to change for warehouse/item information. 
Changes made in this program do not affect transaction files or other modules. 

Item Changer (ICU940), which is used to change specific information about an item to be 
reflected throughout the FACTS System. WARNING! DO NOT ABORT THIS PROGRAM 
WHILE IT IS RUNNING. Data will be left in an indeterminable state and may take several 
weeks to repair. 

This program allows you to change specific information about an item to be reflected 
throughout the FACTS System. You can change the following information: Item number, Item 
descriptions 1 and 2, and Alpha lookup. 

Use the Past Transfer Removal program to delete old records from the past transfer history 
files based on selection criteria. This program can be run through job stream. Transfer 
history is being used for the Service Fill Report, which is accessible via ODBC and the 
Report Writer. 

This program reads through the Past Transfer Header file based on the criteria entered on 
the screen. The program deletes all lines for selected transfer records. Past Transfer 
Removal works against an entire transfer ticket and not just individual transfer receipts. If 
there are no open documents remaining on a transfer ticket and its highest receipt date is 
prior to the receiving cutoff date, then the entire ticket (all receipt documents) is removed 
from the transfer data files and records are removed from the line totals file (ICTRNT).For 
serial/lot items, the program deletes serial/lot records. After the program deletes lines, the 
header record is deleted. 

Deleting a warehouse/item record 
Select a record and choose Delete. The program prompts you with the following: 
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SA history exists for this warehouse/item. Enter new item to store sales history under. 

Enter the alternate SA item number to which you want to transfer sales history information. 
The entry must be a valid item number. 

Item Changer (ICU940) details 
You can enter Current and New Item numbers while others are on the system and save the 
list of entered items into a data file for later use. 

When you access the Item Changer again any items previously entered are displayed in the 
item list. If any of the items had been deleted since they were initially entered in a previous 
session, an asterisk appears in the Deleted column. 

This allows you to load items to be changed during the day (during business hours), exit the 
program without running it, and run the update at night while users are off the system. 

As you make changes to items, the items are added to the list in the bottom half of the 
screen. These changes do not actually take place in the system until you press F3 to update 
at the end of line-item entry. This gives you a chance to verify your changes and make any 
necessary corrections or deletions. 

When you run the actual update portion of this program, you must require everyone off the 
system. When you select Run Update, the system display a caution message indicating that 
the process requires the reading and updating of all files containing item information and 
may take a number of hours to complete; users cannot log in to the FACTS system until this 
program ends; items deleted from the system after entry into the item changer are skipped 
and the program must be allowed to run to completion. 

Item Changer modifies item information for all records in all files for current and historical 
data, as well as the associated sort files in the following FACTS modules (in sequence): 

• Electronic Data Interchange 
• Inventory Control 
• Job Cost 
• Manufacturing Control 
• Purchase Orders 
• Sales Analysis 
• Sales Orders 
• Service & Repair 
• Equipment Rental 

EWMS Processing Note 
The Item Changer (ICU940) program is disabled for any Accellos controlled warehouses. 
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Tips and recommendations 
The Item Changer program also functions for items setup in alternate bin locations. 

Limit each run to no more than 10 items at any one time. This program can change an 
unlimited number of items in the master file at a time, but it may take several hours to do so. 

It is strongly advised that you run this program after normal business hours since users will 
not be able to log into FACTS while Item Changer is running. 

To access this program, click Inventory Control>File Maintenances >Item Changer. 

Infrequent file maintenances  
In most cases, your System Administrator or local FACTS Affiliate will use these programs 
during initial installation or during live processing if you determine that a modification needs 
to be made. 

Always check with your Affiliate before you make changes to these programs. 

Program concepts  
You can access the following programs from the IC File Maintenances menu: 

Item Class F/M (ICF950), which is used to create and maintain the item class records to help 
you review categories of items. Each item can be assigned to an item class (i.e., lawn mower 
parts, bike parts, etc.) Item classes are completely user-definable and can be used in IC 
reports to sort items according to their classes. 

Even if you don’t intend to use item classes, you must create at least one class and assign 
all items to it. 

Item Price Class F/M (ICF952), which is used to create and maintain item price class 
records. Each new item must be assigned an item price class in the IC Item F/M. These 
classes are user-definable. Item price classes are used to set up contract pricing in Sales 
Orders and in the IC Costing & Pricing subsystem. eCatelog Note: When a new item price 
class is added or the description is changed a record will be added to the eCatalog log file for 
the next update to the eCatalog database. 

There is currently no way to remove an item price class record from eCatalog. However, 
when a record is deleted, any unprocessed records for this transaction will be removed from 
the log file. 

GL Posting Table F/M (ICF955), which is used to establish and maintain a set of GL posting 
tables for the Inventory Control module. Once GL Posting Tables are created, you can 
assign a posting table to each item so that the system knows which GL account numbers to 
post to when it posts a transaction for that item. You can set up one GL posting table and 
post all items to it, or you can set up multiple posting tables to produce a more detailed 
accounting system. 

The posting tables define how transactions should be distributed in the General Ledger 
distribution after various FACTS registers have been run. 
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Adjustment Code F/M (ICF960), which is used to create and maintain adjustment codes 
needed to make adjustments that should print on the Adjustment Register. Four standard 
adjustment codes are required: 

IT = item transfer (from the Item Repackaging Program) 

WT = warehouse transfer (from the Adjustment Entry Program) 

PD = physical discrepancy (from the Update Inventory program) 

QT = quick warehouse transfer (from the Quick Transfer Adjustment Program) 

Adjustment codes must be set up in this file maintenance before you can enter adjustments 
in the Adjustment Entry program. 

Each adjustment code has an assigned General Ledger account number. In the GL posting 
control record, the Adjustments Posting flag determines whether adjustments post to GL 
based on the item type (pulled from the IC GL posting table) or based on the adjustment 
code (pulled from the adjustment code). 

If the flag is set to A-adjustment, the G/L number assigned to the code is posted when 
entering an adjustment. If the flag is set to G-GL posting table, the G/L number in the GL 
posting table is posted. If the flag is set to G, the adjustment code type determines whether 
to post to the A-adjustments, R-receipts or S-sales G/L number. 

Unit Of Measure Code F/M (ICF965), which is used to create and maintain a valid set of unit 
of measure codes. These codes are user-definable, and they are referenced throughout the 
system.  Each item is assigned a unit of measure for stocking, pricing, selling, costing and 
buying. You can also specify the Alternate Unit of Measure Code to use it as an option in 
Credit Card Control F/M for Level III summary data processing. 

Warehouse F/M (ICF970), which is used to create and maintain warehouse information that 
is referenced by programs in Inventory Control, Sales Orders, Manufacturing Control, 
Purchase Orders and Equipment Rental modules. Items are entered in warehouses in order 
to maintain on hand, committed, backorder and on order quantities.  This program also 
includes several flags that are necessary for integrating Infor Distribution Storefront.  A 
warehouse cannot be deleted if it is used in the Equipment Rental System.  Note for WMS 
warehouses, if the WMS control record has not yet been created the system displays a 
message indicating that you must first create the WMS control record and returns you to the 
menu. 

IC to GL Posting Control F/M (ICF975), which is used to create and maintain an inventory GL 
posting control record for each company that uses the IC module. This program works in 
conjunction with IC GL Posting Table F/M and various FACTS registers. 

Quick Vendor F/M (ICF940), which is used to add vendors through FACTS for users whose 
systems do not have the Accounts Payable module. If the AP usage flag is set to Y in 
System Control F/M, you will not be able to access this program.  Each record contains a 
vendor number, which serves as the record’s unique ID, and general information relevant to 
the vendor, including cost class, cost hierarchy, and Use lowest cost setting.  Vendor 
numbers may be automatically assigned by the system.  You cannot delete vendors with 
open documents or open purchase orders. 

Standard Part Source F/M, which is used to create source codes. Source codes define the 
source of the standard part number, for instance UPC, IDW or EAN (the European 
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equivalent to UPC). They refer to the industry standard by which the part numbers were 
created. 

Rebuild Inventory Sort Files (ICU990), which is used to rebuild sort files, which may not be 
current with the rest of the system. 

Transfer Entry Options F/M (ICF978), which is used to customize the Transfer Entry and 
Confirmation programs to meet your company’s specific needs. 

Warehouse Transfers Ship Via F/M (ICE972), which is used to set up "from" and "to" 
warehouse default ship via combinations that will be used in the Transfer Entry programs. 
When a new transfer is created, the ship via will be set according to this matrix. You can 
enter a "from" warehouse and then be able to set up a different ship via for other 
warehouses that get transferred to. The "to" warehouse can be left blank for "all" to indicate 
that any other warehouse not set specifically here will use that ship via code. This way, a 
user who only uses one ship via when transferring from warehouse 01 will only have to set 
up the one "to" warehouse record. You can access this new program via the Warehouse F/M 
and from the IC Infrequent F/M menu and the System Installation menu. 

Multiple Item Deletion Entry (ICE110), which is used to pre-enter items you want to delete 
and to specify the appropriate Sales Analysis item to transfer historic information to. 

Multiple Item Deletion (ICU110), which is used to check the items entered in Multiple Item 
Deletion Entry (ICE110) and/or delete them. 

Infor strongly recommends that you password-protect the Nonstatic Control F/M (ICF985) 
and Static Control F/M (ICF980) programs. Changes should only be made extreme caution 
and under the supervision of your Affiliate. 

Static Control F/M (ICF980), which is used to maintain settings that affect how the IC module 
operates. 

Nonstatic Control F/M (ICF985), which is used to maintain settings that the system updates 
and references during live processing. 

Deleting an item class from the system 
When you delete an item class, the system prompts you to enter an alternate item class that 
it can transfer sales history to so that it’s still available in Sales Analysis. 

Make sure you set up at least one false item class to which you can transfer sales history 
when you delete a class. A false class needs to be created even if you use one class for all 
your items. 
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Chapter 3 Transaction procedures 

Inventory Control transaction procedures cover the step-by-step instructions used to 
maintain items in the IC module. 

Standard procedures for Inventory Control 
This section covers standard procedures to be followed for inventory control. These 
procedures may vary depending on how your company’s business is conducted. The 
following three sections of standard procedures are provided as a guideline: 

1 Recommended operating procedures 

An outline is provided of routine procedures on a daily, weekly, period (month, if 12 periods 
are used) and yearly basis. 

2 End-of-period checklist 

The end-of-period procedures are critical to the proper functioning of the system. Certain 
programs must be run in a specific order to close the inventory control module accurately. 

It is suggested that copies of the checklist be made and used for each period close-out to be 
filed for future reference. 

3 End-of-period checklist explanation  

A detailed account is provided of the purpose of each program on the checklist. 
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Recommended operating procedures  

Daily procedures (or as needed) 
1 Print Stock Status Report  

2 Print Surplus Stock Report  

3 Enter adjustments and/or repackaging; print/update Adjustments Register  

4 Enter necessary suggested cost/prices; run the update program  

5 Enter (planned special order) transfers; print transfer tickets; confirm shipments and/or receipts; 
print/update Shipment and/or Receiving registers 

Period procedures (or as needed) 
1 Complete all adjustments; print/update Adjustments Register  

2 Complete all warehouse transfers; print/update last Shipment Register and Receiving Register 

3 Print Stock Status Report  

4 Print Item Ledgercard Listing  

5 Print Item Activity Report  

*6 Print/update Serial/Lot Number Removal Register  

7 Run SM System Clean Up F/M 

*8 Run End of Period Update 

Yearly procedures 
* indicates the procedure is required and must be performed in the time period designated. 

*1 Run End-of-Period Update (already covered in period procedures - do NOT run twice) 

2 Perform Physical Inventory (if not using cycle counting) 

3 Run Review Cycle Setup 
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Adjustments procedures 

Manually adjusting on-hand quantities 
1 Click Inventory Control>Adjustments>Adjustment Entry.  

2 In the Warehouse field, specify the warehouse code for the item(s) to be adjusted.  

3 In the Item field, specify the item number to be adjusted. The system displays the 
description and current on hand quantity for this item and stocking unit of measure.  
 
(Optional) If an item does not update inventory (as set by the IC Control flag), the system 
displays the following message: "This is an uninventoried item. Cannot Adjust. CR-
Continue". 
 
(Optional) If the item is inventoried, but does not exist in the specified warehouse, the 
system displays the message: "Item not in this warehouse. CR-Continue". 
 
(Optional) If the item number is a serial/lot item, the system displays serial/lot fields. 

4 In the Adjustment field, specify the adjustment quantity (+/-) of the item. This displays 
the new on-hand quantity (current on hand plus the adjustment amount).  

5 In the Adjustment Code field, specify the adjustment code.  An S-sales type is only 
accepted if the adjustment was a negative adjustment. An R-receipt type is only 
accepted if the adjustment was a positive adjustment. An A-adjustment is accepted for 
negative and positive adjustments. 

6 (Optional--If the adjustment type entered was not R-receipt or A positive adjustment, the 
Cost field is skipped.) In the Cost field, specify the unit cost for this item receipt.  

7 (Optional--If the adjustment type entered in step 5, was not S-sales, this field is skipped.) 
In the Sales Dollars field, specify the dollar amount of the sale. The amount entered will 
be updated to the warehouse/item file for month-to-date and year-to-date history. 

8 (Optional-- If the adjustment type entered in step 5, was not S-sales, this field is 
skipped.) If the adjustment code type is "S" for sale, you can select the check box to post 
the number of units to the actual usage in the warehouse/ item file. If the adjustment type 
entered in field #4, was not S-sales, this field is skipped.  
 
Based on this setting, usage is given to the warehouse that is being adjusted. The 
system checks the value of the Replenish setting on the Main screen of Warehouse/Item 
F/M (ICF920) to determine whether to display the Post to Usage prompt. If the item’s 
replenishment flag is not Y, the system skips this prompt and does not update usage. If 
the replenishment flag is Y, the system updates usage based on your response here. 

9 In the Adjustment Memo field, specify the optional memo regarding the adjustment (up 
to 25 characters). This memo overrides the adjustments code description that prints on 
the Adjustment Register. You can press Enter to default to no memo and the adjustment 
code description prints on the register or F2to default to the memo previously used.  
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10 (Optional) At the command prompt at the bottom of the screen, the system displays the 
following options: Enter-Accept Line, J-Job #, F4-Backup. 

11 You can:  
 
Press F4 to back up to the adjustment memo.  
 
The system displays the message: Job Number message box and asks: "Enter job 
number?" Yes/ No If you select Yes, the system displays the job-posting dialog box.  
 
-OR- 
 
If you select No, the system accepts the line, and displays it in the browser in the lower 
portion of the screen. The program then proceeds to the item field to await further 
adjustments in this warehouse.  

12 When you have added all the adjustment line, save your entries. You can stop entering 
adjustment lines. You can Add additional items for adjustment or access Note Entry 
(SME710) for the item highlighted in line item browser. 

13 Click Exit to return to the main IC menu. 

Creating item-to-item transfers 
1 Click Inventory Control>Adjustments>Item Repackaging Entry.  

2 In the Warehouse field, specify the warehouse code for the item to be transferred. Press 
Enter to default to the warehouse assigned to the terminal. The system displays the 
warehouse name and description.  

3 In the From Item field, specify the item number from which the quantity is to be 
transferred. This item must exist in the warehouse. The system displays the item 
number, description, stocking unit of measure, prior to repackaging (before) on-hand 
quantity. 
 
If an item does not update inventory (as set by the IC Control flag), the system displays 
the following message: "This is an uninventoried item. Cannot Repackage.". 
 
If the item is inventoried, but does not exist in the specified warehouse, the system 
displays the message: "Item not in this warehouse.". 

4 In the To Item field, specify the item number to which the quantity is to be transferred. 
The smallest unit of measure of the To item must equal the smallest unit of measure of 
the From item. This displays the item number, description, inventory unit of measure, and 
prior to repackaging (before) on-hand quantity.   
 
If the item does not update inventory (as set by the IC Control flag), the following 
message will display: "This is an uninventoried item. Cannot Adjust.". 
 
If the item is inventoried, but does not exist in the specified warehouse, the following 
message will display: "Item not in this warehouse.". 
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5 In the Transfer Quantity field, specify the quantity of the FROM item to be transferred. 
This displays the new on-hand quantities for both items. If you set up multiple units of 
measure on the Item F/M screen for the item entered, you can press F2 to change the 
unit of measure. 

6 In the Transfer Cost field, specify the cost of the TO item per costing unit of measure. 
Press Enter to default to the cost of the FROM item converting it to the stocking unit of 
measure to the TO item. 

7 In the Transfer Memo field, specify an optional memo regarding the transfer (up to 25 
characters). This memo overrides the item transfer code description that prints on the 
Adjustment Register. Press Enter to default to no memo and the item transfer code 
description prints on the register. Press F2 to default to the memo previously used.  

8 At the Post To Usage check box, indicate whether to post the number of units 
transferred of the FROM item to the actual usage in the warehouse/item file.  

9 You can click:  

Save to record the transfer and update on-hand quantities for both items in the 
warehouse. Upon updating the adjustment, the user fields for this transaction are cleared 
and scrolled to the bottom portion of the screen and the program returns to the FROM 
item field to await further item transfers in the displayed warehouse. 

Stop to end item transfers. To add additional item repackaging transfers, click Add.  

Exit to return to the Inventory Control Menu screen. 

Printing and updating the Adjustment Register 
1 Click Inventory Control>Adjustments>Adjustment Register. 

2 In the Order field, select the order to print: I-Item Code Order, A-Alpha Item Order, V-
Vendor Code Order, C-Item Class Order. 

3 In the Beginning and Ending fields, select the beginning order choice to print.  

4 In the Properties section of the screen, complete this information. 
 
The Vendor or Item Class to print.  
Up to ten 2-character Warehouse codes side-by-side to print.  

5 Up to ten 2-character Adjustment Codes side by side to print.  

6 In the Date field, specify the Adjustment Register date. The date entered must be within 
the current or next GL period. 

7 Click OK.  

8 (Optional) If you are printing the GL distribution, the system displays the following 
message: Receipt Register. OK to Print GL Distribution?  
 
After printing the Receipt Register, verify the printout. If you need to correct the register 
data, click Cancel to exit the program. After you make the correction, you can rerun the 
Receipt Register. If everything is correct, click OK to continue. The program then prints 
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the GL distribution.  
 
Once the GL distribution is printed, the program displays the message: Check GL 
Distribution. OK to Update? 
 
After printing the distribution, verify the printout. If everything is correct, click OK. The 
program proceeds with the update. If you need to make a correction, select Cancel to 
exit the program. After you correct the information the correction is made, re-run the 
entire register process - meaning run the register first, then print the GL distribution, 
followed by the optional update. 

-OR-- 

(Optional) If you are not printing the GL distribution, the program displays the message: 
Receipt Register. OK to Update? 
 
After printing the Receipt Register, verify the printout. If you need to make a correction, 
click Cancel to exit the program. After you make corrections, rerun the register. If 
everything is correct, click OK to continue. 

Warehouse transfers procedures 

Generating Transfers from the Buyers Control Center Detail 
screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Creating Transfers in the Buyers Control Center procedure to specify the 
necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 (Optional) Use the Rank drop down for stocked and replenished items to filter the display 
by a specified rank. 

5 (Optional) In the Display Filters section you can limit the browser display using the 
following options: 
Replenish - to include Items where PNA is at or below order point in the browser lines 
below. 
Spec Ord - to include planned special order purchase order lines in the browser display. 
Items Above Line Point - to see all of the items in this ARP, even if they are not ready 
to be ordered. Items that are not ready to be ordered will be displayed with a Purchase 
Quantity of 0, but it can be useful to see all of the items in the ARP, and it allows you to 
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investigate why FACTS is not recommending you purchase an item. 
Backorder – to include items that have open back orders. 
Critical – for items where PNA is less than safety stock quantity. 
Neg PNA –for items where PNA is negative. (i.e. if all open purchase orders arrived now, 
there would still not be enough to fill current needs) 
Rank - filter the display by a specified rank, for stocked and replenished items. 

6 (Optional) The Last Replenishment Doc field displays the last Transfer document 
number and Order Date for the document. Click the drill down icon for quick access to 
the source document. 

7 (Optional) You can also modify the adjusted review cycle value. Press F1 to restore the 
adjusted review cycle value. 

8 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when using the Create Transfer button 
because a valid Ship Via must be provided in order to create a transfer. The Ship Via 
value will pass to the created transfer ticket. 

9 Specify the Replenishment action you want to perform: 
Line Buy--Normal replenishment based on the current system values / settings for an 
ARP, 
Emergency Line Buy--A purchase / transfer that is based on the remaining days in the 
review cycle to fill an urgent need, or 
Below Order Point--The items within an ARP that are at or below the Order Point will be 
included in the buy / transfer. All other items for the selected ARP will be excluded. This 
can be used for daily purchasing / transfers. 

10 The items that have approved replenishment sources for the buyer, from warehouse, to 
warehouse, rank, and purchasing line (if any) are displayed. 

11 You can complete the following tasks: 
Adjusting the Review Cycle for transfer items 
Modifying usage for transfer items 
Viewing warehouse quantities 
Using surplus inventory to fill replenishment transfers 
Adding items to transfers 
Reviewing and updating lead time for transfers 
Modifying transfer quantity information 
Reviewing order or backorder details for a transfer items 

12 (Optional) Click Show Math as needed to display the replenishment calculations such as 
Usage, Order Point, Line Point, Average Lead Time (LT), Safety Stock, ASQ, (average 
sales quantity), Recommended Order Quantity (ROQ), Economic Order Quantity (EOQ), 
Calculated ROQ, and Effective OQ. 

13 Once you are satisfied with your target values, select the Transfer and Override (as 
needed) check boxes for each line you want to generate transfers for. 

14 Click Create Transfer. If you have filtered the visible lines (by changes in the Display 
Filters fields), an additional message is displayed alerting you that all detail lines marked 
'buy' will be included, even if the line are not visible. 
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15 Click Yes to generate transfers and display a dialog where you can select to display 
them or continue. 

16 The system returns you to the Buyers Control Center, where the replenishment lines with 
transfers generated display at the top of the browser with the warehouse highlighted with 
the Rank color codes assigned on the Buyers Control Center view of PO Static Control 
F/M. 

17 (Optional) You can repeat this process to generate additional transfers. 

18 When you have finished generating transfers, exit the program. 

19 Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 

Adjusting the review cycle for transfers from the Buyers 
Control Center Detail screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Creating transfers in the Buyers Control Center procedure to specify the 
necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), rank, and review 
cycle information display in the header, as well as target and current information in 
dollars weight and cubes and the variances. 

4 The items that have approved replenishment sources for the buyer, buyer, from 
warehouse, to warehouse, and purchasing line (if any), rank, and review cycle 
information are displayed. 

5 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when using the Create Transfer button 
because a valid Ship Via must be provided in order to create a transfer. The Ship Via 
value will pass to the created transfer ticket. 

6 In the lower portion of the detail screen, the Target, Current and variance (+/-) values 
indicate whether the current value is too far above or below target amount. 

7 If the current amount is too high, specify a lower value for the Adjusted Review Cycle to 
modify the Recommended transferring quantity. To increase a target, specify a higher 
Adjusted Review Cycle value. 
Note: The Adjusted Review Cycle will then establish a Temporary Line Point and 
redisplay the Recommended transfer quantity if needed. New items will appear in the 
listing if their replenishment needs fall into the new Temporary Line Point. Consequently, 
if an item’s parameters do not fall into the Temporary Line Point, it will be removed from 
the list. When indicated in the Item F/M, the ROQ for an item will be applied to the 
Recommended Quantity. Items that have been flagged as “Required” will remain in the 
BCC for processing unless remove by the buyer directly or a full Refresh is performed for 
the To Warehouse / From Warehouse. 
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8 Once you are satisfied with your target values, click the Transfer and Override check 
boxes (as needed) for each line you want to generate transfers for. 

9 Click Create Transfer. 

10 Click Yes to generate transfers and display a dialog where you can select to display 
them or click Continue. 

11 The system returns you to the Buyers Control Center 

12 (Optional) You can repeat this process to generate additional transfers. 

13 When you have finished generating transfers, click Done to exit the program. 

Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 

Modifying usage for a transfer item on the Buyers Control 
Center Detail Screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to specify the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, buyer, from warehouse, to warehouse, and purchasing line (if any), rank, and 
review cycle information, display in the header, as well as target and current information 
in dollars weight and cubes and the variances. 

4 The items that have approved replenishment sources for the buyer, buyer, from 
warehouse, to warehouse, and purchasing line (if any), rank, and review cycle 
information are displayed. 

5 To modify usage for an item in the browser, click the icon beside the Usage field to 
access the Usage View of the Buyers Control screen. 

6 Click the Usage month you want to review. 

7 Click Usage Review to display the Usage Review program for the item, warehouse and 
month you selected. 

8 In the Beginning Date field, specify the beginning date for the browser display, and in 
the Days to Display field specify the number of days (30, 60, 90, or 120) to display. 

9 (Optional) Check the Abnormal check box to only display those usage lines that are 
Abnormal (both High and Low). 

10 In the browser, double click the usage line in the browser to display the Usage Review 
Detail (ICE556) program. You can to change qualified usage for any document that has 
recorded usage for the selected warehouse and item combination you specified. 

11 (Optional) You can apply a set of filters to define the usage lines displayed in the 
browser. In the Beginning Date field, you can filter for the beginning date for the display. 
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12 (Optional) In the Days to Display field specify the number of days (30, 60, 90, or 120) to 
display. 

13 (Optional) You can also select the For Usage Warehouse from list box with the user-
specified warehouse, along with all the warehouses that are replenished from the 
specified warehouse/item and the type of usage to display: Exceptional Usage, Not 
Exceptional Usage, or All, and the document types for the display: AD – adjustment, 
SO – Sales Order/Invoice, MC – BOM Ticket, MF – Formulation Ticket, MP – 
Formulation Packaging, MI – Formulation Ingredients, PO – Purchase Order, CR – 
Credit of usage for Customer/Vendor Returns, and LS – Lost Sale. 

14 Highlight a disbursement line in the browser and click Edit to modify information 

15 Click the Update Usage check box to update usage. 

16 In the Usage Date field specify the date for the usage change. 

17 In the Qualified Usage field, specify the new usage value for the warehouse/item on the 
document line. 

18 Once you have modified the qualified usage and save your changes, click Done to return 
to Usage Review (ICE555). 

19 Click Recalculate Usage on Usage Review (ICE555) to recalculate qualified usage for 
specified warehouse/item. 

20 Click Done to specify additional qualified usage. 

21 Click Done again to exit the program and return to the BCC Detail screen. 

Using surplus inventory to fill replenishment transfers 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and use 

the Creating transfers in the Buyers Control Center procedure to enter the necessary 
information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when clicking Create Transfer because a 
valid Ship Via must be provided in order to create a transfer. The Ship Via value will pass 
to the created transfer ticket. 

5 To use surplus inventory, click the Surplus.  
Note: Surplus selection is enabled by setting the Use Surplus flag in PO Static Control 
F/M. When the flag is set, the Buyers Control Center will display an additional column for 
Surplus for each item. 

6 Specify the quantity to use from surplus. 
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7 Click Create Transfer. 

8 Specify the ship-via. 

9 You can optionally update the transfer quantity and a document notes. 

10 Click OK. 

11 Click the transfer ticket created message to return to the BCC Detail screen with the 
surplus quantities applied. 

12 Once you are satisfied with your target values, check the Transfer and Override check 
boxes (as needed) for each line you want to generate transfers for. 

13 Click Create Transfer. 

14 Select Yes to generate transfers and display a dialog where you can select to display 
them or select Continue. 

15 The system returns you to the Buyers Control Center. 

16 (Optional) You can repeat this process to generate additional transfers. 

17 When you have finished generating transfers, exit the program. 

Note: To process return transfers created by the Buyers Control Center, you must run the IC 
Transfer Register program. 

Adding transfer items on the Buyers Control Center Detail 
screen 
1 Click PO>Entry>Buyers Control Center Transfer and use the Transferring items for 

replenishment using the Buyers Control Center procedure to specify the necessary 
information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 The items that have approved replenishment sources for the buyer, from warehouse, to 
warehouse, and purchasing line (if any), rank, and review cycle information are 
displayed. 

5 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when using the Create Transfer button 
because a valid Ship Via must be provided in order to create a transfer. The Ship Via 
value will pass to the created transfer ticket. 

6 To add an item click the icon beside the item field on an empty line in the browser. 

7 Select an item from the Item Search screen to add to the procurement process. 
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8 The item and all of its replenishment parameter information are added to the browser. 

9 Once you are satisfied with your target values, select the Transfer and Override check 
boxes (as needed) for each line you want to generate transfers for. 

10 Click Create Transfer. 

11 Click Yes to generate transfers and display a dialog where you can select to view them 
or select Continue. 

12 The system returns you to the Buyers Control Center. 

13 (Optional) You can repeat this process to generate additional transfers. 

14 When you have finished generating transfers, click Done; click Done again to exit. 

Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 

Reviewing and updating lead time for transfer items on the 
Buyers Control Center Detail screen 
1 Click Purchase Orders>Entry>Buyers Control Center Transfer and use the Creating 

Transfers in the Buyers Control Center procedure to enter the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 The items that have approved replenishment sources for the buyer, from warehouse, to 
warehouse, and purchasing line (if any), rank, and review cycle information are 
displayed. 

5 To modify lead time for an item in the browser, click the icon beside the Lead Time field 
to access the Transfer History View of the Buyers Control screen the item, warehouse 
and you selected. 

6 The transfers shipment lines and purchase order receipt lines are displayed in the 
browser so you can modify the lead time information as needed. 

7 Highlight the line you want to modify and click Edit. 

8 (Optional) Check the Ignore check box to prevent this lead time from be included in 
average lead time calculations. 

9 (Optional) Check the Abnormal check box to flag a Lead Time as abnormal if it is more 
than 50% different from the average or if the ARP Lead Time minimum or maximum 
threshold has been reached. 

10 Specify the qualified lead time that represents the correct lead time value that is to be 
used in calculations in the system. 



Transaction procedures 

82 | Infor Distribution FACTS  Inventory Control User Guide 

11 Click Save. 

12 You have these options.  
Restocking-Opens the Restocking View (POC417) screen for the selected 
warehouse/item; if the header warehouse/item is not used it will use the warehouse/item 
of the line in the browser. 
Usage-Opens the Usage View (POC416) for the selected warehouse/item; if the header 
warehouse/item is not used it will use the warehouse/item of the line in the browser. 
View Doc-View the doc selected in the browser. 
Replen F/M-Accesses Replenishment Parameter Maintenance for the selected 
warehouse/item or for the warehouse/item of the highlighted line in the browser. 
-Or- 
Highlight the next receipt to specify qualified usage and repeat steps 7-10. 

13 Click Done to enter another warehouse and item to use for the receipt document display 
or click Done again to exit the program. 

Modifying transfer quantity information for a line item on the 
Buyers Control Center Detail Screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to specify the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when using the Create Transfer button 
because a valid Ship Via must be provided in order to create a transfer. The Ship Via 
value will pass to the created transfer ticket. 

5 To modify the transfer quantity for an item, highlight the Transfer field and specify the 
new value. 

6 Once you are satisfied with your target values, click the Transfer and Override (as 
needed) check boxes for each line you want to generate transfers for. 

7 Click Create Transfer. 

8 Click Yes to generate transfers and display a dialog where you can select to display 
them or select Continue. 

9 The system returns you to the Buyers Control Center 

10 (Optional) You can repeat this process to generate additional transfers. 

11 When you have finished generating transfers, exit the program. 
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Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 

Reviewing order or back order details for an item on a 
Transfer 
1 Click Purchase Orders>Entry>Buyers Control Center Transfer and use the 

Transferring items for replenishment using the Buyers Control Center procedure to enter 
the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 To review the surplus, on order, back order or available quantities for an item, click the 
icon in the appropriate field (Surplus, On Order, Backorder or Available) to access the 
Open Docs view of the Buyers Control Center. 

5 To review the details for a document line, double click the line in the browser. 

6 Click Close to return to the Open Docs view where you can other view more document 
line details or click Done to return to the Buyers Control Center Detail screen. 

Managing planned special order item transfers  
1 Click Inventory Control>Warehouse Transfers>Planned Special Order Transfer 

Entry.  

2 In the From Warehouse field, enter the warehouse code from which to transfer items.  

3 In the To Warehouse field, enter the warehouse code to which the items will be 
transferred.  

4 At the Type field, select the type of transfer you are creating: R-Restocking or S-Special 
Orders. 

5 You have these options. 

Edit-to modify the units for the item. 

Delete-to remove the item. 

Inquiry From-to display FROM warehouse item pricing, quantity, usage and receipt 
information.  

Inquiry To-to display TO warehouse pricing, quantity, usage and receipt information. 
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Del Range-to delete a range of items from the planned special order transfer. The 
system displays the Delete Range of Items screen. Specify the Beginning Item and 
Ending Item numbers to delete. Click OK.  

6 (Optional) For special order transfers only Add-adds a special order item. If an item 
entered has a restocking path that is direct from the vendor a message is displayed. For 
special order transfers, complete this information. 

Specify the sales order number containing the items to be transferred for this special 
order.  

Specify the line number of the sales order that contains the item number to transfer. The 
item entered on this line must be on back order. 

Specify the number of units (per stocking unit of measure) to transfer.  

Click OK. 

7 Totals for the transfer are calculated and displayed. Totals include total number of items, 
units, weight and cost of planned special order transfer. 

8 Click Done to exit. 

Creating transfer ticket headers 
1 Click Inventory Control>Warehouse Transfers>Transfer Entry.  

2 In the Whse/Ticket field, specify the warehouse code from which to transfer items. You 
can also assign a new specific ticker number to a transfer by clicking the menu option 
File>New Document Number, then specify the ticket number. The entered ticket 
number cannot already exist in the transfer file (ICTRNH). 

3 In the To Warehouse field, specify the warehouse code to which the items will be 
transferred. 

4 In the Entered field, specify the date the transfer is entered.  

5 In the Request field, specify the date the items are requested for delivery.  

6 In the Ship Via field, specify the method of shipment (up to 15 characters). 

7 (Optional) In the Reference field, specify the reference number (up to 30 characters). 

8 (Optional) If there are planned special order transfers on file, the system displays the 
message Planned Special Order transfers on file. Do you want to import? (If there are no 
planned special order transfers on file, this system skips this field.) 
 
Specify Y or N to indicate whether the planned special order orders on file should post to 
the transfer ticket being entered. If you specify Y, the first planned special order line-item 
displays. If you specify Y, the system displays the Import Planned Special Order 
Transfers dialog box. Refer to the Import Planned Special Order Transfers topic for 
details. 

9 This concludes the header portion of the Transfer Ticket Entry program. At this time the 
ticket number is automatically assigned (if NEXT was entered in field #1) and displayed. 
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After the header record is created, all the header fields except #1-3 are accessible 
through the change header routine. Fields #1-3 can only be changed by deleting and 
reentering the ticket. Refer to the Adding transfer entry line items procedure for 
information about adding line items to transfer tickets. 

 Adding transfer entry line items 
1 Click Inventory Control>Warehouse Transfers>Transfer Entry.  

2 For new transfer tickets, enter the header information. Refer to the Creating transfer 
ticket headers. For existing transfer tickets, enter the number of transfer ticket you are 
modifying.  
TIP: Once the header is complete, the program automatically goes into Add mode, which 
means the cursor jumps to the Item field in the line entry section where you can begin 
entering line-item information. Use the line entry section to enter the item numbers, the 
quantities requested, committed and/or back ordered 

3 At the Item field, you have these options. 
Specify the item number, or add a special order, or press F2 for a search.  
If an item entered has a restocking path that is direct from the vendor, the system 
displays a message. Press Enter to continue. 
If you enter an item, complete the following: In the Requested field, enter the number of 
units (per stocking unit of measure) to transfer. Press F2 to change the unit of measure if 
multiple UMs are set up for the item.  
If you entered a special order, complete the following: Specify the sales order number 
containing the items to be transferred for this special order. Specify the line number of 
the sales order that contains the item number to transfer. The item continued on this line 
must be on back order. 
Specify the number of units (per stocking unit of measure) to transfer. Press Enter to 
default to the quantity on order or back order for the item on the line of the sales order. 

4 The system displays the optional Warehouse Quantities Window, which displays the 
"from" and "to" warehouse on hand, on order, committed, available, back-ordered 
quantities based on settings in IC Transfer Entry Options F/M (ICF978). When adding a 
line, the committed and back ordered will be calculated based on the available quantity. 

5 In the Committed Quantity field, enter the amount of inventory to commit. If the "Allow 
Over Commitment" flag in the IC Static Control file is set to "N", the committed plus 
shipped quantity cannot be greater than the available. When a line is being added or 
changed, the user will enter the requested quantity and then how much of that is 
committed and how much is back ordered. When adding a line, the requested quantity 
must be greater than zero. When editing the line, the requested quantity can be changed 
to zero to indicate that no more shipments of this line will be taking place. The requested, 
committed and back-ordered quantities cannot be negative. The committed plus back-
ordered quantities must add up to the requested quantity for the line to be saved.  

6 In the Backordered Quantity field, enter the amount of inventory to back order. If the 
item in inactive, it cannot be back ordered and it cannot commit more than is available.  

7 The system automatically returns you to the item field to add another transfer. When you 
are satisfied with your line item entry click Stop to complete the line item entry.  
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8 You have these options.  

Header-to access the Header Detail for Documents screen, which is used to view 
(inquiry-mode) and/or modify warehouse, shipping information, request and entered 
dates, and ship via, reference and priority.  

Edit-to make changes for the highlighted line item.  

Add or Insert-to add another line item. 

I to access Note Entry (SME710) for the item highlighted in line item browser.  

D to access Note Entry (SME710) for the transfer header record specified in the 
program.  

L to access Note Entry (SME710) for the transfer line record highlighted in the line item 
browser.  

9 When you have completed the line item or header information changes, click Done. 

10 The system displays the Print transfer ticket check box.  

11 Indicate whether to print the ticket now. If you do not check the Print transfer ticket 
check box, the ticket is saved for batch printing and may be printed through the Transfer 
Ticket Print. 

12 Click Done. 

Confirming shipments 
1 Click Inventory Control >Warehouse Transfers >Shipment Confirmation. 

2 In the Whse/Ticket field, enter the transfer ticket number. You can access the ticket by 
ticket number or warehouse. If accessing by warehouse enter the warehouse to display 
tickets for. You can search for transfer tickets in the specified warehouse. Transfer 
tickets are displayed in summary so you can select the ticket to confirm. The summary 
screen displays the line number, ticket number, status of ticket (E-entered, P-printed or 
S-shipped), entry date, requested date, FROM warehouse, TO warehouse and 
reference. 

3 (Optional) If the transfer ticket entered has not been printed, the system displays the 
message: Ticket not yet printed. Confirm anyway? If the ticket has not been printed, 
enter N or YES to indicate whether to confirm the ticket. The header portion of the 
transfer ticket is displayed. 

4 In the Shipped Date field, enter the date the ticket was shipped. Press Enter to default 
to the system date. 

5 At the Assume Shipment prompt, Assume shipment of committed?. You have these 
options. 

Y Assume shipment of all committed quantities 

N Do not assume shipment, back order all committed quantities 

C Do not assume shipment, leave all lines committed 
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B Confirm shipment of committed line-by-line 

6 The program automatically displays the line-items. If you select Options: 

Y Assume shipment of all committed quantities, N Do not assume shipment, back order 
all committed quantities, or C Do not assume shipment, leave all lines committed, the 
system completed the requested activity.  

If you select B--Confirm shipment of committed line by line, the system displays a dialog 
box for the line where you can select the confirmation method. At the Confirmation 
method field select from Y - Ship the committed quantity, N - Do not ship, backorder the 
committed quantity, C - Do not ship, leave the committed quantity, S - Ship this line and 
remaining lines, B - Backorder this line and remaining lines., L - Leave this line and 
remaining lines committed. 

7 The program automatically displays the line-items associated with the transfer ticket. If 
an item is a serial/lot item, the system displays the serial/lot item entry fields. 

8 After the system displays the line-items, have these options. 

Add or Insert a line-item above the highlighted line item. Enter the item number and 
quantity to confirm. 

Edit the highlighted line-item.  

Delete the highlighted entry. 

Header -Accesses the Header Detail screen where you modify the header information.  

Done -Accesses the ending routine. 

Stop Conf -Stops confirmation. Confirmation may be stopped prior to completion. If you 
stop confirmation, the system does not record changes to the transfer ticket. 

I-Accesses Note Entry (SME710) for the item highlighted in line item browser. 

D - Accesses Note Entry (SME710) for the transfer header record specified in the 
program. 

L - Accesses Note Entry (SME710) for the transfer line record highlighted in the line item 
browser.  

9 To exit, click Done. 

Printing and updating the Shipment Register 
1 Click Inventory Control>Warehouse Transfers>Shipment Register. 

2 In the Beginning and Ending Ticket fields, enter the beginning and ending transfer 
ticket numbers to print.  

3 In the Beginning and Ending Date fields, enter the beginning and ending transfer dates 
to print.  

4 In the From and To Warehouse fields, enter the warehouse to print FROM which 
shipments were transferred and the warehouse TO which shipments were sent.  
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5 In the Date field, enter the Shipment Register date.  

6 Click OK. 

7 (Optional) If you are printing the GL distribution, the system displays the following 
message: Receipt Register. OK to Print GL Distribution?  
 
After printing the Receipt Register, verify the printout. If you need to correct the register 
data, click Cancel to exit the program. After you make the correction, you can rerun the 
Receipt Register. If everything is correct, click OK. The program then prints the GL 
distribution.  
 
Once the GL distribution is printed, the program displays the message: Check GL 
Distribution. OK to Update? 
 
After printing the distribution, verify the printout. If everything is correct, click OK. The 
program proceeds with the update. If you need to make a correction, click Cancel. After 
you correct the information the correction is made, re-run the entire register process - 
meaning run the register first, then print the GL distribution, followed by the optional 
update. 
 
--OR-- 

(Optional) If you are not printing the GL distribution, the program displays the message: 
Receipt Register. OK to Update? 
 
After printing the Shipment Register, verify the printout. If you need to make a correction, 
click Cancel to exit the program. After you make corrections, rerun the register. If 
everything is correct, click OK. 

Confirming transfer receipts 
1 Click Inventory Control >Warehouse Transfers >Receipt Confirmation. 

2 In the Ticket field, specify the transfer ticket number. Press F2 to search for tickets.  

3 (Optional) Specify the shipment number if needed. If there is only one shipment number 
available to be received, then the shipment number is automatically displayed. If the 
Require User Entry of Ship# is selected on the Transfers tab of IC Static Control F/M 
(ICF980), you must specify the shipment number. 

4 In the Received Date field, specify the date the ticket was received. Press Enter to 
default to the system date. 

5 At the Assume Shipment check box, indicate whether to assume shipment. Checking 
the box sets number of units received for each item to the shipped amount entered on 
the transfer ticket. Not checking the box sets the number of units received for each item 
to zero.  

6 The program automatically displays the line-items associated with the transfer ticket. If 
an item is a serial/lot item, the system displays the serial/lot item entry options for 
Receipt confirmation. 
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7 You have these options. 

Edit-edit a line item; specify the number of units to receive.  
If the number received is not equal to the number shipped, you must specify a 
discrepancy G/L# to post the discrepancy to. Press Enter to default to the discrepancy 
number in the GL posting table assigned to the item. 

Add-Add line-items. In the Item field; specify the item number in the Item field and 
quantity to receive in the Received field.  

Insert-Add a line-item above the highlighted line item. 

Delete the highlighted entry. 

Cancel-Complete line item entry.  

Save-Saves your line item changes. 

I- Accesses Note Entry (SME710) for the item highlighted in line item browser. 

D- Accesses Note Entry (SME710) for the transfer header record specified in the 
program. 

L - Accesses Note Entry (SME710) for the transfer line record highlighted in the line item 
browser.  

Header -Accesses the Header Detail screen where you can modify header information. 

Done -Exits the transfer ticket and returns you to the Ticket # prompt.  

Stop Conf -Stops confirmation. Confirmation may be stopped prior to completion. If you 
stop confirmation, the system does not record changes to the transfer ticket. 

Update Updates the inventory quantities. The receipt will not longer be editable. If you 
select to update, the system prompts for the password if necessary and then given an 
"attention" message stating that proceeding will update the inventory quantities and the 
receipt will not longer be editable. You can select to continue with the update or cancel. 

8 When you can finished confirming the receipt, click Done to exit to the transfer ticket and 
return to the Ticket # field.  

9 You can specify additional receipt confirmations or click Done. 

Printing and updating the Receiving Register 
1 Click Inventory Control>Warehouse Transfers>Receiving Register. 

2 In the Beginning and Ending Ticket fields, enter the beginning and ending transfer 
ticket numbers to print.   

3 In the Beginning and Ending Date fields, enter the beginning and ending receipt dates 
to print.  

4 In the From and To Warehouse fields, enter the warehouse to print FROM which 
shipments were transferred and the warehouse TO where the shipments were received.  

5 In the Date field, enter the Receiving Register date.  
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6 Click OK. 

7 (Optional) If you are printing the GL distribution, the system displays the following 
message: Receiving Register. OK to Print GL Distribution?  
 
After printing the Receiving Register, verify the printout. If you need to correct the 
register data, click Cancel. After you make the correction, you can rerun the Receiving 
Register. If everything is correct, click OK. The program then prints the GL distribution.  
 
Once the GL distribution is printed, the program displays the message: Check GL 
Distribution. OK to Update? 
 
After printing the distribution, verify the printout. If everything is correct, click OK. The 
program proceeds with the update. If you need to make a correction, click Cancel. After 
you correct the information the correction is made, re-run the entire register process - 
meaning run the register first, then print the GL distribution, followed by the optional 
update. 
 
--OR-- 

8 (Optional) If you are not printing the GL distribution, the program displays the message: 
Receiving Register. OK to Update? 
 
After printing the Receiving Register, verify the printout. If you need to make a correction, 
click Cancel. After you make corrections, rerun the register. If everything is correct, click 
OK. 

Entering a quick transfer adjustment 
1 Click Inventory Control>Warehouse Transfers>Quick Transfer Adjustment.  

2 In the From Warehouse field, enter the warehouse FROM which the item was 
transferred.  

3 In the To Warehouse field, enter the warehouse TO which the item was transferred.  

4 In the Item field, enter the item number to transfer.  

5 (Optional) For serial/lot items, enter the serial/lot number in the Serial/Lot Number field.  
If this item is not a serial/lot item this field is skipped.  

6 In the Transfer Quantity field, enter the quantity to transfer (per stocking unit of 
measure). If you set up multiple units of measure on the Item F/M screen for the item 
entered, you can press F2 to change the unit of measure. 

7 In the Transfer Memo field, enter the optional memo regarding the adjustment (up to 25 
characters). This memo overrides the warehouse transfer code description which prints 
on the Adjustment Register. 

8 Click Save. 

9 Click Exit.  
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Costing & pricing procedures 

Adding suggested cost/pricing information for an item 
1 Click Inventory Control>Costing & Pricing>Suggested Cost/Price Entry.  

2 In the Item field, specify the inventory item code for which you want to create suggested 
cost/price information.  

3 Enter this information in the header of a Suggested Cost/Price record. 

In the Effective Date field, specify the effective date of this suggested cost/price change. 
When running the Update Suggested Costs/Prices program, a cutoff date is entered and 
effective dates up to that cutoff date are updated. 

In the Amount (Suggested List Price) field, specify the list price. 
The list price can be entered as a dollar amount or you can press F1to specify a change 
%. The Basis and multiplier options are not available for list price. 

In the Amount (Suggested Manual Cost) field, specify the manual cost. The manual cost 
may be entered as dollar amount or a change %. The only available basis for manual 
cost is list price. 

4 This completes the header information for the Suggested Cost/Price record for the item. 
Use the Filter list box to select the display settings for the suggested cost and/or price 
lines in the browser. You can select from: P-Price Levels, S-Standard Price, or Q-
Quantity Breaks. 

5 In each browser view, the system advances from one UM to the next in the order it is 
displayed until all units of measure (Ums) have been entered for each option (Standard 
Prices, Price Levels and Quantity Breaks) or until you click Done.  

6 For new records the system creates blank suggested cost/pricing lines for the highlighted 
item. Click Edit. You can update this information. 

Qty 

For quantity breaks, specify the minimum quantity that must be sold on a sales order 
document in order to utilize the price from the level. For example, the standard price of 
I100 is $10.00 ea., the break 1 price is $9.75 and the break 2 price is $9.50. In order to 
receive a price of $9.75 the customer must purchase a minimum of 50. In order to 
receive a price of $9.50 the customer must purchase a minimum of 100. Therefore break 
1’s quantity is 50 and break 2’s quantity is 100. 

Quantity break is always defined in the selling unit of measure. 

Basis  

For quantity breaks, the system displays the basis options. Initially, you can select from L 
- Use List Price as Basis, M - Use Manual Cost as Basis, S - Use Standard Price as 
Basis. After you set the basis/multiplier all price breaks must either use the same basis 
or they must be based on another price break.  
The basis options for additional quantity breaks are: L - Use List Price as Basis , or 1-6 - 
Use Prior Quantity Break 1-6 as Basis. For example, if manual cost is the basis for break 



Transaction procedures 

92 | Infor Distribution FACTS  Inventory Control User Guide 

1, the bases for breaks 2 through 6 must be either manual cost or one of the previous 
price breaks. The basis for levels 2 - 6 may not be set to list price or standard price. 

For level pricing, you can select from L - Use List Price as Basis, M - Use Manual Cost 
as Basis, S - Use Standard Price as Basis, or 1-6 - Use Prior Price Level 1-6 as Basis. 

For standard pricing, you can select from L - Use List Price as Basis or M - Use Manual 
Cost as Basis. 

Mult 

For quantity breaks, if you are entering the suggested standard price as a basis and 
multiplier, specify the multiplier for the suggested standard price for the level. The system 
automatically calculated and displays the new suggested standard price for the level.  

If you are entering the suggested price level as a basis and multiplier, specify the 
multiplier for the suggested standard price for the level. The system automatically 
calculated and displays the new suggested standard price for the level.  

If you are entering the suggested standard price as a basis and multiplier, specify the 
multiplier for the suggested standard price. The system automatically calculated and 
displays the new suggested standard price.  

Price 

The suggested level price may be entered as a basis and multiplier, a set price or a 
change %. The valid options for basis for level price are as follows: List Price, Manual 
Cost, Standard Price, or any prior Price Level. You can press F1 to specify a change 
percentage (Chg %) value.  

The quantity break price may be entered as a basis and multiplier, a set price or a 
change. The valid options for basis for quantity break prices are as follows: list price, 
manual cost, standard price, or any previous quantity break price. You can press F1 to 
specify a change percentage (Chg %) value.  

The standard price may be entered as a basis and multiplier, a set price or a change %. 
The valid options for basis for standard price are as follows: List Price or Manual Cost. 
You can press F1 to specify a change percentage (Chg %) value. All of the item’s valid 
pricing unit of measures are displayed in the order of the smallest to largest, and up to 
seven lines of standard prices can be displayed at one time. 

Chg % (percent) 

Costs/prices may be entered by pressing F1 to specify a change % (percent) from the 
existing cost/price. The system automatically calculate and displays the new suggested 
standard price for the level or the item. For example, if a standard price of $100.00 is 
increasing by 3% then you specify a change percent of 3.000. The system then 
calculates and displays the new calculated price of $103.00. When entering a change 
percent, the system calculates and stores the actual dollar amount in the pricing files. In 
this example, the system would store $103.00 the pricing files and this is the amount that 
would appear in Sales Order Entry programs. 

Comm %  

Enter a commission percent for the price level, standard price or quantity break price 
level. When entering the commission %, you also have the option to set it to "no priority"  



Transaction procedures 

Infor Distribution FACTS  Inventory Control User Guide  | 93 

which leaves the field blank), indicating that commission is not generated based on the 
price being set up. (If the item is set to "no priority", any commission % entered in the 
pricing system will be ignored). For more information on commissions, refer to the 
Commission Basis flag set in System Management>File Maintenances>Company 
Control F/M. 

7 Click Save. When you have completed the information entry, you can update the 
following header fields: effective date, list price, manual cost, standard prices, and 
quantity breaks. 

8 (Optional) You can highlight a suggested costing/pricing line in the browser and click 
Delete to display the Delete Record Type dialog box, where you can select to delete 
from the following: L - Suggested list price, M - Suggested manual cost, S - Suggested 
manual price for the selected unit of measure. 

9 (Optional) Use the Item Navigation links to display the Previous Item, Previous 
Suggested Costing/Pricing Line Next Suggested Costing/Pricing Line or Next Item 
suggested costing/pricing information. 

10 Click Done to end the program and then again to exit the screen. 

Creating suggested costs/prices for a range of items 
1 Click Inventory Control >Costing & Pricing >Create Suggested Costs/Prices. 

2 In the Order field, select the order to create suggested costs/prices: Item, Alpha, Vendor, 
Item Class, Item Price Class. Press Enter to default to Item order. 

3 In the Beginning and Ending Order Choice field, specify the beginning and ending order 
choices.  

4 In the Item Type field, specify the type of item to create: Stocked, Nonstocked, or 
Uninventoried. Press Enter to default to SNU. 

5 In the Vendor/Item Price Class field, specify the vendor number or item price class to 
create.  

6 In the Effective Date field, specify the effective date of the suggested cost/price change. 
Press Enter to default to the system date. Effective dates for any suggested records 
already on file will be overwritten.  

7 At the Suggested Level Types field, select the suggested record types to create: List 
Price, Manual Cost, Standard Price, Level 1, Level 2, Level 3, Level 4, Level 5, Level 6. 
The number of price levels available corresponds to the number of price levels that are 
set up in the # Price Levels field in the IC Static Control program.) Press Enter to default 
LMS123456 (or all of the record types that are available). 

8 In the List Price fields, complete this information.  
Change % - Enter the Change % of the suggested list price over current list price for the 
item(s) selected. Press Enter to default to 0% (zero). 
 
Replace - Indicate whether to replace the existing suggested list price if one already 
exists for the item(s) selected. Press Enter to default to selected. 
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9 In the Manual Cost fields, complete this information. 
Multiplier - Enter the Multiplier to be applied to the basis to calculate List Price or press 
F1-Skip. Press Enter to default to 0 (zero). 
Change % - Enter the Change % for the list price for the item(s) selected. Press Enter to 
default to 0% (zero). (Basis and multiplier are not valid options for list price and these 
fields were skipped). 
Replace - Indicate whether to replace the existing suggested list price if one already 
exists for the item(s) selected. Press Enter to default to selected. 

10 In the Standard Price fields, complete this information.  
 Basis - Enter the basis to apply the multiplier against to calculate the suggested 
standard price or press F1-Skip to specify a Change % to calculate the standard price. 
Options for basis are L - List Price and M - Manual Cost. 
Multiplier - Enter the Multiplier to be applied to the basis to calculate standard price or 
press F1-Skip. 
Change % - Enter the Change % to calculate the standard price. If a basis and multiplier 
were entered in the previous fields, this Change % is skipped. 
Commission %  - Enter the Commission % for the suggested standard price. Press 
Enter to set the Commission % to the current Commission %. Press F1 to default to No 
Priority. 
Replace - Indicate whether to replace the existing suggested list price if one already 
exists for the item(s) selected. Press Enter to default to selected. 

11 (Optional) For the Level Prices 1-6 fields, complete this information. 
Basis - Enter the basis to apply the multiplier against to calculate the suggested level 
price or press F1-Skip to specify a change % to calculate the level price. Options for 
basis are L - List Price, M - Manual Cost and S - Standard Price. Once this is set for level 
1, the only options for basis on levels 2-6 are either what is set for level 1 or a previous 
level. 
Multiplier  - Enter the multiplier to be applied to the basis to calculate level price or press 
F1-Skip. 
Change % - Enter the Change % to calculate the level price. If a basis and multiplier 
were entered in the previous fields, this Change % is skipped. 
Commission %  -  Enter the Commission % for the suggested level price. Press Enter 
to set the Commission % to the current Commission %. Press F1 to default to No 
Priority . 
Replace -  Indicate whether to replace the existing suggested list price if one already 
exists for the item(s) selected. Press Enter to default to selected. 
 
Note: You cannot access this field for levels 2 - 6 if the Require Descending Level Prices 
flag in the IC Static Control Record is set to Y because this field will default to whatever 
you entered in Replace for Level 1 Price for all other price levels. 

12 Click Create Levels to create price levels for items if no current prices exist for the 
level.  This field is skipped if no suggested price levels were selected to be created in the 
previous field. The price levels created here will be based on the standard price. Press 
Enter to default to unselected. 

13 Select a Pricing UM Scope option to indicate whether to create suggested price records 
for All pricing UM records, Non-default pricing UM records or Default pricing UM records. 
This UM scope does not affect the list price or manual cost. Press Enter to default to All. 
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This field is skipped if the Suggested Types selected do not include price levels, list price 
or standard price.  

14 Select a Rounding option to round prices to the nearest Five Cents, Ten Cents or No 
Rounding. Press Enter to default to N. Suggested records will be created only for current 
records with dollar amounts. 

15 Select Skip Inactive Items to skip inactive items when creating suggested costs and 
prices. 

16 Click OK, and after the system displays a message telling how many records were 
updated, click OK on the message box to exit the program.  

Updating suggested costs/prices for a range of items 
1 Click Inventory Control >Costing & Pricing >Update Suggested Costs/Prices. 

2 In the Order field, specify the order to create suggested costs/prices: Item, Alpha, 
Vendor, Item Class, Item Price Class. Press Enter to default to Item order. 

3 In the Beginning and Ending Order Choice fields, specify the beginning and ending 
order choices.  

4 In the Item Type field, specify the type of item to create: Stocked, Nonstocked, or 
Uninventoried.  

5 In the Vendor/Item Price Class field, specify the vendor number or item price class to 
create.  

6 In the Update field, select which types of suggested records to update: List Price, 
Manual Cost, Standard Price, Price Levels and Quantity Breaks.  

7 In the Pricing UM Scope field, specify whether to update suggested price records for All 
pricing UM records, Non-default pricing UM records or Default pricing UM records. This 
UM scope does not affect the list price or manual cost. 

8 In the Cutoff Date field, specify the ending effective date through which to update. 
Suggested cost/price changes with an effective date prior to and including date entered 
are updated. 

9 Click OK.  

10 After the program runs, click in the message box to exit the program.  

Erasing suggested costs/prices for a range of items 
1 Click Inventory Control>Costing & Pricing >Erase Suggested Costs/Prices. 

2 In the Order field, specify the order to create suggested costs/prices: Item, Alpha, 
Vendor, Item Class, Item Price Class. Press Enter to default to Item order. 

3 In the Beginning and Ending Order Choice fields, specify the beginning and ending 
order choices.  
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4 In the Item Type field, specify the type of item to create: Stocked, Nonstocked, or 
Uninventoried. Press Enter to default to SNU.  

5 In the Vendor/Item Price Class field, specify the vendor number or item price class to 
create.  

6 In the Erase field, select which types of suggested records to erase: List Price, Manual 
Cost, Standard Price, Price Levels and Quantity Breaks.  

7 In the Pricing Um Scope field, specify whether to erase suggested price records for All 
pricing UM records, Non-default pricing UM records or Default pricing UM records. This 
UM scope does not affect the list price or manual cost. 

8 In the Cutoff Date field, specify the ending effective date through which to erase. 
Suggested cost/price changes with an effective date prior to and including date entered 
are removed. Press Enter to default to the system date. 

9 Click OK. 

10 After you complete the erase process the system displays a message telling how many 
records were updated. Click in the message box to exit the program.  

Changing existing cost/price information for an item 
1 Click Inventory Control>Costing & Pricing>Suggested Cost/Price Entry.  

2 In the Item field, specify the inventory item code for which you want to create suggested 
cost/price information.  

3 If you’ve already set up costing/pricing information for an item, the program automatically 
goes into edit mode. Edit the highlighted line. You can update this information. 

Qty 

For quantity breaks, specify the minimum quantity that must be sold on a sales order 
document in order to utilize the price from the level. For example, the standard price of 
I100 is $10.00 ea., the break 1 price is $9.75 and the break 2 price is $9.50. In order to 
receive a price of $9.75 the customer must purchase a minimum of 50. In order to 
receive a price of $9.50 the customer must purchase a minimum of 100. Therefore break 
1’s quantity is 50 and break 2’s quantity is 100. 

Quantity break is always defined in the selling unit of measure. 

Basis  

For quantity breaks, the system displays the basis options. Initially, you can select from L 
- Use List Price as Basis, M - Use Manual Cost as Basis, S - Use Standard Price as 
Basis. After you set the basis/multiplier all price breaks must either use the same basis 
or they must be based on another price break.  
The basis options for additional quantity breaks are: L - Use List Price as Basis , or 1-6 - 
Use Prior Quantity Break 1-6 as Basis. For example, if manual cost is the basis for break 
1, the bases for breaks 2 through 6 must be either manual cost or one of the previous 
price breaks. The basis for levels 2 - 6 may not be set to list price or standard price. 
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For level pricing, you can select from L - Use List Price as Basis, M - Use Manual Cost 
as Basis, S - Use Standard Price as Basis, or 1-6 - Use Prior Price Level 1-6 as Basis. 

For standard pricing, you can select from L - Use List Price as Basis or M - Use Manual 
Cost as Basis. 

Mult 

For quantity breaks, if you are entering the suggested standard price as a basis and 
multiplier, specify the multiplier for the suggested standard price for the level. The system 
automatically calculated and displays the new suggested standard price for the level.  

If you are entering the suggested price level as a basis and multiplier, specify the 
multiplier for the suggested standard price for the level. The system automatically 
calculated and displays the new suggested standard price for the level.  

If you are entering the suggested standard price as a basis and multiplier, specify the 
multiplier for the suggested standard price. The system automatically calculated and 
displays the new suggested standard price.  

Price 

The suggested level price may be entered as a basis and multiplier, a set price or a 
change %. The valid options for basis for level price are as follows: List Price, Manual 
Cost, Standard Price, or any prior Price Level. You can press F1 to specify a change 
percentage (Chg %) value.  

The quantity break price may be entered as a basis and multiplier, a set price or a 
change. The valid options for basis for quantity break prices are as follows: list price, 
manual cost, standard price, or any previous quantity break price. You can press F1 to 
specify a change percentage (Chg %) value.  

The standard price may be entered as a basis and multiplier, a set price or a change %. 
The valid options for basis for standard price are as follows: List Price or Manual Cost. 
You can press F1 to specify a change percentage (Chg %) value. All of the item’s valid 
pricing unit of measures are displayed in the order of the smallest to largest, and up to 
seven lines of standard prices can be displayed at one time. 

Chg % (percent) 

Costs/prices may be entered by pressing F1 to specify a change % (percent) from the 
existing cost/price. The system automatically calculate and displays the new suggested 
standard price for the level or the item. For example, if a standard price of $100.00 is 
increasing by 3% then you specify a change percent of 3.000. The system then 
calculates and displays the new calculated price of $103.00. When entering a change 
percent, the system calculates and stores the actual dollar amount in the pricing files. In 
this example, the system would store $103.00 the pricing files and this is the amount that 
would appear in Sales Order Entry programs. 

Comm %  

Enter a commission percent for the price level, standard price or quantity break price 
level. When entering the commission %, you also have the option to set it to "no priority" 
(which leaves the field blank), indicating that commission is not generated based on the 
price being set up. (If the item is set to "no priority", any commission % entered in the 
pricing system will be ignored). For more information on commissions, refer to the 
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Commission Basis flag set in System Management>File Maintenances>Company 
Control F/M. 

4 Click Save. When you have completed the information entry, you can update the 
following header fields: effective date, list price, manual cost, standard prices, and 
quantity breaks. 

5 (Optional) You can highlight a suggested costing/pricing line in the browser and click 
Delete to display the Delete Record Type dialog box, where you can select to delete from 
the following: L--Suggested list price, M - Suggested manual cost, S -  Suggested 
manual price for the selected unit of measure. 

6 (Optional) Use the Item Navigation links to display the Previous Item, Previous 
Suggested Costing/Pricing Line Next Suggested Costing/Pricing Line or Next Item 
suggested costing/pricing information. 

7 Click Done to end the program and then again to exit the screen. 

Deleting cost/pricing information 
1 Click Inventory Control>Costing & Pricing>Suggested Cost/Price Entry.  

2 In the Item field, specify the inventory item code for which you want to create suggested 
cost/price information.   
If no suggested records exist for an item, you can flag the current prices so the system 
knows to delete them. When a current price is selected to be deleted, a message is 
displayed under suggested indicating this deletion will take place. Current pricing records 
are not deleted until the Update Suggested Costs/prices program is run.  

3 You can highlight a suggested costing/pricing line in the browser and click Delete to 
display the Delete Record Type dialog box, where you can select to delete from the 
following: L--Suggested list price, M - Suggested manual cost, S - Suggested manual 
price for the selected unit of measure. Click OK to delete the selected record type or 
Cancel to exit the dialog box without deleting anything. 
Current List Price and Manual Cost may not be deleted, (only suggested records may be 
deleted for List Price and Manual Cost). 

4 (Optional) Use the Item Navigation links to display the Previous Item, Previous 
Suggested Costing/Pricing Line Next Suggested Costing/Pricing Line or Next Item 
suggested costing/pricing information. 

5 Click Done to end the program and then again to exit the screen. 

Setting Scope  
This option is available after entering the first item to add/edit. Use it to set the field fields you 
want to access first during Suggested Cost/Price Entry. The purpose of this scope screen is 
to make cost/price entries faster and easier.  
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When entering suggested records for an inventory item the first time, the New Entry column 
tells the system what suggested records will be entered (list price, manual cost, standard 
price, price levels, quantity breaks).  

The First Stop At columns indicate to the system where to place the cursor when a 
suggested record is being edited. If a particular First Stop At flag is set to Y, then all other 
first stop at flags for that price type are set to N. (Only one First Stop At flag per price type 
may be set to Y).  

For example, you may want to set all prices using multipliers and bases. If so, the First Stop 
At flag should be set to Y under Basis. Then each time you set up an item, the program will 
always stop at the Basis fields first.  

In another example, you may want to set all your prices using the dollar amount method, and 
never use the multiple and basis. In this case, the First Stop At flag should be set to Y under 
Amount. Then each time you set up an item, the system will automatically skip basis and go 
directly to the amount field.  

However, say you decide that you want to set manual cost using the dollar amount method, 
standard prices using the basis/multiplier method and level prices using the change % 
method. To make this possible, you would set the First Stop At flag for manual cost to Y 
under Amount, the First Stop At flag for standard prices to Y under Basis and the First Stop 
At flag for level prices to Y under Change %. 

Setting flags in the Scope box 
1 Use your arrow keys to select the field you want to set. 

2 Press Enter to change the setting from Y to N or vice versa. 

3 Press F4-Exit to return to the previous screen. 

4 Scope settings are user definable. When you exit the Suggested Cost/Price Entry 
program, the scope returns to the system’s default settings. 

Electronic price updates procedures 

Process Flow: Importing Standard Part Numbers in EPU 
Use the following steps to set up and import standard part numbers using the FACTS 
Electronic Pricing Update system.  

The items for which you want to create standard part numbers must already exist in Item F/M 
or Catalog Item F/M. 

1 Create source codes, such as UPC, EAN, IDW, for standard part numbers in Standard 
Part Source F/M. Click Inventory Control>File Maintenances>Infrequent File 
Maintenances>Standard Part Source F/M. 
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2 Use Standard Part Map F/M to define positions, field lengths etc. for each pricing service 
and vendor that provides flat files. Click Inventory Control>Electronic Price 
Updates>Standard Part Map F/M. 

3 Run Flat File Import. The information imported through this program is not considered "in 
the system" until you run Pending File Update. Click Inventory Control>Electronic 
Price Update>Flat File Import. 

4 Use Pending Standard Part F/M to correct or delete standard part numbers and 
descriptions before you updated them to the system. This step is optional. Click 
Inventory Control>Electronic Price Update>Pending Standard Part F/M. 

5 Run Pending File Update to add the standard part numbers into the system. Click 
Inventory Control>Electronic Price Update>Pending File Update. 

6 Use Standard Part Number Entry to add any additional standard part numbers and 
descriptions into the system. Any information created in this program is immediately 
added to the system. Click Inventory Control>Electronic Price Update>Standard Part 
Number Entry. 

Process Flow: Creating Standard Part Numbers Manually 
Before you set up a standard part number, make sure the item to which it is related is set up 
in Item F/M or Catalog Item F/M. 

1 Create source codes, such as UPC, EAN, IDW, for standard part numbers in Standard 
Part Source F/M. Click Inventory Control-->File Maintenances-->Infrequent File 
Maintenances-->Standard Part Source F/M. 

2 Use Standard Part Number Entry to create the numbers and their descriptions. Standard 
part numbers entered in this program are automatically added to the system. You do not 
have to run an update. 

Creating standard part numbers 
1 Click Inventory Control>EPU>Standard Part Number Entry (ECU460). 

2 In the Standard Source Code field, specify a source code.  

3 In the Std Part # field, enter the standard part number. 

4 Enter a unit of measure (UM) for the standard part number. To find an existing unit of 
measure, press F2. New units of measure must be created in Item F/M.  

5 The description defaults to Description 1 and 2 for the FACTS item selected. 

6 Press Enter to continue adding standard part numbers for the same source code. Click 
Cancel to exit the line item entry section. 

7 You have these options. 

Add more standard part number for the same source. 
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Highlight a standard part number line, then click Delete.  

Highlight a standard part number line, then click Edit. When you are finished editing the 
part number information, click Save.  

8 The system returns you to the Standard Source Code field, click Done to exit. 

Deleting a standard part number 
1 Click Inventory Control>EPU>Standard Part Number Entry (ECU460). 

2 In the Standard Source Code field, specify a source code.  

3 Highlight the standard part number in the item browser and click Delete. 

4 Click Done.  

Editing a standard part number (change description or UM) 
1 Click Inventory Control>EPU>Standard Part Number Entry (ECU460). 

2 In the Standard Source Code field, specify a source code.  

3 Highlight the standard part number in the item browser and click Edit. 

4 Use the line-item entry section to modify the standard part number information. 

5 Click Save. 

6 Click Done.  

Updating imported pricing information and standard part 
numbers 
1 Click Inventory Control>Electronic Price Updates>Pending File Update. 

2 In the Service Code field, enter the pricing service code from Service Code F/M.  

3 At the Initial Item Load field, enter No or Yes to indicate whether this is the first time this 
item has been loaded into the inventory files.  

Caution: Entering Yes overrides the action code and vendor default settings and treat 
each record in the pending file as if it were a new stocked item. Existing FACTS data will 
be overwritten.  

4 In the Cost/Price Update field, enter whether to update Suggested FACTS costs/prices 
or Actual FACTS costs/prices. Press Enter to default to S. 

5 In the Effective Date field, enter the date the suggested changes are to take effect (ref. 
3). Note: This field is accessible only if Suggested Cost/Price data is to be updated.  
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6 In the Beginning and Ending Vendor fields, enter the beginning and ending vendors to 
process.  

7 Click OK. 

8 Click the update message to exit. 

Importing a flat file 
1 Click Inventory Control>Electronic Price Update>Flat File Import. 

2 In the Service Code field, enter the pricing service code from Service Code F/M. For 
vendor direct data, enter the AP Vendor number.  

3 In the Load Command field, press Enter to default to the load command entered for this 
service provider in Service Code F/M.  

4 In the File Name field, press Enter to default to the flat file name entered for this provider 
in Service Code F/M. If the file already exists on the system, a message will display "File 
already exists. Download a new flat file?" Answer No to update the existing file on the 
system. Answer Yes to overwrite the existing file on the system. 

5 In the Beginning and Ending Vendor fields, enter the beginning and ending vendor 
numbers to process.  
Note:   A file from a pricing service normally contains data for several vendors. To load a 
specific vendor’s information from that file, enter the vendor number to process. All data 
that does not match this vendor will be skipped.  
 
A file from a specific vendor normally contains that vendor’s data. Enter the vendor’s 
number or press Enter for FIRST. 
 
If you are importing data from a CD catalog (and this service code uses ICU452 as its 
update program), press Enter to default to ALL. (The system cannot select a range of 
vendors when its importing data from CD-ROM catalogs.) You can also enter a specific 
vendor number. 

6 When the system displays: Initialize the Pending file before updating? Enter Yes to clear 
the pending file before processing the new data from this flat file. Enter No to leave any 
unprocessed records in the pending file before processing the new data from this flat file. 
Note: Records remain in the pending file until they are manually removed through 
Pending File Maintenance or updated through Pending File Update. 

7 In the Number of Records field, specify the number of records to import from the flat 
file. In the testing and setup phases of EPU, this function could be used to check the 
EPU Service Code record against the layout of the flat file record sent by the provider 
without having to import the entire flat file. Press Enter to default to ALL. 

8 (Optional) If you want to continue and import the file, type YES in the selection prompt in 
the bottom right-hand corner of the screen.  

9 (Optional) If you are importing information from a CD Catalog, and you entered ICU452 
as the update program in Service Code F/M, FACTS opens the Flat File Preprocessor 
Program.  
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10 The Flat File Preprocessor program indicates to FACTS what to do with the CD Catalog 
information. If you need to create and import a file, select B from the pick list. If you just 
want to create a flat file and import it later, select C. If a flat file already exists, select I to 
import it. 

11 Click Exit. 

Physical inventory procedures 

Capturing on-hand or available quantities 
1 Click Inventory Control>Physical Inventory >Capture Quantities. 

2 In the Order field, select from the preset options Item number, Alpha sort, Vendor 
number, item Class, Location or Movement class order. (The order choice automatically 
appears on the screen as set in the inventory static control record.)  

3 In the Beginning and Ending Order Choice fields, select the beginning and ending 
order choices to capture.  

4 In the Item Type field, specify the type of item to capture: Stocked items and/or 
Nonstocked items. Press Enter to default to SN. 

5 In the Warehouse field, specify the warehouse to capture. The entry must be a valid 
warehouse code.  

6 In the Cutoff Date field, specify the next physical inventory cutoff date. Items with the 
next physical inventory date (as set through the Warehouse/Item F/M) on or before the 
date entered are captured. Press Enter to default to the system date. 

7 Click OK.  

8 (Optional) If existing quantities are already captured a message is displayed asking to 
clear the current information. 

9 (Optional) Check the Clear Records check box. Click Continue. 

Entering physical counts 
1 Click Inventory Control>Physical Inventory >Enter Counts. 

2 In the Warehouse field, enter the warehouse for which the physical inventory is being 
taken.  

3 In the Item Type field, enter the item type to enter counts for: Stocked items and/or 
Nonstocked items.  

4 In the Item field, enter the item number for which the count is to be entered. The entry 
must be a valid item number. This displays the item, description, stocking unit of 
measure, serial/lot number (if applicable), capture date, location and captured quantity. If 
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the count has already been entered at least once, the recorded count is also displayed. 
Press Enter to default to the next item captured (same order as count sheets).   

5 In the Location field, specify bin location for the item.  
 
As records are displayed on the screen, the location label displays as either "PRI LOC" 
or "ALT LOC". If the location is not the primary location of the item, the capture quantity 
field displays blanks. For a serial or lot item when the inventory order is not location, you 
can only enter the item’s primary location.  
 
Inventory Order of Location Only – Since serial items can only have a quantity of zero or 
one, when you enter a serial number and a count of 1, the Enter Counts program looks 
for any other location records for that serial number. If it finds one that already has a 
count of 1, it displays a message indicating the location that already has the count and 
the quantity will be changed back to zero. If there is an adjustment that needs to be 
made, you have to zero the count on the first location record before he is able to enter it 
onto the new location. 

6 If you enter an ‘un-captured item*’, the system displays the message: Specify N or YES 
to indicate whether the item should be added. If N is entered the program returns to the 
item number field. If you enter Yes, the system displays the message Caution! Inventory 
quantities will be affected!. Click OK to accept the message and enter the amount as of 
the capture date, i.e. captured amount. The program then proceeds to the next prompt 
Note:  *It is possible to enter an item in this program that was not captured since it may 
be an item that was found on the shelf but was not captured. An example would be an 
item assigned to the incorrect bin location. 

7 For serial and lot items enter the serial or lot number in the S/L field.  

8 In the Count field, enter the physical count for this item. Press Enter to replace the 
displayed quantity with the number of items counted. Press F1 to add the number to the 
displayed quantity. Press F2 to change the unit of measure. Press F3 to display the next 
item captured (on the count sheet). 

9 You have these options. 

Save your inventory count when you have finished entering records. 
Cancel item count entry. 
Add additional item counts after stopping line entry.  

10 After recording the count, the program returns to the Item Type field. The item just 
recorded is displayed in the bottom portion of the screen. 

11 Click Done. 

Updating physical inventory 
1 Click Inventory Control>Physical Inventory>Update Inventory.  

2 In the Order field, select from the preset options include Item number, Alpha sort, 
Vendor number, item Class, Location or Movement class. The order choice automatically 
appears on the screen as set in the inventory static control record.  
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3 In the Beginning and Ending Order Choice fields, enter the beginning and ending 
order choices to update.  

4 In the Item Type field, enter the type of item to update: Stocked and/or Nonstocked. 
Press Enter to default to SN. 

5 In the Warehouse field, enter the warehouse to update.  

6 In the Days to Next Inventory field, enter the number of days until the next physical 
inventory (0-999). The system calculates and displays the date based on the number of 
days entered. Press Enter to default to 90. 

7 Click Yes at the message: Are you sure you want to update inventory? 

8 The system displays a message telling how many records were updated. Click OK on 
the message to exit the program 

Inquires procedures 

Viewing item information 
1 Click Inventory>Inquiries >Item Inquiry. 

2 In the browser in the upper portion of the screen, the system displays the available items 
in the system. Double-click an item to display it in the browser. You can specify a specific 
item number in the Go To field to locate a specific item to display detail information in the 
browser. The Go to field is case sensitive. This means that if you specify i100 to lookup 
an item number when someone entered it as I100, the item record you are looking for will 
not appear in the browser. 

3 In the center section of a screen, select the view that contains the type of information you 
want to see for this specified item. You can select from these views. 

General Usage 

Packaging and weight Receipts 

Warehouse and stocking Open purchase orders 

Costing Open orders 

Price Blanket sales orders 

Activity Production 

Interchange Transfers 
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Ledgercards Serial/Lot 

Turns Vendors 

DOT information MSDS information 

Restocking Companions information 

Notes User-Defined 

Lost Sales LIFO/FIFO 

Quotes Standard Part Numbers 

Usage  Timeline 

4 When you are finished reviewing information for vendors, click Exit. 

Using Transfer Document Inquiry  
1 Click Inventory Control>Inquiries>Transfer Document Inquiry. 

2 Use the following fields to display transfer document inquiry information: 

From Warehouse  

Specify the warehouse from which items are to be transferred. You can press F2 or the 
icon to search. Press F3 to default to ALL.  

To Warehouse 

Specify the warehouse to which items will be transferred. Press F3 to default to ALL.  

Ticket Number 

Specify a valid transfer ticket number.   Search orders will be descending ticket 
number, reference number and item number.  

Transfer by Descending Ticket 

You can search for transfer tickets and open the selected one navigate to the next or 
previous ticket  

3 You have these options. 

Line Detail to access transfer document line details. 

Shipments to access receipt line details. 

I to access Note Entry (SME710) for the item highlighted in line item browser. 
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D to access Note Entry (SME710) for the transfer header record specified in the 
program. 

L to access Note Entry (SME710) for the transfer line record highlighted in the line item 
browser.  
Note: When in Overview mode, you cannot access the Notes feature. 

If there is an open shipment request for the ticket   (in Current mode), that system 
displays: 

Shipment Request Header Information: 

"From" warehouse, name and 3 address lines 

"To" warehouse, name and 3 address lines 

Date entered 

Date requested 

Date shipped 

Ship via 

Reference number 

Priority 

Status of the document being displayed 

Shipment Request Line information: 

Line number (display sequence number) 

Item number 

Description 1 

Requested 

UM of the shipment request 

Committed 

Backordered 

Shipped  

Sales Order number 

Sales Order line 

Full Description 

Click Shipments (disabled if there are no receipts for the ticket on file) to scroll 
through receipts.  

Click Overview to switch to Overview mode. 

If there is no open shipment request remaining for the selected ticket number, then the 
system displays the ticket receipts in Overview mode. 

Shipments View Details 
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In the Shipments view of Transfer Document Inquiry, Ship GL Posting and Rect GL 
Posting are enabled when the transaction highlighted in the browser is one that allows 
for drill back from the source document to the GL posting that was created by the 
register. Ship GL Posting displays GL posting records from the Shipment register. Rect 
GL Posting displays GL posting records from the Receiving register. Click Line Detail 
to display the line details and cost layers information for the shipment line.  

When viewing shipments that have been received, click Options>Cost Discrepancy 
Entry to make cost corrections to the highlighted receipt. When processing an over-
shipments (OS), the source document line cost is not updated if the receiving cost 
differs from the OS cost. A cost discrepancy entry is automatically created and the 
Cost Discrepancy Register (ICR610) must be run to finalize the changes.  

Receipts header information includes: 

"From" warehouse, name and 3 address lines, "To" warehouse, name and 3 address 
lines, and from the first receipt: Date entered, Date requested, Ship via, Reference 
number, and Priority, and whether the receipt is a normal replenishment document (Y) 
or an Emergency (N). 

Receipts Line information: 

The line browser information includes: 

Item number,  

Description 1,  

Original Requested quantity,  

UM,  

Total Shipped ( total shipped from the line totals file using the UM from the first receipt 
found),  

Total Received (total received from the line totals file plus any un-updated receipts for 
this line (accumulated in smallest UM) displayed using the UM from the first receipt 
found),  

Sales Order number,  

Sales Order line   

Full Description 

The quantities display in the unit of measure of the receipt being viewed. The lines will 
display in sequence number order. The system also displays the totals for units and 
weight. 

Click Line Detail (disabled if there are no receipts for the ticket on file) to scroll through 
receipts. Click Overview to switch to Overview mode. 

If there is no open shipment request remaining for the selected ticket number, then the 
system displays the ticket receipts in Overview mode. 

4 Click Exit.  
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Using Profit Analysis Inquiry  
1 Click Inventory Control>Inquiries> Profit Analysis Inquiry. 

2 Use the following fields to display profit analysis inquiry information: 

1 Warehouse 

Specify the warehouse. The entry must be a valid warehouse code. Press Enter to 
default to the warehouse assigned to the terminal.  

2 Item 

Specify the item. The entry must be a valid item number. Press Enter to default to the 
first item on file in the warehouse.  

3 Item by Item  

Open the Item file or scroll through items to analyze profits. 

In the browser in the portion of the screen, the system displays the cost and price of the 
item, the gross margin and percent gross margin, the selling unit for the item and the 
item profit. To change the Cost of Item, Price of Item, Gross Margin, Gross Margin %, 
Units Sold, or Profit values, highlight the line in the browser and click: 

Old - to change the Old Cost of Item, Price of Item, Gross Margin, Gross Margin %, Units 
Sold, or Profit values.  

New - to change the New Cost of Item, Price of Item, Gross Margin, Gross Margin %, 
Units Sold, or Profit values. 

Change - to specify the dollar change for value for the Cost of Item, Price of Item, Gross 
Margin, Gross Margin %, Units Sold, or Profit values. 

% Change - to specify the dollar change for value for the Cost of Item, Price of Item, 
Gross Margin, Gross Margin %, Units Sold, or Profit values. 

3 In the lower portion of the screen, the program indicates the percent increase in sales 
needed to maintain the current gross margin based on the information you entered.  

4 When you have completed profit analysis, click Done.  

End-of-Period procedures 

End-Of-Period Checklist for Inventory Control 

EOP Explanation  

Period ____ Year _____ 



Transaction procedures 

110 | Infor Distribution FACTS  Inventory Control User Guide 

User Date Menu  Description 

________ ________ Adjustments 1 Complete all adjustments and 
print/update Adjustments 
Register 

________ ________ Whse Trans. 2 Confirm all transfers and 
print/update Shipment and 
Receiving Registers 

________ ________ Reports 3 Print Stock Status Report 

________ ________ Reports 4 Print Item Ledgercard Listing 

________ ________ EOP 5 Print Item Activity Report 

________ ________ EOP 6 Print/update Serial/Lot 
Number Removal Register 

________ ________ EOP 7 Run System Clean Up F/M 
(SMF993) 

________ ________ EOP 8 Run End-of-Period Update 

End-Of-Period Checklist Explanation 

1 Complete all adjustments and run Adjustments Register. All adjustments, item 
repackaging and quick item transfers should be entered. The user should print and 
update the last Adjustments Register for the period to ensure the inventory quantities and 
figures are accurate.  

2 Confirm all transfers and print/update Shipment and Receiving registers. All shipments 
being sent out or received into a warehouse should be confirmed. The user should print 
and update the last Shipment Register (shipments being sent out) and Receiving 
Register (shipments being received in) for the period to ensure the inventory quantities 
and figures are accurate.  

3 Run Stock Status Report. This report allows the user to obtain a report of the status 
(quantity) and valuation (cost and extension) of items by warehouse. This report provides 
end-of-period inventory figures. (The report is optional.) 
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4 Print Item Ledgercard Listing. If item ledgercards are used, this program provides the 
user with a list of all transactions that have occurred for warehouse/item combinations. 
These transactions will be removed by the System Clean Up F/M (SMF993). It is 
recommended that a hard copy be saved for future reference. 

5 Print Item Activity Report. This report provides the user with a list of each item’s activity in 
a warehouse for the period. This report is not required; however, the information for the 
period is not available after the End-of-Period Update is run. 

6 Print Serial/Lot Number Removal Register. This register allows the user to obtain a list of 
all serial/lot numbers which have an on-hand quantity of zero and an available flag. After 
the register prints, the user should remove the records just printed to clean up the file. If 
records are not removed, they will appear on next period’s register. All Serial/Lot Number 
Removal Registers should be kept as an audit trail. 

7 Run System Clean Up F/M (SMF993). If item ledgercards are used, this program is run 
to remove ledger card information. The user determines the number of ledgercards to 
keep and the cutoff date through which to remove ledger card information. 

8 Run End-of-Period Update. This program should only be run after all of the above 
procedures are complete. This program updates period information and resets restocking 
information while flagging necessary items. The current IC period is closed.  

New item entry shortcuts 

Creating Default Items 
To speed up new item entries, you can create a default item, which serves as a template. If 
many of your items share common information, this information can be entered in the default 
item. Then when you create new items from the default, the system automatically enters all 
the default information for you.  

1 Click Inventory Control>File Maintenances>Item F/M.  

2 When initially accessing the screen, enter S in the item field; the system displays the 
Default Item window. Enter an existing item number to be set as the default number or 
press F2 to search items.  
If you enter an item number the system returns to the item# field and displays the Default 
Item number. If you enter an item number that is not on file, the system prompts you with 
"Set defaults from item 'Default Item' for new item 'New Item'?"  
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If you answer Yes, the system displays the default item's information and you can 
continue adding the item. If you select No to the default item, the system displays the 
message: "Record Not Found. Create New Record" and all data fields are empty and 
ready for entry. The default item can be changed to another item at any time by again 
selecting "S" and changing the item #.  

3 The default item will remain set until the user either exits Item F/M or select "C" at the 
Item # prompt to "clear the default item". Even when a default item number is set, you 
can edit or delete existing items.  

Note: When setting up a new item with a default item, the new item takes on all of the default 
item’s units of measure that have been set up as a default UM for stocking, pricing, selling, 
costing or buying. 

Units of Measure entry in Item F/M 
When you save the new item record, the system proceeds to the Item/Unit of Measure F/M 
(ICF915) program so units of measure can be entered for this item. You can access Units of 
Measure in existing item records by clicking Add UM. 

Cost, Price and Warehouse Information 
After units of measure have been added for this item, the system displays Quick Item Entry 
(ICF911) if the Quick Entry flag in the Inventory Static Control Record is set to Y. These 
fields are only available when creating an item. Once an item is entered, these fields are 
maintained using the costing and pricing programs and the Warehouse/Item F/M Program in 
the Inventory Control System. 

Cost and price Entry 
Prior to entering costing and pricing information, refer to the Costing & Pricing section in the 
online help. Complete this information in the Quick Item Entry (ICF911) program. 

1 List Price 

Enter the list price per the unit of measure displayed for the item. Press Enter to default to 0. 
Press F3 to skip adding the cost/price record and proceeds to Warehouse. 

2 Manual Cost Multiplier 

Enter the manual cost multiplier per default costing unit of measure for the item. (The basis is 
automatically set to list price) F1 skips this entry and proceeds to the manual cost amount 
field (next). Press Enter to default to 0. Press F3 to skip adding the cost/price record and 
proceeds to Warehouse. 

3 Manual Cost Amount 
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If a multiplier is entered in the previous field, this field is skipped. Enter the manual cost 
amount if multiplier was skipped. Press Enter to default to 0. F3 skips adding the cost/price 
record and proceeds to Warehouse. 

For a default item, after the list price and manual cost has been entered, standard price 
information is displayed. 

Standard pricing  
A standard price can be added for each unit of measure that is a default unit of measure for 
any type (pricing, costing, selling, etc.) and is valid for pricing. Complete this information in 
the Quick Item Entry (ICF911) program. 

4 Standard Price Basis 

Enter the basis for calculating the standard price per unit of measure displayed: List Price, or 
Manual Cost. Press F1 to skip the entry of basis and multiplier and go to the price field. 

5 Standard Price Multiplier 

If basis was not entered in the previous field, this field is skipped. Enter the standard price 
multiplier for calculating the standard price per unit of measure displayed. Press F1 to skip 
the entry of basis and multiplier and go to the price field. 

6  Standard Price 

If basis and multiplier were entered in the previous 2 fields, this field is skipped. Enter the 
standard price per unit of measure displayed. F3 ends item fields. Press Enter to default to 0. 

7 Comm% 

Enter the commission percentage for this standard price UM. Press F1 to default to NO 
PRIORITY. 

Pricing levels 
Level prices can be added for each unit of measure that is a default unit of measure for any 
type (pricing, costing, selling, etc.) and is valid for pricing. Complete this information in the 
Quick Item Entry (ICF911) program. 

For each price level used by the system, enter the following: 

8 Price Level Basis 

Enter the basis for calculating the standard price per unit of measure displayed: List Price, 
Manual Cost, Standard Price or Previous Level #. Press F1 to skip the entry of basis and 
multiplier and go to the price field. 

9 Price Level Multiplier 

If basis was not entered in the previous field, this field is skipped. Enter the price level 
multiplier for calculating the level price per unit of measure displayed. Press F1 to skip the 
entry of basis and multiplier and go to the price field. 
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10 Level Price 

If basis and multiplier were entered in the previous 2 fields, this field is skipped. Enter the 
level price per unit of measure displayed. F3 ends item fields. Press Enter to default to 0. 

11 Comm% 

Enter the commission percentage for this level price UM. Press F1 to default to NO 
PRIORITY. 

Quantity break pricing 
Quantity break prices can be added for each unit of measure that is a default unit of measure 
for any type (pricing, costing, selling, etc.) and is valid for pricing and selling. Complete the 
following in the Quick Item Entry (ICF911) program. 

For each quantity break used by the system, enter the following: 

12 Quantity Break  

Enter the quantity break per unit of measure displayed. 

13 Quantity Break Basis 

Enter the basis for calculating the quantity break price per unit of measure displayed: List 
Price, Manual Cost, Standard Price or Previous Level #. Press F1 to skip the entry of basis 
and multiplier and go to the price field. 

14  Quantity Break Multiplier 

If basis was not entered in the previous field, this field is skipped. Enter the quantity break 
multiplier for calculating the quantity break price per unit of measure displayed. Press F1 to 
skip the entry of basis and multiplier and go to the price field. 

15 Quantity Break Price 

If basis and multiplier were entered in the previous 2 fields, this field is skipped. Enter the 
quantity break price per unit of measure displayed. Press F3 to end item fields. Press Enter 
to default to 0. 

16  Comm% 

Enter the commission percentage for this quantity break. Press F1 to default to NO 
PRIORITY. 

Once all prices have been entered for an item, or if at any time the user selects to end 
costing/pricing entries, prior to moving on to the warehouse entry, the user has the option to 
edit costing/pricing information entered or change the scope of what costing/pricing 
information is entered.  

Quick Warehouse/Item Entry 
After you enter pricing information for the new item, the system displays the Quick 
Warehouse/Item Entry (ICE912) program so you can enter the new item in the warehouse.  
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Using Quick Item Add vs. entering temporary items 
If the item is a special order or that will not be kept in inventory, enter it as a temporary item 
in one of the SO Order Management programs. (Enter the temporary item number and enter 
the vendor and item information as the system prompts for it). 

To create an item in Quick Item Add: 

1  Enter an existing item to use as your default (or template) in the Default Item Entry box. 

This is a required field. 

Choosing an existing item that is similar to the one you are creating helps you save time 
since you can use many of the same properties and settings. 

The system makes a copy of this record so you can rename it to something else. The original 
record is not overwritten or changed in any way. 

2  Enter a name for the item you are creating. 

The new item name can be any alphanumeric combination. The system warns you if you 
enter a number that already exists and requires you to enter a new number. This prevents 
you from overwriting an existing item number. 

Click OK to continue to the main Quick Item Add screen. Select Cancel (F4) to return to exit 
out of Quick Item Add without creating a record. 

3  Use the Quick Item Add main screen to define the item. 

The Quick Item Add main screen is similar to the Item F/M program. 

Use the Main tab to enter general item information, such as vendors, descriptions, price 
class, GL table, etc. 

Use the UM/Pricing tab to enter units of measure, conversion factors (if necessary) and 
weights. Also enter pricing information on this tab. 

When you enter a default item through this program, the system does not automatically 
create all of the Units of Measure (UMs) for the new item that existed for the default item. 
The Quick Item Add program is designed to carry over the smallest UM from a default item. If 
the default you are using to create another item has UM as defaults for Stocking, Costing, 
Pricing, and Selling, then the system also creates those UM’s for the new item. Since the 
Buying UM does not exist in the Quick Item Add program, the system uses the default item’s 
stocking UM for the new item’s buying UM. To check the UM information for items created 
via the Quick Item Add program, access the Item F/M and review the UM setup information. 

Use the Inventory tab to determine which warehouses stock this item, the restocking 
warehouse, safety allowance, restocking method, warehouse location and the item’s 
seasonal status, if any. 

Note: To enter service items on the fly, you can start by creating the item record in Quick 
Item Add and set up the Service Item controls in Item F/M later. Set the Item Type field to 
Uninventoried. 

4   Click Save. 
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If you decide you do not want to enter this item, choose Exit (F4) at any time and choose No 
(N) when the system asks if you want to save the record. 

Maintaining inventory 

Adding purchase lines 
1 Click Inventory Control>File Maintenances>Purchase Line Entry (ICE920). 

2 Click the Next icon to add a new purchasing Line. 

3 Specify the purchasing line description and the vendor for the line. 

4 Click Add and specify the item number. 

5 (Optional) To enter additional items, click Add again and specify item number to include 
in the purchasing line for the specified vendor. 

  

Updating the vendor for an item on a purchase line 
1 Click Inventory Control> File Maintenances>Purchase Line Entry (ICE920). 

2 Specify the purchasing line you want to modify, or enter the purchasing line description 
and the vendor for a new purchasing line. 

3 Click Add and enter the item number. 

4 Reply Yes when the message "Do you want to change vendor XX to vendor XX for the 
item?" 
The item will be modified in the system to the new purchasing line and vendor you 
specify. 

5 Save your changes. 

6 Exit the program. 

Deleting items from purchase lines  
1 Click Inventory Control> File Maintenances>Purchase Line Entry (ICE920). 

2 Specify the purchasing line you want to modify. 

3 In the browser, highlight the item line that you want to remove. 

4 Click Delete. 

5 Save your changes. 
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6 Exit the program. 

Modifying lead time for a receipt (Entering Qualified Lead 
Time) 
1 Click Inventory Control>File Maintenances> Lead Time Review. 

2 Specify the warehouse and item to use for the receipt document display. 

3 Indicate the type of documents you want to view - transfers, purchase orders or both. 

4 (Optional) Specify the PO number and receipt or Transfer number and shipment line if 
you know the exact information. 

5 The transfers shipment lines and purchase order receipt lines are displayed in the 
browser so you can modify the lead time information as needed. 

6 Highlight the line you want to modify and click Edit. 

7 (Optional) You can select the Ignore check box to prevent this lead time from be included 
in average lead time calculations. 

8 (Optional) You can select the Abnormal check box to flag a Lead Time as abnormal if it 
is more than 50% different from the average or if the ARP Lead Time minimum or 
maximum threshold has been reached. 

9 Specify the qualified lead time that represents the correct lead time value that is to be 
used in calculations in the system. 

10 Save your changes. 

11 You have these options. 

• Restocking-Opens the Restocking View (POC417) screen for the selected 
warehouse/item; if the header warehouse/item is not used it will use the 
warehouse/item of the line in the browser. 

• Usage-Opens the Usage View (POC416) View for the selected warehouse/item; if 
the header warehouse/item is not used it will use the warehouse/item of the line in 
the browser. 

• View Doc-Views the doc selected in the browser. 
• Replen F/M-Accesses Replenishment Parameter Maintenance for the selected 

warehouse/item or for the warehouse/item of the highlighted line in the browser. 
-Or- 

• Highlight the next receipt to enter qualified usage and repeat steps 7-10. 

12 When you are finished entering qualified usage, click Done to enter another warehouse 
and item to use for the receipt document display or click Done again to exit the program. 

Entering qualified usage 
1 Click Inventory Control>File Maintenances>Usage Review. 
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2 Specify the warehouse and item to use for the receipt document display. 

3 In the Beginning Date field, specify the beginning date for the browser display, and in 
the Days to Display field specify the number of days (30, 60, 90, or 120) to display. 
Tip: Press F1 to enter the current date. Click IC Period End to automatically enter the 
'end of current IC period' or you can enter the date to be the end of the current IC period 
(even if that date is in the "future"). This allows you to view all the dates of the current 
period. 

4 (Optional) Check the Abnormal check box to only display those usage lines that are 
Abnormal (both High and Low). 

5 In the browser, double click the usage line in the browser to display the Usage Review 
Detail (ICE556) program. You can change qualified usage for any document that has 
recorded usage for the selected warehouse and item combination you specified. 

6 (Optional) You can apply a set of filters to define the usage lines displayed in the 
browser. In the Beginning Date field, you can filter for the beginning date for the display. 

7 (Optional) In the Days to Display field specify the number of days (30, 60, 90, or 120) to 
display. 

8 (Optional) You can also select the For Usage Warehouse from list box with the user 
entered warehouse, along with all the warehouses that are replenished from the 
specified warehouse/item and the type of usage to display-- Exceptional Usage, Not 
Exceptional Usage, or All, and the document types for the display: AD – adjustment, SO 
– Sales Order/Invoice, MC – BOM Ticket, MF – Formulation Ticket, MP – Formulation 
Packaging, MI – Formulation Ingredients, PO – Purchase Order, CR – Credit of usage 
for Customer/Vendor Returns, and LS – Lost Sale. 

9 Highlight a disbursement line in the browser and click Edit to modify information 

10 Select the Update Usage check box to update usage. 

11 In the Usage Date field specify the date for the usage change. 

12 In the Qualified Usage field, specify the new usage value for the warehouse/item on the 
document line. 

13 Once you have modified the qualified usage and save your changes, click Done to return 
to Usage Review (ICE555). 

14 Click Recalculate Usage on Usage Review (ICE555) and specify the Recalculate From 
date. 

15 Click OK to recalculate qualified usage for specified warehouse/item. 

16 Click Done to enter additional qualified usage. 

17 Click Done again to exit the program 

Replenishment Parameter Maintenance procedures 
The Replenishment Parameter Maintenance program allows the buyer to configure the 
procurement calculations. These procedure categories of parameters are available.  
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Correcting errors in Replenishment Parameter Maintenance 
If you enter incorrect information for the default company parameters, you cannot proceed in 
this program until the error is corrected.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 In the Parameter Options Line browser, select the Replenishment Parameter that is 
highlighted in red. 

3 Make the necessary changes in the Replenishment Parameter information. 

4 Click Exit when you are done. 

Editing replenishment parameters 
Note that you cannot delete the company default settings. You can delete only the overrides 
entered for the parameters set in the system.   

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining parameters for the item: You can enter a warehouse, from 
warehouse vendor, purchasing line and/or item combination. Note: The scope for an item 
ideally should be least to most specific. When possible, parameters should be set 
according to the hierarchy: Company, Warehouse, From Warehouse, Vendor, 
Purchasing Line, Item, Warehouse / Item and avoid specific items settings. 

3 In the Show drop down, specify Summary to view all of the effective parameters entered 
for the parameters set in the system and Detail to display overrides for only those 
parameter options that can be defined for the warehouse, from warehouse, vendor, 
purchasing line and/or item combination entered in step 2. 

4 In the Parameter Options Line browser, select the Replenishment Parameter that you 
want to delete. 

5 Click Delete. 

6 Click yes, when the message asking if you want to delete the line is displayed. 

7 Click Exit. 

Entering frozen controls replenishment parameters 
Use this procedure matrix to enter all Frozen Controls replenishment parameters at one time. 
This procedure matrix is particularly useful or setting up all parameters in a category at once.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining scope for Frozen Controls parameter you are entering. You can 
leave the setting as company-wide or enter a warehouse, from warehouse, vendor, 
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purchasing line and/or item combination. Note: The scope for an item ideally should be 
least to most specific. When possible, parameters should be set according to the 
hierarchy: Company, Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and 
avoid specific items settings. 

3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Frozen Controls to display all Frozen Controls Replenishment 
Parameters in the browser. 

5 Click the Frozen Controls parameter you want to add an override value to or edit the 
company record and click Add or Edit. 

6 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. 

7 (Optional) When the system asks if you want to change to a more specific scope, click 
Yes. 

8 Use this matrix to enter all Frozen Controls Replenishment Parameter Maintenance 
information.  

Freeze Order Point/Line Point/Order Quantity 

1 (Optional) Check the Order Point check box to indicate you want to freeze the order 
point for the specified item in the specified warehouse. Then, enter the frozen order point 
value. 

2 (Optional) Check the Line Point check box to indicate you want to freeze the line point 
for the specified item in the specified warehouse. Then, enter the frozen line point value. 

3 (Optional) Check the Order Quantity check box to indicate you want to freeze the order 
quantity for the specified item in the specified warehouse. Then, enter the frozen order 
quantity value. 

4 In the Expiration Date field specify the expiration date for the frozen rank if you have 
modified the scope of the parameter to narrow it from the company defaults. 

5 (Optional) In the Memo field specify the optional memo for the frozen rank. 

6 Click Save. 

7 (Optional) You can specify additional replenishment parameters as needed. 

8 Click Exit. 

Freeze Rank 

1 Click the Freeze Rank check box to indicate an item’s rank is frozen. 

2 Enter the frozen rank value (A-E). 

3 In the Expiration Date field specify the expiration date for the frozen rank if you have 
modified the scope of the parameter to narrow it from the company defaults if you have 
modified the scope of the parameter to narrow it from the company defaults. 
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4 (Optional) In the Memo field specify the optional memo for the frozen rank. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Freeze Lead Time 

1 Click the Freeze Lead Time check box to indicate an item’s lead time is frozen.  

2 Enter the frozen lead time value. 

3 In the Expiration Date field specify the calendar date that Lead Time will become 
unfrozen. 

4 (Optional) In the Memo field specify the optional short description about frozen lead time 
for display and reporting purposes. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Freeze Safety Stock 

1 Click the Freeze Safety Stock check box to indicate an item’s safety stock is frozen. 
Then, enter the frozen safety stock value and specify whether the type is P-Percent or D-
Days. 

2 In the Expiration Date field specify the expiration date for the expiration date to remove 
the freeze if supplied. 

3 (Optional) In the Memo field specify the optional memo for display and reporting 
purposes. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Entering Order Point replenishment parameters 
Use this procedure matrix to enter all Order Point replenishment parameters at one time. 
This procedure matrix is particularly useful or setting up all parameters in a category at once.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining scope for the Order Point parameter you are entering. You can leave 
the setting as company-wide or enter a warehouse, from warehouse, vendor, purchasing 
line and/or item combination. Note: The scope for an item ideally should be least to most 
specific. When possible, parameters should be set according to the hierarchy: Company, 
Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and avoid specific items 
settings. 
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3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Order Point to display all Order Point Replenishment Parameters 
in the browser. 

5 Click the Order Point parameter you want to add an override value to or edit the 
company record and click Add or Edit. 

6 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. 

7 (Optional) When the system asks if you want to change to a more specific scope, click 
Yes. 

8 Use this procedure matrix to enter all order point Replenishment Parameter Maintenance 
information.  

ASQ (average shipping quantity) parameters 

1 Check the Use ASQ check box to indicate Average shipping Quantity will be a factor 
used in Order Point calculation. 

2 Check the Include Transfer in ASQ check box to indicate warehouse transfers should 
be included in the Average shipping Quantity. 

3 In the ASQ maximum dollar increase field specify the total cost value of a ASQ 
average shipping quantity increase to order point, above which the ASQ will be ignored. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Five-Hi ASQ parameters 

1 Check the Use Five HI check box to indicate Five Hi will be a factor used in Order Point 
calculation. 

2 Check the Include Transfer in 5Hi check box to indicate warehouse transfers should be 
included in the Order Point calculation. 

3 In the 5-Hi maximum dollar increase field specify the total cost value of a 5-Hi average 
shipping quantity increase to order point, above which the 5-Hi ASQ will be ignored. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

ASQ/Five HI months 

1 In the Months Used for ASQ/Five Hi fields specify the number of usage months for 
ASQ and Five HI calculations. 
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2 Click Save. 

3 (Optional) You can specify additional replenishment parameters as needed. 

4 Click Exit. 

Threshold minimum order point 

1 Click the Apply a Threshold Minimum check box to indicate a threshold order point 
minimum is applied and the order point will not be allowed to fall below the minimum. 

2 In the T-min Order Point field specify the value of the threshold order point minimum. 

3 In the Expiration Date field specify the expiration date for the threshold minimum. 

4 (Optional) In the Memo field specify the optional memo for the threshold order point 
minimum. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Entering Order Quantity replenishment parameters 
Use this procedure matrix to enter all Order Quantity replenishment parameters at one time. 
This procedure matrix is particularly useful or setting up all parameters in a category at once.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining scope for the Order Quantity parameter you are entering. You can 
leave the setting as company-wide or enter a warehouse, from warehouse, vendor, 
purchasing line and/or item combination. Note: The scope for an item ideally should be 
least to most specific. When possible, parameters should be set according to the 
hierarchy: Company, Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and 
avoid specific items settings. 

3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Order Quantity to display all Order Quantity Replenishment 
Parameters in the browser. 

5 Click the Order Quantity parameter you want to add an override value to or edit the 
company record and click Add or Edit. 

6 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. 

7 (Optional) When the system asks if you want to change to a more specific scope, click 
Yes. 
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8 Use this procedure matrix to enter all Order Quantity Replenishment Parameter 
Maintenance information.  

OQM for Seasonal Items ARP Vendor 

1 In the Parameter Options Line browser, select the Replenishment Parameter “OQM for 
Seasonal Items ARP Vendor”. 

2 Click Edit. 

3 In the R Cost $ field specify the replenishment cycle cost - the cost to process an order 
for an item. 

4 In the K Cost % field specify the cost to carry percent - the annual cost to carry inventory 
divided by the average inventory value. 

5 In the Minimum Days Supply field, specify the number of days supply that the order 
quantity should always be. 

6 In the Maximum Days Supply field, specify the number of days supply that the order 
quantity should never exceed. 

7 Click the Use EOQ check box to indicate you want to apply the economic order quantity 
calculation. 

8 In the Expiration Date field specify the expiration date for the using the economic order 
quantity calculation if you have modified the scope of the parameter to narrow it from the 
company defaults. 

9 (Optional) In the Memo field specify the optional memo for display and reporting 
purposes. 

10 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. When the system asks if you want to change to a 
more specific scope, click Yes. 

11 Click Save. 

12 (Optional) You can specify additional replenishment parameters as needed. 

13 Click Exit. 

OQM for non-Seasonal Items ARP Vendor 

1 In the Parameter Options Line browser, select the Replenishment Parameter “OQM for 
non-Seasonal Items ARP Vendor”. 

2 Click Edit. 

3 In the R Cost $ field specify the replenishment cycle cost - the cost to process an order 
for an item. 

4 In the K Cost % field specify the cost to carry percent - the annual cost to carry inventory 
divided by the average inventory value. 

5 In the Minimum Days Supply field, specify the number of days supply that the order 
quantity should always be. 
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6 In the Maximum Days Supply field, specify the number of days supply that the order 
quantity should never exceed. 

7 Click the Use EOQ check box to indicate you want to apply the economic order quantity 
calculation. 

8 In the Expiration Date field specify the expiration date for the using the economic order 
quantity calculation if you have modified the scope of the parameter to narrow it from the 
company defaults. 

9 (Optional) In the Memo field specify the optional memo for display and reporting 
purposes. 

10 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. When the system asks if you want to change to a 
more specific scope, click Yes. 

11 Click Save. 

12 (Optional) You can specify additional replenishment parameters as needed. 

13 Click Exit. 

OQM for Seasonal Items ARP Transfer 

1 In the Parameter Options Line browser, select the Replenishment Parameter “OQM for 
Seasonal Items ARP Transfer”. 

2 Click Edit. 

3 In the R Cost $ field specify the replenishment cycle cost - the cost to process an order 
for an item. 

4 In the K Cost % field specify the cost to carry percent - the annual cost to carry inventory 
divided by the average inventory value. 

5 In the Minimum Days Supply field, specify the number of days supply that the order 
quantity should always be. 

6 In the Maximum Days Supply field, specify the number of days supply that the order 
quantity should never exceed. 

7 Click the Use EOQ check box to indicate you want to apply the economic order quantity 
calculation. 

8 In the Expiration Date field specify the expiration date for the using the economic order 
quantity calculation if you have modified the scope of the parameter to narrow it from the 
company defaults. 

9 (Optional) In the Memo field specify the optional memo for display and reporting 
purposes. 

10 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
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replenishment parameter hierarchy. When the system asks if you want to change to a 
more specific scope, click Yes. 

11 Click Save. 

12 (Optional) You can specify additional replenishment parameters as needed. 

13 Click Exit. 

OQM for non-Seasonal Items ARP Transfer 

1 In the Parameter Options Line browser, select the Replenishment Parameter “OQM for 
non-Seasonal Items ARP Transfer”. 

2 Click Edit. 

3 In the R Cost $ field specify the replenishment cycle cost - the cost to process an order 
for an item. 

4 In the K Cost % field specify the cost to carry percent - the annual cost to carry inventory 
divided by the average inventory value. 

5 In the Minimum Days Supply field, specify the number of days supply that the order 
quantity should always be. 

6 In the Maximum Days Supply field, specify the number of days supply that the order 
quantity should never exceed. 

7 Click the Use EOQ check box to indicate you want to apply the economic order quantity 
calculation. 

8 In the Expiration Date field specify the expiration date for the using the economic order 
quantity calculation if you have modified the scope of the parameter to narrow it from the 
company defaults. 

9 (Optional) In the Memo field specify the optional memo for display and reporting 
purposes. 

10 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply.  Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy.  When the system asks if you want to change to a 
more specific scope, click Yes. 

11 Click Save. 

12 (Optional) You can specify additional replenishment parameters as needed. 

13 Click Exit. 

Apply Rounding to Order Quantity 

1 In the Parameter Options Line browser, select the Replenishment Parameter “Apply 
Rounding to Order Quantity”. 

2 Click Edit. 

3 Click the Apply Rounding on Order Quantity check box to indicate you want to round 
up to the recommended purchase amount. 
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4 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy.  When the system asks if you want to change to a 
more specific scope, click Yes. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Rounding Value for ARP Vendor 

1 In the Parameter Options Line browser, select the Replenishment Parameter “Rounding 
Value for ARP Vendor”. 

2 Click Edit. 

3 In the Round to the next field specify the amount to use to round the recommended 
order quantity to the next multiple of this quantity that the recommended purchase 
amount should be rounded up to, usually due to vendor policies 

4 In the drop down field specify the unit of measure that the recommended purchase 
amount should be rounded up to, usually due to vendor policies 

5 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply.  Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy.  When the system asks if you want to change to a 
more specific scope, click Yes. 

6 Click Save. 

7 (Optional) You can specify additional replenishment parameters as needed. 

8 Click Exit. 

Rounding Value for ARP Transfer 

1 In the Parameter Options Line browser, select the Replenishment Parameter “Rounding 
Value for ARP Transfer”. 

2 Click Edit. 

3 In the Round to the next field specify the amount to use to round the recommended 
order quantity to the next multiple of this quantity that the recommended purchase 
amount should be rounded up to, usually due to warehouse/item policies. 

4 In the drop down field specify the unit of measure that the recommended purchase 
amount should be rounded up to, usually due to warehouse/item policies. 

5 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply.  Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy.   

6 When the system asks if you want to change to a more specific scope, click Yes. 
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7 Click Save. 

8 (Optional) You can specify additional replenishment parameters as needed. 

9 Click Exit. 

Minimum Order Quantity for ARP Vendor 

1 In the Parameter Options Line browser, select the Replenishment Parameter “Minimum 
Order Quantity for ARP Vendor”. 

2 Click Edit. 

3 In the Minimum Order Quantity field specify the amount to round the suggested order 
quantity to if it falls below this minimum. 

4 In the drop down field specify the buying unit of measure that the recommended 
minimum order quantity should be rounded up to, usually due to warehouse/item policies 

5 In the Expiration Date field specify the expiration date for the using the minimum order 
quantity as the rounding value for the suggested order quantity. 

6 (Optional) In the Memo field specify the optional memo for display and reporting 
purposes. 

7 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Vendor/Item, Item, Warehouse/Item as appropriate and click Apply. Note: The settings 
for this parameter must always contain an item. When the system asks if you want to 
change to a more specific scope, click Yes. 

8 Click Save. 

9 (Optional) You can specify additional replenishment parameters as needed. 

10 Click Exit. 

Minimum Order Quantity for ARP Transfer 

1 In the Parameter Options Line browser, select the Replenishment Parameter “Minimum 
Order Quantity for ARP Transfer”. 

2 Click Edit. 

3 In the Minimum Order Quantity field specify the amount to round the suggested order 
quantity to if it falls below this minimum. 

4 In the drop down field specify the buying unit of measure that the recommended 
minimum order quantity should be rounded up to, usually due to warehouse/item policies 

5 In the Expiration Date field specify the expiration date for the using the minimum order 
quantity as the rounding value for the suggested order quantity. 

6 (Optional) In the Memo field specify the optional memo for display and reporting 
purposes. 

7 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse/Item, Item, From Warehouse/Item as appropriate and click Apply. Note: The 
settings for this parameter must always contain an item.  

8 When the system asks if you want to change to a more specific scope, click Yes. 
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9 Click Save. 

10 (Optional) You can specify additional replenishment parameters as needed. 

11 Click Exit. 

Entering Lead Time replenishment parameters 
Use this procedure matrix to enter all Lead Time replenishment parameters at one time. This 
procedure matrix is particularly useful or setting up all parameters in a category at once.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining scope for Lead Time parameter you are entering. You can leave the 
setting as company-wide or enter a warehouse, from warehouse, vendor, purchasing line 
and/or item combination. Note: The scope for an item ideally should be least to most 
specific. When possible, parameters should be set according to the hierarchy: Company, 
Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and avoid specific items 
settings. 

3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Lead Time to display all Lead Time Replenishment Parameters in 
the browser. 

5 Click the Lead Time parameter you want to add an override value to or edit the company 
record and click Add or Edit. 

6 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. 

7 (Optional) When the system asks if you want to change to a more specific scope, click 
Yes. 

8 Use this procedure matrix to enter all Lead Time Replenishment Parameter Maintenance 
information.  

Abnormal Lead Time for ARP Transfers 

1 In the % of Average Too Low field, specify the percent difference below the existing 
average lead time for a new lead time to be considered abnormal. 

2 In the % of Average Too High field specify the percent difference above the existing 
average lead time for a new lead time to be considered abnormal. 

3 Click Save. 

4 (Optional) You can specify additional replenishment parameters as needed. 

5 Click Exit. 
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6 Abnormal lead time for ARP vendors 

7 In the % of Average Too Low field specify the percent difference below the existing 
average lead time for a new lead time to be considered abnormal. 

8 In the % of Average Too High field specify the percent difference above the existing 
average lead time for a new lead time to be considered abnormal. 

9 Click Save. 

10 (Optional) You can specify additional replenishment parameters as needed. 

11 Click Exit. 

Receipts used to calculate lead time 

1 In the Number of Receipts field specify a minimum number of receipts required for lead 
time to become a factor. 

2 In the Number of Months field, specify the number of months in which the number of 
receipts must occur. 

3 Click Save. 

4 (Optional) You can specify additional replenishment parameters as needed. 

5 Click Exit. 

Lead time for ARP vendors 

1 Check the Use a Minimum/Maximum Days for ARP Vendor Lead Time check box to 
indicate minimum and/or maximum Lead Times will be used for the ARP for a specified 
vendor. 

2 In the Lead Time Minimum Days field specify the minimum number of days specified for 
a vendor's Lead Time. 

3 In the Lead Time Maximum Days field specify the maximum number of days specified 
for a vendor's Lead Time. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Lead time for ARP transfers 

1 Check the Use a Minimum/Maximum Days for ARP Warehouse Lead Time check box 
to indicate minimum and/or maximum lead times will be used for a warehouse transfer. 

2 In the Lead Time Minimum Days field specify the minimum number of days specified for 
a warehouse transfer's lead time. 

3 In the Lead Time Maximum Days field specify the maximum number of days specified 
for a warehouse transfer's lead time. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 
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New Item Default Lead Time for ARP Vendor 
1 In the New Item Lead Time field specify the lead time for new items. 

2 Click Save. 

3 (Optional) You can specify additional replenishment parameters as needed. 

4 Click Exit. 

New Item Default Lead Time for ARP Transfer 
1 In the New Item Lead Time field specify the lead time for new items. 

2 Click Save. 

3 (Optional) You can specify additional replenishment parameters as needed. 

4 Click Exit. 

Entering Threshold Maximum Line Point replenishment 
parameters 
Use this procedure matrix to enter the Threshold Maximum Line Point replenishment 
parameter.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining scope for Threshold Maximum Line Point parameter. You can leave 
the setting as company-wide or enter a warehouse, from warehouse, vendor, purchasing 
line and/or item combination. Note: The scope for an item ideally should be least to most 
specific. When possible, parameters should be set according to the hierarchy: Company, 
Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and avoid specific items 
settings. 

3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Line Point to display the Threshold Maximum Line Point 
Replenishment Parameter in the browser. 

5 Click the Threshold Maximum Line Point parameter you want to add an override value to 
or edit the company record and click Add or Edit. 

6 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. 

7 (Optional) When the system asks if you want to change to a more specific scope, click 
Yes. 
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8 Check the Apply a threshold maximum line point check box to apply a maximum 
value and not allow the calculated value to exceed the maximum entered here. 

9 Specify the maximum line point value in the T-Max Line Point field.  

10 Specify the expiration date for the parameter and a memo to indicate the purpose for the 
threshold maximum line point.  

11 Click Save. 

12 Click Cancel to end line entry. 

13 (Optional) You can specify additional replenishment parameters as needed.  

14 Click Exit. 

Entering Usage replenishment parameters 
Use this procedure matrix to enter all Usage replenishment parameters at one time. This 
procedure matrix is particularly useful or setting up all parameters in a category at once.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining scope for Usage parameter you are entering. You can leave the 
setting as company-wide or enter a warehouse, from warehouse, vendor, purchasing line 
and/or item combination. Note: The scope for an item ideally should be least to most 
specific. When possible, parameters should be set according to the hierarchy: Company, 
Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and avoid specific items 
settings. 

3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Usage to display all Usage Replenishment Parameters in the 
browser. 

5 Click the Usage parameter you want to add an override value to or edit the company 
record and click Add or Edit. 

6 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. 

7 (Optional) When the system asks if you want to change to a more specific scope, click 
Yes. 

8 Use this procedure matrix to enter all Usage Replenishment Parameter Maintenance 
information.  

Threshold minimum usage adjuster 

1 In the T-Min usage minimum field specify the value for Threshold Minimum Monthly 
Usage to be applied. 
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2 In the Expiration Date field specify the expiration date for the threshold minimum usage. 

3 (Optional) In the Memo field specify the optional memo for the threshold minimum 
usage. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Trending parameters and adjusters 

1 Select the Apply seasonal trend minimum and maximum check box to indicate to 
apply a minimum and maximum trend percentage. 

2 In the Minimum Trend % field specify the value for Minimum Trend percentage to apply 
when forecasting usage. 

3 In the Maximum Trend % field specify the value for Maximum Trend percentage to 
apply when forecasting usage. 

4 In the Prior Year Hits field specify the value for the hits the item must have had last year 
before allowing a trend to be applied. 

5 In the Current Year Hits field specify the value for the hits the item must have this year 
before allowing a trend to be applied. 

6 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 

7 (Optional) In the Memo field specify the optional memo for the seasonal trend maximum 
and minimum. 

8 Click Save. 

9 (Optional) You can specify additional replenishment parameters as needed. 

10 Click Exit. 

Usage months for seasonal 

1 In the Rank A-E fields specify the number of months to analyze when calculating 
average usage for an A-E ranked items. 

2 Click Save. 

3 (Optional) You can specify additional replenishment parameters as needed. 

4 Click Exit. 

Seasonal lead time advance for vendor ARPs 

1 Click Apply to adjust the usage period start date for trend factor and usage calculations 
on seasonal items by the average lead time to reflect the need when the product is to 
arrive  

2 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 
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3 (Optional) In the Memo field specify the optional memo for the seasonal lead time 
advance. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Seasonal lead time advance for transfer ARPs 

1 Click Apply to adjust the usage period start date for trend factor and usage calculations 
on seasonal items by the average lead time to reflect the need when the product is to 
arrive  

2 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 

3 (Optional) In the Memo field specify the optional memo for the seasonal lead time 
advance. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Usage months for non-Seasonal 

1 In the Rank A-E fields specify the number of months to analyze when calculating 
average usage for an A-E ranked items. 

2 Click Save. 

3 (Optional) You can specify additional replenishment parameters as needed. 

4 Click Exit. 

Entering Surplus Stock parameters  
Use this procedure matrix to enter all Surplus Stock Replenishment Parameter Maintenance 
information.  

Long-Term Surplus, Seasonal 

1 In the Usage Calculation field specify how to calculate average daily usage for long 
term surplus: T-Total Yearly Usage or C-Current Average Daily Usage. 

2 In the # of Days Supply field, specify the number of days' supply, above which available 
stock is considered long-term surplus. 

3 In the Skip Items Establish Less Than field, specify the number of days an item must 
be establish before calculating long-term surplus. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 
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Long-Term Surplus, Non-Seasonal  

1 In the Usage Calculation field specify how to calculate average daily usage for long 
term surplus: T-Total Yearly Usage or C-Current Average Daily Usage. 

2 In the # of Days Supply field, specify the number of days' supply, above which available 
stock is considered long-term surplus. 

3 In the Skip Items Establish Less Than field, specify the number of days an item must 
be establish before calculating long-term surplus. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Entering Safety Stock replenishment parameters 
Use this procedure matrix to enter all Safety Stock replenishment parameters at one time. 
This procedure matrix is particularly useful or setting up all parameters in a category at once.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining scope for Safety Stock parameter you are entering. You can leave 
the setting as company-wide or enter a warehouse, from warehouse, vendor, purchasing 
line and/or item combination. Note: The scope for an item ideally should be least to most 
specific. When possible, parameters should be set according to the hierarchy: Company, 
Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and avoid specific items 
settings. 

3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Lead Time to display all Safety Stock Replenishment Parameters 
in the browser. 

5 Use this procedure matrix to enter all Safety Stock Replenishment Parameter 
Maintenance information.  

Safety stock for vendor ARP parameters 

1 In the Safety Stock Type field specify the safety stock type (P)ercentage or (D)ays. 

2 In the Percentage or Days field specify the number of days or percentage safety stock. 

3 In the Rank A-E fields specify the value for A-E ranked items, dependent on safety stock 
type. 

4 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 

5 (Optional) In the Memo field specify the optional memo for the override. 

6 Click Save. 
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7 (Optional) You can specify additional replenishment parameters as needed. 

8 Click Exit. 

Safety stock for vendor ARP adjusters 

1 For Ranks A-E in the Minimum and Maximum Days fields, specify Rank A-E minimum 
and maximum Safety Stock days for the ARP Vendor. 

2 In the Expiration Date field specify the expiration date for the Safety Stock by ARP 
Vendor minimum and maximum values if you have modified the scope of the parameter 
to narrow it from the company defaults. 

3 (Optional) In the Memo field specify the optional memo for Safety Stock by ARP Vendor 
minimum and maximum values for Rank adjuster. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Safety stock for transfer ARP adjusters 

1 For Ranks A-E: in the Minimum and Maximum Days fields specify Rank A-E minimum 
and maximum Safety Stock days for ARP Vendor. 

2 In the Expiration Date field specify the expiration date for the Safety Stock by ARP 
Vendor minimum and maximum days if you have modified the scope of the parameter to 
narrow it from the company defaults. 

3 (Optional) In the Memo field specify the optional memo for Safety Stock by ARP Vendor 
minimum and maximum days for Rank adjuster. 

4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Safety stock for transfers ARP parameters 

1 In the Safety Stock Type field specify the safety stock type (P)ercentage or (D)ays. 

2 In the Percentage or Days field specify the number of days or percentage safety stock. 

3 In the Rank A-E fields specify the value for A-E ranked items, dependent on safety stock 
type. 

4 In the Expiration Date field specify the expiration date for the Safety Stock by ARP 
Vendor minimum and maximum days if you have modified the scope of the parameter to 
narrow it from the company defaults. 

5 (Optional) In the Memo field specify the optional memo for the override. 

6 Click Save. 

7 (Optional) You can specify additional replenishment parameters as needed. 

8 Click Exit. 
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Entering Alert replenishment parameters 
1 Click Inventory Control>File Maintenances>Replenishment Parameter 

Maintenance. 

2 Specify the defining scope for the Alert parameter you are entering. You can leave the 
setting as company-wide or enter a warehouse, from warehouse, vendor, purchasing line 
and/or item combination.  Note:  The scope for an item ideally should be least to most 
specific. When possible, parameters should be set according to the hierarchy: Company, 
Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and avoid specific items 
settings. 

3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Alerts to display all Alert Replenishment Parameters in the 
browser. 

5 Click the Alert parameter you want to add an override value to or edit the company 
record and click Add or Edit. 

6 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. 

7 (Optional) When the system asks if you want to change to a more specific scope, click 
Yes. 

8 Use this procedure matrix to enter all Alerts Replenishment Parameter Maintenance 
information.  

Alert for Non-Replenishment Items with Hits 

1 Click the Alert on Non-Replenishment Items with Hits check box to indicate an alert 
will be generated when the criteria are met. 

2 In the Number of Hits field specify the number of document hits required within the 
number of months indicated in the field below. 

3 In the Number of Months field, specify the number of months in which the hits must 
occur. 

4 If an item has frozen controls and that item has the indicated # of document hits in the # 
months specified (going back from today), an alert will be raised. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Alert on Expiring Parameters 

1 Click the Alert on Frozen Controls about to expire check box to indicate an alert 
should be raised prior to a freeze on a control expiring. 
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2 In the Days Before Expiration field specify the number of days prior to the freeze 
expiration date that the buyer(s) should begin receiving alerts. 

3 Click Save. 

4 (Optional) You can specify additional replenishment parameters as needed. 

5 Click Exit. 

Alert on Usage Alert Settings 

1 In the Usage Months field specify the number of month usage to average when 
checking for abnormal usage. 

2 In the High Usage Multiplier field specify the value for the multiplier when calculating 
high usage. If the current month’s usage is higher than the calculated average multiplied 
by this multiplier, it is considered high. 

3 In the Low Usage Multiplier field specify the value for the multiplier when calculating 
low usage. If the current month’s usage is lower than the calculated average multiplied 
by this multiplier, it is considered low. 

4 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 

5 (Optional) In the Memo field specify the optional memo for the usage alert setting. 

6 Click Save. 

7 (Optional) You can specify additional replenishment parameters as needed. 

8 Click Exit. 

Note: This minimum setting will not impact a higher calculated order point from becoming 
effective for an item. 

Alert Calculated vs. Frozen OP/LP/OQ (order point, line point or order quantity) 
Variance 

1 Click the Alert Calculated vs. Frozen OP/LP/OQ Variance check box to indicate 
whether an alert should be raised when order point, line point or order quantity 
significantly deviate from their frozen values. 

2 For Order Point, in the Units, Percent and Cost fields specify the value for the amount, 
percent and/or total cost values that should generate an alert, when the calculated order 
point deviates from the frozen order point. 

3 For Line Point, in the Units, Percent and Cost fields specify the value for the amount, 
percent and/or total cost values that should generate an alert, when the calculated line 
point deviates from the frozen line point. 

4 For EOC, in the Units, Percent and Cost fields specify the value for the amount, percent 
and/or total cost values that should generate an alert, when the calculated economic 
order quantity deviates from the frozen order quantity. 

5 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 

6 (Optional) In the Memo field specify the optional memo for the alert setting. 
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7 Click Save. 

8 (Optional) You can specify additional replenishment parameters as needed. 

9 Click Exit. 

Alert on Unconfirmed Purchase Orders 

1 Click the Alert on Unconfirmed Purchase Orders check box to indicate whether an 
alert should be raised for purchase orders that have not been confirmed in a specified 
number of days. 

2 In the Number of Days field specify the value for the number of days a purchase order 
can go unconfirmed after printing and generate an alert. 

3 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 

4 (Optional) In the Memo field specify the optional memo for the alert setting. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Seasonality Analysis Alerts 

1 Click the Perform Seasonality Analysis check box to indicate whether FACTS should 
evaluate usage method settings and recommend changes based on usage. 

2 In the Percentage of Hits field specify the value for the percentage of hits that must 
occur in the specified number of months for the item’s usage method to be ‘trend”. 

3 In the Months of Hits field specify the value for the number of months to use for the 
item’s usage method to be ‘trend”. 

4 In the Months Established field specify the value for the months established for its 
usage method to be evaluated. 

5 In the Minimum Hits field specify the value for the minimum hits the item must have in 
the months establish to be for its usage method to be evaluated. 

6 (Optional) In the Memo field specify the optional memo for the alert setting. 

7 Click Save. 

8 (Optional) You can specify additional replenishment parameters as needed. 

9 Click Exit. 

Alert for Purchase Orders Past Promise Date 

1 Click the Alert for Purchase Orders Past Promise Date check box to indicate you want 
to generate an alert for purchase orders that are a specified number of days past their 
promise date. 

2 In the Number of Days field specify the value for the number of days past the PO’s 
promise date to generate an alert. 

3 (Optional) In the Memo field specify the optional memo for the alert setting. 
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4 Click Save. 

5 (Optional) You can specify additional replenishment parameters as needed. 

6 Click Exit. 

Alert on Product to Arriving Too Early/Late 

1 Click the Alert on Product to Arriving Too Early/Too Late for Demand check box to 
indicate whether an alert should be raised when on-order products are expected to arrive 
out of synch with demand. 

2 In the Too Early Days field specify the value for the number of days worth of supply that 
is too much and should generate an alert, when an order is expected to create excessive 
supply. 

3 In the Too Late Days field specify the value for the number of days late the product must 
be to generate an alert when an order will not arrive before a stockout is expected to 
occur. 

4 (Optional) In the Memo field specify the optional memo for the alert setting. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Vendor Review Cycle Outside of Limits Alert 

Note: The Review Cycle value is set in Review Cycle Setup (ICE560). 

1 Click the Alert When Review Cycle Exceeds These Limits check box to indicate you 
want to raise an alert when the review cycle value deviates from the minimum and 
maximums entered here.  

2 In the Variances Exceeding section, specify the Minimum Days or Percent to use to 
raise an alert if the review cycle falls below this value and the Maximum Days or 
Percent to use to raise an alert if the review cycle days exceeds the this value.  

3 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 

4 (Optional) In the Memo field specify the optional memo for the alert setting. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Transfer Review Cycle Outside of Limits Alert 

The Review Cycle value is set in Review Cycle Setup (ICE560). 

1 Click the Alert When Review Cycle Exceeds These Limits check box to indicate you 
want to raise an alert when the review cycle value deviates from the minimum and 
maximums entered here.  
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2 In the Variances Exceeding section, specify the Minimum Days or Percent to use to 
raise an alert if the review cycle falls below this value and the Maximum Days or 
Percent to use to raise an alert if the review cycle days exceeds the this value.  

3 (Optional) In the Expiration Date field you can specify the expiration date if you have 
modified the scope of the parameter to narrow it from the company defaults. 

4 (Optional) In the Memo field specify the optional memo for the alert setting. 

5 Click Save. 

6 (Optional) You can specify additional replenishment parameters as needed. 

7 Click Exit. 

Entering Rank replenishment parameters 
Use this procedure matrix to enter all Rank replenishment parameters at one time. This 
procedure matrix is particularly useful or setting up all parameters in a category at once.  

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining scope for Rank parameter you are entering. You can leave the 
setting as company-wide or enter a warehouse, from warehouse, vendor, purchasing line 
and/or item combination. Note: The scope for an item ideally should be least to most 
specific. When possible, parameters should be set according to the hierarchy: Company, 
Warehouse, Vendor, Purchasing Line, Item, Warehouse / Item and avoid specific items 
settings. 

3 In the Show drop down, specify Summary to view all of the effective values entered for 
the parameters set the upper part of the screen and Detail to display override values for 
each record entered for the parameter and what the scopes are for those records. 

4 For Category, specify Rank to display all Rank Replenishment Parameters in the 
browser. 

5 Click the Rank parameter you want to add an override value to or edit the company 
record and click Add or Edit. 

6 (Optional) To modify the scope of the item’s parameter, click Change Scope and specify 
Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and click 
Apply. Note: The settings for this parameter can be defined at any level in the 
replenishment parameter hierarchy. 

7 (Optional) When the system asks if you want to change to a more specific scope, click 
Yes. 

8 Use this procedure matrix to enter all Rank Replenishment Parameter Maintenance 
information.  

Parameters 

1 In the Parameter Options Line browser, select the Replenishment Parameter 
“Parameters”. 
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2 Click Edit. 

3 (Optional) To modify the scope of the item’s parameter, select Change Scope and 
specify Warehouse, Vendor, Purchasing Line, Item or Whse/Item as appropriate and 
click Apply.  

4 Note:  The settings for this parameter can be defined at the company, warehouse, or 
whse/item levels only. 

5 In the Rank Type field specify the warehouse ranking type (P)ercentage or (H)its. 

6 In the Periods to calculate Rank field specify the number of periods to utilize usage 
information for Rank calculation. 

7 In the Rank A field specify the number of hits or the percentage of hits for an item to be 
an A ranked item. 

8 In the Rank B field specify the number of hits or the percentage of hits for an item to be 
an B ranked item. 

9 In the Rank C field specify the number of hits or the percentage of hits for an item to be 
an C ranked item. 

10 In the Rank D field specify the number of hits or the percentage of hits for an item to be 
an D ranked item. 

11 In the Rank E field specify the number of hits or the percentage of hits for an item to be 
an E ranked item. 

12 Click Save. 

13 (Optional) You can specify additional replenishment parameters as needed. 

14 Click Exit. 

Threshold minimum rank for new items 

1 In the Parameter Options Line browser, select the Replenishment Parameter “Threshold 
Minimum Rank for New Items”. 

2 Click Edit. 

3 (Optional) To modify the scope of the item’s parameter, select Change Scope and 
specify Warehouse, Vendor, Purchasing Line, Item or Vendor as appropriate and click 
Apply.   

4 When the system asks if you want to change to a more specific scope, click Yes. 

5 The settings for this section can be defined at the company, warehouse, or whse/item 
levels only. 

6 In the Minimum Rank drop down specify the Rank assigned when new items are 
created under applied scope, (based on the number of months it has been established). 
The default recommended value is ‘C’. 

7 In the Number of Months field, specify the number of months required before a new 
product ranking is calculated by the system. 

8 Click Save. 
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9 (Optional) You can specify additional replenishment parameters as needed. 

10 Click Exit. 

Creating a default buyer for an alternate ARP 
Using Replenishment Parameter Maintenance or Warehouse F/M (ICF970) you can set up a 
default buyer for a warehouse, so that if a buyer does not exist for an approved 
replenishment path (ARP), a default is now available for returns, purchase orders 
(procurement) and transfers to be processed in the Buyers Control Center. For example, the 
new default buyer can be used for special orders and Order-as-Needed (OAN) items for a 
path that is not part of the normal replenishment process. The default buyer will also be 
applied for transfers processed from the Buyers Control Center if the Review Cycle does not 
exist for a given ARP (Warehouse + From Warehouse). 

1 Click Inventory Control>File Maintenances>Replenishment Parameter 
Maintenance. 

2 Specify the defining parameters for the item. At a minimum specify the To Warehouse 
(Warehouse) to setup the buyer: You can enter a warehouse, from warehouse, vendor, 
purchasing line and/or item combination.  

3 In the Show drop down, specify Summary to view all of the effective parameters entered 
for the parameters set in the system and Detail to display overrides for only those 
parameter options that can be defined for the warehouse, from warehouse, vendor, 
purchasing line and/or item combination entered in step 2. 

4 In the Parameter Options Line browser, select the Replenishment Parameter “Review 
Cycle”. 

5 Click Edit. 

6 Modify the warehouse scope of the item’s parameter, click Change Scope and select 
the scope "B - Warehouse (default)" and click Apply.  

7 Make any changes to the other fields for targets, notes, and so on. Note that this 
information can also be entered on the new Default Buyer tab of Warehouse F/M 
(ICF970) to maintain the warehouse level hierarchy for the review cycle. 

8 Click Save. 

9 (Optional) You can specify additional replenishment parameters as needed. 

10 Click Exit. 

11 With the new default buyer setup for a warehouse, access the Buyers Control Center 
(POE400) program. 

12 Specify the buyer code and additional filter display information in the Header portion of 
the screen.  

13 Click Recalculate All to display a line for each ARP associated with the default buyer. 
These lines are the ‘temporary’ ARP for the given Warehouse + Vendor or Warehouse + 
From Warehouse and do not have a specific Warehouse + Vendor or Warehouse + From 
Warehouse scope set up in Replenishment Parameter Maintenance. The lines will not 
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appear in the Buyers Control Center until the user selects the Recalculate All option and 
will remain unprocessed without further action. 

Deleting multiple items 

Managing multiple item delete lists 
1 Click Inventory Control>File Maintenances>Infrequent File Maintenances>Multiple 

Item Deletion Entry (ICE110). 

2 You have these options. 

Add-Click Add and specify the item number to delete and SA item number to transfer 
history to. 

Edit-Highlight a browser line, click Edit and modify the item number to delete and SA 
item number to transfer history to, as needed. 

Delete-Highlight a browser line, click Delete. 

Selection-To manage a range of items, click Selection. Specify the Beginning and 
Ending Item for the range.  

3 Complete this information to further specify your range selection.  

Cutoff Date-The date since the items had sales activity.  
Creation Date-The date after which the items were created.  
Item Type-the type of items, B-Both, S-Stocked, or N-Nonstocked, for the range.  
Item Class-The item class for the range. 

4 Select the type of Update to perform for the range of items: A-Add Entries only, U-
Add/Update entries, D-Delete Entries. 

5 Click OK. 

Checking/updating multiple item deletions 
1 Click Inventory Control>File Maintenances>Infrequent File Maintenances> Multiple 

Item Deletion (ICU110). 

2 Select the Update Type to perform for the pre-entered items you want to delete 
(specified in Multiple Item Deletion Entry): C-Check Only or U-Check/Update. 

3 Click OK. 
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